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Chapter 1 Overview

1.1 Introduction

SpinStudioJ is a professional software package for NMR data acquisition and

processing in the products of Zhongke-niujin. The User Manual thoroughly describes

all aspects of SpinStudioJ, which include system requirements, installation,

introduction to menus and panels, NMR experiments, data processing and analysis, as

well as the routine 1D and 2D experiments, data plotting and pulse programming.

This manual enables users to quickly get acquainted with the main functions and

operations of the software and be quite capable of running experiments and

processing data. All users of SpinStudioJ are recommended to carefully read this

manual.

1.1.1 Definitions and Conventions

In order to make the text in the manual more clear and easier to be understood by

users, following conventions are used in this manual:

1. Commands to be entered are all in bold italic, e.g. wfp.

2. Menus, buttons are all in bold, e.g. File, Acquire.

Table 1.1 Term definition and abbreviation

Term abbreviation Description

FID Free Induction Decay

APT Attached Proton Test

BIRD BIlinear Rotation Decoupling

DEPT Distortionless Enhancement by Polarization Transfer

DOSY Diffusion Ordered Spectroscopy

GARP Globally optimized Alternating-phase Rectangular Pulses
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T1 Spin-Lattice Relaxation Time

T2 Spin-Spin Relaxation Time

1.2 System Installation

1.2.1 System Requirements

1. Hardware Environment

Computer: PC and compatible;

CPU: 2.0 GHz or higher;

RAM: 8G or more;

Monitor: Recommend 1600×900 or higher resolution, 24-bit color or more;

Other peripherals: Standard keyboard, mouse, serial ports, network interface;

Software distribution media: CD-ROM.

2. Software environment

Microsoft Windows 7, Windows 10. The operations introduced in this manual

are based on Windows 7, whereas there are a few differences for those in Windows 10

and Linux. Support for Windows 7 and Windows 10 with 64-bit operating systems,

this article mainly introduces the operation in Windows 7, the operation in Windows

10 is slightly different from Windows 7..

1.2.2 SpinStudioJ Installation and Uninstallation

The version name of SpinStudioJ is composed of the software name, version

number, version type and release date, all of which are hyphenate. For example,

SpinStudioJ-1.4.9alpha-20190624 means version 1.4.9 for internal testing (alpha for

internal testing, beta for external testing) released at June 24, 2019.

Currently, the SpinStudioJ is released as zipped package of executables requiring

no installation. Users can unzip it to a suitable directory and use it directly.

Uninstallation means simple deletion of the whole directory.
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1.2.3 Installation of plug-ins

In the main menu bar, click Help to open the drop-down menu, then click Install

New Software, to pop-up a dialog box:

Figure 1.1 Installation wizard dialog

1. Click the hyperlink Work with the list of software sites below Add button to

open a dialog box (Figure 1.2):
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Figure 1.2 Plugin address management dialog

2. Click Add in Figure 1.2 to open a new box (Figure 1.3), then click Local to

find the local directory where plug-ins are located (e.g. F:/Git/Features/repository),

and clock OK to return to the above dialog box (Figure 1.4).

Figure 1.3 Add plugin address dialog

Figure 1.4 Plugin address management dialog
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Click OK to return to the initial dialog box (Figure 1.1), then open the

drop-down menu right toWork with, select the added directory, a list of plug-ins will

be displayed (Figure 1.5).

Figure 1.5 Installation dialog

As shown in Figure 1.6, if the path is blank or the updated features are not

displayed, uncheck the “Group items by category” and the updated features should be

displayed.

Figure 1.6 Show updated features window
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3. Click Select All→Next→Finish, then click OK, Yes according to the hint to

restart SpinStudioJ.

1.3 Start the System

Double click the icon of SpinStudioJ in you desktop to start the software, and a

login window will appear(Figure 1.7). The default username is guest without

password, whereas the user can also use the username assigned by administrator and

corresponding password. After click OK, a dialog box will be opened (Figure 1.8) for

the selection of root directory of your workspace. The default root directory for data

storage is D:\Data\Global\SpinStudioJData, or you can also select other directory by

click Browse button. If you check “Whether to use this work path the next time you

start?”, next time when you log in again, the same directory will be used by default. If

user want to use another directory as the workspace path, click File > Switch Work

Path > Other on the main menu, the dialog box as in Figure 1.8 will be open again.

Figure 1.7 User login dialog
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Figure 1.8 Workspace root selection dialog

After click OK in Figure 1.8, the main interface will be open(Figure 1.9). The

main interface includes menu bar, toolbar, navigation panel, data window, log panel,

command line, status bar.

Figure 1.9 Software main interface

1.4 Menu bar

Menu bar includes several menus as shown in Figure 1.10, each of which will be

introduced in detail. User can click the selected menu to reveal a drop-down menu,

which may also include several options that can be selected for execution.
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Figure 1.10 Menu bar

1.4.1 File

File menu is shown in Figure 1.11.

Figure 1.11 File menu

New:

Open New Experiment dialog box, which will be explained in detail in 2.6 New

Experiment.

Save As:

Save data in current workspace as Template or SpinStudioJ Data (Figure 1.12).

Figure 1.12 Save As option

1．Click Template to open a dialog box (Figure 1.13). In Save Directory item
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you can select General to save as general template or Auto to save as automation

template. User can give a Name to your template. The item Class and Dim are

decided by the current data, while Type can be selected.

Figure 1.13 Save template dialog

User can also set up parameters for automation experiments by clicking Add

Automation Parameter button to open a dialog (Figure 1.14), where both General and

Advanced parameters can be selected according to your requirement.
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Figure 1.14 Add parameters dialog

2．Click SpinStudioJ Data to open a dialog box for data saving (Figure 1.15).

Figure 1.15 Save experiment data dialog

Print:

Enter the print/plot interface. User can edit spectra here. Please refer to Chapter

9 Spectrum Printing for detailed description.

Import:
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Data import. User can import data of different format, including SpinStudioJ,

Bruker and Agilent for processing. You don’t need to select the specific format of data.

Click Browse to find the directory where the data are saved, and the format will be

recognized automatically. User can select all or some of the data under the defined

directory. User have to choose the destination directory through Import to folder box.

Check the box under Options will keep all your directory structure retained in

destination directory. You can set password for your imported data by clicking Add

password button (Figure 1.16).

Figure 1.16 Data import dialog

Export:

Data export. User can export the data in current workspace to designated

directory in SpinStudioJ or Varian format (Figure 1.17). You can give a name to

your experimental data as you like. If in SpinStudioJ format, you can set password

for your exported data by clicking Add password button.
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Figure 1.17 Data export dialog

If you want to export one of the array data, enter the command export1DArray,

and the dialog box will pop up as shown in Figure 1.18. Fill in the corresponding

number of the data (the number range is displayed in the parent brace), that is, export

the data to the current array data. Under the directory, and automatically named

"current data name_export data number".

Figure 1.18 Export one of the array data

Close:

Close current workspace. This can also be done by clicking button on the

workspace tab. The third way is to put the mouse over the tab and righ-click to choose

Close.

Close All:

Close all workspaces. You can also put the mouse over the tittle bar of the data

window and righ-click to choose Close all.

Recent:

Show history of recently opened workspace number and path. The number of

items displayed history is determined by Show max history record num in

Preferences >Automation under Options menu.

Switch work Path:

Switch the work path. Switch the data storage path, you can select the existing

path directly in the record, or you can switch through the dialog box, as shown in

Figure 1.19, you can directly modify the path manually, or click the Browse button to

select, the final path will be selected. A first-level user name is added after the path,

that is, the user name entered when the software logs in.
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Figure 1.19 Switch the work path dialog

Exit:

Exit the software. You can also click button on the top right of the main

window to exit the software.

1.4.2 Acquire

Figure 1.20 Acquire menu

Sample: Click Eject or Inject to control sample in and out.

New Experiment: Create New Experiment or New Template.

Tune: Open tuning interface, referring 2.8 Tuning and Matching Shimming for

details.

Shim: Open shimming interface, referring 2.9 Shimming for details.

Lock: Open lock interface, referring 2.7 Locking for detail.

Spin: Open Spin Rate Edit dialog box.



22

Acquisition: Start or stop acquisition, equivalent to the commands go or aa.

Automation: Open automation interface, user name and password needed. Refer

to 2.12 Automation for details.

1.4.3 Process

Figure 1.21 Data processing menu

Spectrum:

To open Window Function or Fourier Transform dialog boxes. Details are

referred to 4.3 Window Function, 4.5 Fourier Transform, 5.2 2D Window Function,

5.4 2D Fourier Transform.

Phase Correction:

To open Automatic or Manual phase correction dialog boxes, referring to 4.6

Phase Correction for details.

Baseline Correction:

There are three options included, Automatic,Manual and Semi.

Automatic: enables automatic baseline correction;

Manual: enables manual base line correction by opening a dialog window to set

appropriate parameters, referring to 4.7.4 Manual baseline correction for details;

Semi: similar to Manual but with different parameters, referring to 4.7.3

Semi-automatic baseline correction for details

Tilt:

Open a dialog box for tilt processing, referring to chapter 5.7 J Spectrum Tilt.

Elimination T1 Noise:

Eliminate T1 noise of 2D spectra, referring to 5.8 t1 Noise Elimination.
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Symmetry:

Symmetrize the spectra to improve the quality. Two options for COSY-like and

J-Resolved are included. Please refer to 5.9 Symmetry.

1.4.4 Analysis

Figure 1.22 Data analysis menu

Reference:

Include Automatic and Manual methods. Clicking Automatic enables directly

automatic referencing, while clicking Manual will open a dialog box to set the

reference shift, referring 6.1 Reference.

Peak Picking:

Include Automatic and Manual methods. Clicking Automatic will directly

display the results of peak picking, while clicking Manual will enter manual peak

picking mode, referring to 6.2 Peak Picking.

Integration:

Enter manual integration mode, referring to 6.3 Integration.

Multiple Spectrum Display:

Enter Multiple Spectrum Display mode to manage the display and processing of

multiple spectra in different workspace, referring to 6.4 Multiple Spectrum Display.

Fitting:

Enter data fitting mode for T1 relaxation, T2 relaxation and DOSY data,

referring to 6.6 Fitting.
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Signal/Noise Calculation:

Calculate signal to noise ratio, referring to 6.7 Signal/Noise Ratio.

Resolution:

Calculate the digital resolution of the spectrum and the line shape data for the

highest peak within the displayed region of spectrum, equivalent to command res.

1.4.5 View

Figure 1.23 View menu

Trace Manager:

Open Trace Manager window tor manage the display of arrayed data, referring

to chapter 6.5 Array Data Display and Processing.

Show view:

Open a window for display setting of the software appearance (Figure 1.24).

User can choose to open the windows you want to display.
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Figure 1.24 Show view dialog

Hide Explorer/Show Explorer:

Hide or show the Data Navigator.

Hide Console/Show Console:

Hide or show NMR Console window below the workspace window, including

log panel and command line.

Layout:

Control the layout of multiple spectra display (Figure 1.25), which includes

Horizontal (Figure 1.26), Vertical (Figure 1.27) and Stacked display (Figure 1.29). For

Stacked layout, an offset must be set in pixel unit (Figure 1.28).

Figure 1.25 Layout menu

Figure 1.26 Horizontal layout view
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Figure 1.27 Vertical layout view

Figure 1.28 Stack Layout Offset dialog

Figure 1.29 Stack layout view
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1.4.6 Options

Figure 1.30 Option menu

Preferences:

To Configure the appearance of software interface, Automation experiments,

Shimming methods, NMR Editor, Navigator and Pulse Sequence Diagram (Figure

1.31).

Figure 1.31 Software preference configuration interface

Appearance: to set the theme of the whole interface(Figure 1.32). User can

select: Classic, Dark, Windows, Windows XP Blue, Windows XP Olive or Windows

Classic.
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Figure 1.32 Software appearance configuration

Fonts: to configure the fonts used in Navigator, Console and Status Line (Figure

1.32). Click Edit to show the dialog box (Figure 1.33) for font selection, then the

selected font name will be shown in the Preview window.

Figure 1.33 Font configuration dialog
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Figure 1.34 Font editing dialog

Automation: to set up the conditions of log files for automation experiments

(Figure 1.35). The page can be configured with: a. History limit, above which the

earlier history is automatically cleared in the software interface. b. The history file

interval is limited by the number of days, and a new history file is automatically

created. c. History file size limit beyond which a new history file is automatically

created. d. The history rolls back the initial number, and when the history file is

re-created, the latest pieces are kept in the software interface.

Figure 1.35 Automation history configuration
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Automation > Tuning After Gradient Shimming: to configure the combination

of shim coils for search shimming after auto shimming (Figure 1.36). User can add or

delete shim coil in this window, or change the sequences of coil combinations.

Figure 1.36 configure the combination of shim coils for search shimming after auto

shimming

DataProcess: to set the MestReNova installation path for the data processing

software. After the configuration is completed, open the data in the work area, and

enter the command mnova in the command line to open the data of the current active

workspace in the MestReNova installed in the machine for post-processing of the

data.



31

Figure 1.37 MestReNova installation path setting

Instrument > Shimming > 3D Smart Shimming: to configure the shim coil

combinations for search shim before and after 3D Smart Shimming (Figure 1.38).

Figure 1.38 Search shimming configuration before/after 3D Smart Shimming

Instrument > Shimming > Search Shimming: to set up the configurations for

search shim (Figure 1.39). User can add or delete shim coils and their combinations or

change the sequences of them.

Figure 1.39 Search shimming configuration
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Instrument > Shimming > Smart Shimming: to set up the configuration of

tuning shim before and after Smart Shimming (Figure 1.40).

Figure 1.40 Smart shimming configuration

NMR Editor: to set up the maximum number of opened workspace, maximum

spectral number for 1D array display and the maximum number for history display

(Figure 1.41).

Figure 1.41 NMR Editor configuration

NMR Editor > FID/Spectrum: to set up the parameters for FID/spectrum

display (Figure 1.42). If no specific display parameter was correlated to specified
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experiment, the default parameters in this window will be used.

Figure 1.42 FID/spectrum display configuration

Navigator: configure to select whether to show pulse sequence name and path in

experiment node (Figure 1.43).

Figure 1.43 Navigator configuration

Sequence Diagram > Appearance: to configure the colors to be used for pulse

sequence display (Figure 1.44).
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Figure 1.44 Pulse sequence appearance configuration

Instrument:

The inherent parameters for the spectrometer preset by installation engineer, user

changing not recommended.

Language:

Switch languages between Chinese and English.

Security:

To open the User Setting dialog box. Administrator can add or delete users and

their information, refresh display (Figure 1.45); normal user can only edit your

information and refresh display (Figure 1.46).

Figure 1.45 User management dialog when the administrator logs in
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Figure 1.46 User management dialog when the guest logs in

1.4.7 Tools

Figure 1.47 Tool menu

PS Editor:

Pulse sequence editor. User can create new pulse sequence by editing an existing

pulse sequence in library, or open an pulse sequence in other place to edit. Detailed

function description refers to 3.4 PS Editor.

1.4.8 Help

Figure 1.48 Help menu

Help Content: to open user manuals.

Check for Updates: to check if there is any updates.
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Install New Software: to install software plug-ins. Please refer to 1.2.3

Installation of plug-ins for details.

About: to display the software information of current version.

1.5 Toolbar

Toolbar includes buttons for acquisition and display.

Acquisition related buttons

Acquisition related buttons are shown in Figure 1.49, most of which have

corresponding items in menu bar. For example, user can click button for peak

picking or click Analysis > Peak Picking.

Figure 1.49 Acquisition related buttons

New Experiment

Save Template

Print

Manual Phase Correction

Manual Base Line Correction

Manual Calibration

Manual Peak Picking

Manual Integration

Multiple Spectral Display

Peak Distance

Trace Manager

Set Spectral Center

Set Spectral Width

Eliminate T1 Noise

Start

Stop
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Automation

Tuning

Lock

Shimming

Display related Buttons

Display related buttons are shown in Figure 1.50, which include scaling and

moving of FID and spectrum displayed in workspace, as well as insert display and

contour display.

Figure 1.50 Display related buttons

1.6 NMR Data Navigator

NMR Data Navigator provide an experimental data management tool for users.

User can open, create, copy, paste, display and delete data in it. You can choose

navigator template according to your occupation. The default template is for

university, while templates for testing center and pharmaceutical company are also

included (Figure 1.51). New template can be created by administrator using command

syscf, referring to 2.3.3.2 Experiment Catalog.

Figure 1.51 NMR Data Navigator

There are two useful buttons in the right of the title bar of navigator area. You

can click the button to close all the pop-down structure in navigator, and click

button to spread it and navigate to the position corresponding to the active workspace.
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Click the button to minimize the window or button to maximize it, and click

button to recover it.

In the next section we will introduce the right-click menus based on university

template. The templates for testing center and pharmaceutical company are similar.

1.6.1 User Node

The username displayed in user node is the same as the login username.

Username includes admin, guest and user created name. Only administrator can use

admin to log in for setting up the system. Normal users can use self-defined username

or guest to log in.

The right-click menu is shown in Figure 1.52. User can create New Research

Team, or directly create New Experiment. New Research Team can include directories,

while New Experiment is a .nmr file.

Figure 1.52 The right-click menu of user node

1 New Research Team: Create a directory for new team (Figure 1.53). The

default directory is under the current user node. Fill in the name of your team, then

click Finish to close the window.
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Figure 1.53 Create a new research team dialog on the user node

2 New Experiment: Create new experiment in current user (Figure 1.54). You

can use the current directory or choose a new one, then fill in a name for the

experiment, and choose the parameter type. If there is now data opened in workspace,

the default parameter type is template and the default template is PROTON16；on the

other hand, the default type is Current workspace parameter, i.e., using the parameters

of the active workspace. Finally, click Finish to complete the creation.

Figure 1.54 Create a new experiment dialog on the user node
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3 Open Local Folder: open the directory of current user in File Manager.

4 Upload: upload data to the predefined FTP server. The FTP server can be

configured using command syscf.

5 Import: import data. A dialog box will be opened and you can select the

directory to find the data you want to import. The default directory is the user’s

directory (Figure 1.55). Refer to 1.4.1 File for other functions.

Figure 1.55 Data import dialog in user node

1.6.2 Research Team node

When a Research Team node is created, you can also use right-click menu to

execute many functions (Figure 1.56).
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Figure 1.56 Right-click menu in research team node

1 New Study: Create a new research project (Figure 1.57), which is under

Research Team path and can further contain directories.

Figure 1.57 New research project dialog in the research team node

2 New Experiment: create new experiment under current research team

directory. A dialog box will be opened (Figure 1.58), and the settings are similar to

those described in the New Experiment under User node.
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Figure 1.58 New experiment dialog under the research team node

3 Open Local Folder: open the directory of current Research Team in File

Manager.

4 Upload: upload data to the predefined FTP server. The FTP server can be

configured using command syscf.

5 Delete: Delete the selected Research Team node.

6 Rename: Rename the Research Team.

7 Import: import data. A dialog box will be opened and you can select the

directory to find the data you want to import. The default directory is the user’s

directory.

1.6.3 Research Project node

User can create new research project (Study) under current Team node, and the

right-click menu is shown in Figure 1.59.
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Figure 1.59 Right-click menu in research project

All operations are the same as previous description, but under current Study

directory.

1.6.4 Folder node

User can create new Folder under Study node, which may be the directory for

some sample. The right-click menu and correlated operations are similar to the

previously described.

1.6.5 Experiment node

This may be the last node under the whole directory structure, created by New

Experiment in right-click menu, with the name of any kind of structure correlated

with current experiment. It is a .nmr file composed of several components.

Double-clicking the node will open a new window in workspace to show the data.

The right-click menu is shown in (Figure 1.60), which is a little bit different from

previous menus.
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Figure 1.60 Right-click menu in experiment node

1 Open: open experimental data in workspace.

2 New Folder: create a new folder parallel to it.

3 New Experiment: create new experiment parallel to the current experiment.

The default Params Type is current node parameters.

4 Password: add password to the experiment (Figure 1.61). After entering the

password and confirming it in the pop-up dialog box, click the button to

save it.

Figure 1.61 File encryption dialog

5 Show Log: display log information.

6 Open Local Folder: open the directory of current experiment data in File
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Manager.

7 Load Shim Values: retrieve the shim values from a shim file. If your

shimming is not good, you can select a saved data with good shimming to retrieve it.

1 Upload: upload data to the predefined FTP server.

2 Copy: copy data.

3 Paste: paste copied data. Using Copy and Paste can copy experimental data

to any nodes.

4 Delete: delete the node.

5 Edit Experiment Title: edit the experimental title, which may contain any

information you want to be recorded, which will be shown in the bracket following

the experiment node name, and will be shown above the spectrum when you print or

export it (Figure 1.62).

Figure 1.62 Edit title dialog

6 Rename: rename the experiment.

7 Import: import data. The default destination directory is one layer above

current experiment node.

1.7 Workspace

The workspace looks like Figure 1.63.
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Figure 1.63 Workspace interface

The top bars display the names of opened experimental nodes, with the active

window in white and others in blue. The workspace where data acquisition is in

progress is labeled with a black star.

At the bottom of workspace are tabs for FID/Spectrum, Parameters, Sequence

and Acquisition. Clicking each tab to show corresponding information in the current

workspace window. The active tab is in white while others in blue.

FID/Spec:

To display the FID or spectrum of current experiment. The FID will be displayed

at the end of acquisition, or can be shown during acquisition by typing command

showfid. Right-clicking within window area will allow user to select FID or Spec and

Real or Imaginary part (Figure 1.64).

Figure 1.64 Right-click display menu of FID/Spec interface

Parameters:

To display acquisition and processing parameters. In these windows, user can set

and modify parameters, which can also be done in command line, e.g., typing in

p1=10 will set the pulse width to 10 μs, and si=32768 will set the data points to

32768.

Sequence:
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Display Diagram and Source file of pulse sequence. User can check and edit

pulse sequence here.

Acqu:

Display acquired data in real time during acquisition. Both FID and spectrum can

be displayed by right-clicking as in the FID/Spec tab.

1.8 Log Panel

Log panel is used to show all the log information of backstage operations and all

the commands and parameters that user typed in the command line (Figure 1.65).

Figure 1.65 Log panel

User can click to clear log information; click to lock the scrolling side

bar to stop the scrolling of log information; click to force the log information

displayed in a new line, which is the default mode; click to minimize and to

maximize the log panel, and click at the right side of workspace to restore it.

1.9 Command Line

The Command Line is just below the Log Panel. User can type any commands to

execute it, or just type in parameter name to check its value, or assign a value to

parameter by typing parameter name followed by an equal sign and a value, e.g.,

si=32768 means set si to 32768.
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1.10 Status bar

Status bars are located at the bottom of software interface (Figure 1.66). They are

used to display the major status information of the spectrometer in real time, which

includes connection, lock, sample, spin, temperature, helium level, queue and

acquisition information.

Figure 1.66 Status bars

1.10.1 Connection Status

Display the current status of connection between computer and console.

means connected and means connection failed.

1.10.2 Lock Status

The icon for lock status is , demonstrating whether the field is locked and the

lock level.

Double-clicking the icon or button on toolbar will open the LockShim

box (Figure 1.67). Adjust z0 and lock power and gain to let the lock level to a certain

value, then select the LockOn option, the status will be shown as Locked；deselecting

the LockOn option will prompt an Unlocked status.
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Figure 1.67 LockShim box

1.10.3 Sample Status

Display whether there is a sample in the magnet. Right-clicking the icon, you

will be prompted to select Inject or Eject sample. If there is a sample changer,

right-clicking the icon to select Sample Status will open a window, as is shown in

Figure 1.68 for 24 slots sample changer. User can right-click position number to select

Inject or Eject sample.

Figure 1.68 Sample status diagram

1.10.4 Spinning Status

Display current spinning rate. Right-clicking the icon to select Start Edit will

open a dialog box (Figure 1.69). You can type in a value or use double-headed arrow

button to select a value in the box right to Target Spin Rate, then click to
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rotate the sample. Clicking to stop spinning.

Figure 1.69 Spin rate setting dialog

1.10.5 Temperature Status

Display current sample temperature in °C. Right-clicking the icon and then

select Start Edit to open a dialog box (Figure 1.70). You can type in a value for

targeted temperature, then click to start VT control. When you want to stop

VT control, click .

Figure 1.70 Temperature setting dialog

1.10.6 Cryogen Level Status

Display the current levels of liquid helium and nitrogen. Double-clicking or

right-clicking the icon then selecting Display Parameters, will open a tab in

Navigator area for level reading and setting (Figure 1.71). Only the administrator can

set up new values, and the normal user can only browse it.
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Figure 1.71 Level reading and parameter setting interface

The liquid nitrogen level is shown as percentage value as well as corresponding

capacitance value. You can also click to read the value in real time.

Liquid nitrogen level is continuously monitored. Administrator can set Data

Transfer Interval in seconds for uploading the level data to computer. The

commonly used value is 3600s, i.e., uploading data every hour, and a new data point

will be added in the record curve.

Alert Value: minimum value for alerting, with a default value of 30%. Changes

on this value is not recommended.

Meter Calibration: used to calibration of the capacitance values for 0% and

100% level. Normally done by installation engineer and changes is not recommended.

Clicking Open Record will open an Excel file with records, which includes

record time, capacitance value and percentage level. Clicking Show History will

open a diagram shown recorded curves (Figure 1.71).

The liquid helium level is shown as percentage value as well as corresponding

resistance value. You can also click to read these values in real time.

Alert Value: minimum value for alerting, with a default value of 20%. Changes

on this value is not recommended.

Meter Calibration: used to calibration of the resistance values for 0% and 100%

level. Normally done by installation engineer and changes is not recommended.

The Measuring Parameters are used to set the duration and electric current values
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each time the helium level is measured. Normally done by installation engineer and

changes is not recommended.

Refilling Record can facilitate the administrator to record the time, refilled

volumes and price, and add them to record files.

Right-clicking the icon in status bar then selecting Display Level History

will open a figure in the workspace, which includes the curves of recorded helium and

nitrogen levels, as well as preset alerting level curves (Figure 1.72). User can scroll

the mouse wheel to room, or click and hold the left button, then move around to check

the suitable range of level and date.

Figure 1.72 Liquid level history curve

Right-clicking over the above window, you will be prompted for options (Figure

1.73).

Figure 1.73 Right-clicking option for liquid level recording curve page

Display: select whether to show helium, nitrogen and warning curve;

Reset Level Range: the default level range for display is 0%~110%, which can

be reset to 0%~100%;
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Reset Date Range: reset the displayed time period defined by Show option.

Show: options for displaying records of last week, month or year.

Settings: open the cryogen status window (Figure 1.71).

1.10.7 Queue Information

Display which experiment is currently executed and the total amounts of

experiments. For example, 2/4 means totally there are 4 experiments to be done and

currently the second one is running. Double-clicking the Experiment: will open

the Experiment Queue table showing detailed information (Figure 1.74). User can use

right-clicking options to change the position of any experiment or delete it from list.

Figure 1.74 Experimental queue list

Type include acquiring, again, alock, autoz0, stm, gmap1d, gshim1d, gmap3d,

gshim3d, searchshim, autosample and tune.

1.10.8 Acquisition Related Information

Residual: residual time for current experiment.

Scan: completed scans and total scans.
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Chapter 2 Getting Started

2.1 Sample Preparation and

1. Sample Preparation and Spectrometer Startup

Add appropriate amount of sample into dry and clean NMR tube of the same

diameter as that of the probe.

For 5mm NMR tube, a volume of 0.5~0.65 mL will result in a sample height of

4~5cm height. It is recommended that all samples are kept with the same height.

Wipe the tube with lens paper and insert it into spinner, then put them into the

gauge at one end of the sample rack, adjust the position of tube in spinner until it

touch the bottom of the rack (Figure 2.1). Note, sample surface should be higher than

the brown plate.

Figure 2.1 Sample rack, spinner and NMR tube

2. Spectrometer Status Checking

Spectrometer turned on?

All wiring correct?

Spectrometer work well?
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Pressure of compressed air appropriate?

Right probe?

2.2 Startup SpinStudioJ

1. Startup

Double-click the SpinStudioJ icon on the desktop, or go to the SpinStudioJ

folder in the software installation directory and double-click SpinStudioJ.exe to

startup the software.

2. Checking the connection

The connection status between computer and console is displayed at the left side

of the status bar. means connected and means unconnected.

If unconnected, user can type hi command to start connection. If the connection

is still failed, you need to check:

A. Is the IP address and port number of console network correctly set up?

B. Is the network cable connected and router working?

C. Is there any malfunctioning in the console?

2.3 System Configuration

After the software is started, enter the syscf command in the software command

line to pop up the password verification dialog (Figure 2.2).

Figure 2.2 System configuration password check

Only the system administrator has the right to configure the system. Therefore,

only the system administrator password can be used to configure the system. The

initial password is “zhongkeMR”, and the administrator can modify it. After the
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password verification is passed, the system configuration directory is entered,

including “Component”, “Automation”, and “Others”, as shown in Figure 2.3.

Figure 2.3 System configuration directory

2.3.1 Component

Component consists of three parts: ① Component: parameters related to each

component of the system, such magnet, RF system, console, Autosampler; ② Global:

global and fundamental parameters；③ Probe: probe specific parameters.

2.3.1.1 Component

1. Basic parameters

Figure 2.4 Basic configuration
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Magnet: resonance frequency of the magnet and displayed in the “Base” column

of the sampling parameters panel.

Probe: file name corresponding to the specific probe. The options are based on

the existing files in the directory for system configuration, which were created by

engineer before delivering.

Shim coils: number of shim coils, set according to the system, e.g., 23 for

400MHz and 40 for 600MHz.

Gradient: maximum gradient strengths in Gauss/cm of x, y and z axis.

2. RF parameters

This part include parameters for power amplifier and preamplifier.

Figure 2.5 RF configuration

PowerAmplifier: bandwidth information (minimum and maximum frequencies),

rf power and channel number.

Preamplifier: bandwidth information (minimum and maximum frequencies) for

each nucleus, and corresponding layer number and receiver number.
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3. Console parameter

Figure 2.6 Console configuration

Configure the IP addresses and port numbers of master, each transmitter and

receiver, host and OPCUA.

The default IP addresses of master computer, first and second transmitters,

receiver and local host are sequentially set from 192.168.5.21 to 192.168.5.24, while

their port numbera are all set to 10240.

The default IP address of local host is 192.168.5.55, and port number 10240.

The default IP address of OPCUA is 192.168.5.29 and port number is 4840. OPC

UA (OPC Unified Architecture) is a service based, cross-platform communication

solution. Computer can send instructions to hardware through OPCUA.

Timeout is used to define the response time (s) from IP address. The connection

will be considered failed without response over this time period. Use default values.

4. Auto Sample changer parameter
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Figure 2.7 Auto Sample Change configuration

Set the slot number of sample changer, only two selections for slotnum, i.e., 24

or 60. You can also decide if to use it by setting the value of enable to true or false.

expiretime: time used for the judgement of sample changer status. If the sample

changer dose not respond to an instruction over this time period, an error message will

be popped up.

5. Others parameters

Figure 2.8 Others configuration in Component
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temperature: VT control parameters. The lowest and highest temperature values

are set with precision (decimal numbers)； useOPCUA parameter decides if to use

OPCUA communication for VT control, true for yes and false for no.

spin: sample rotating parameter. The minimum and maximum spinning rates are

set with precision (decimal numbers)；useOPCUA parameter decides if to use OPCUA

communication for VT control, true for yes and false for no.

2.3.1.2 Global Parameters

(1) Global:

Figure 2.9 Global configuration

lockfrqb: The base lock field frequency, which is the lock frequency displayed

on the “Acquparams” interface in workspace.

expCtrlPath: The path of the experiment control layer relative to the UI

interface.

(2) InsParams:
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Figure 2.10 Instrument parameter configuration

Basic parameters about the time events and others of the instrument, set by

engineer before delivering and not allowed to change.

2.3.1.3 Probe related parameters

1. Main:
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Figure 2.11 Probe configuration

Basic parameters for probe setting.

probename: the name of currently used probe, corresponding to the probe

filename in Basic. All parameters of the probe are retrieved from the file with the

same name.

coillength: the length of RF coil of specified probe.

tunetype: type of tuning and matching, o for manual and 1 for automatic.

2. Nucleus:

Configure the pulse widths for observe, decoupling and spinlock and

corresponding powers for each nucleus (Figure 2.12).

Figure 2.12 Nuclear related configuration

2.3.2 Automation

Configuration for Automation experiments, which includes three components
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①Lock and Gain;②Auto Shim;③STM.

2.3.2.1 Lock and Gain

1. autoGain

Figure 2.13 Automatic gain parameter configuration

defaultgain: initial value for gain calculation, with a default value of 21;

Step: increment for gain adjustment, with a default value of 3.

addition: value to be deducted from calculated gain value, set according to

specific instrument (2~10), with a default value of 3.

fidthreshold: maximum FID intensity used for automatic gain calculation. The

maximum value for FID is 32768, but 30000 is recommended.

2. autoLock
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Figure 2.14 Automatic lock parameter configuration

Z0HzRatio: conversion value between Z0 and Hz, set by engineer.

Z0ChangeRate: change rate of Z0, set by engineer.

Z0WaitTimeMax: maximum time for Z0 stabilization, set by engineer.

Z0WaitTimeMin: minimum time for Z0 stabilization, default value being 4000.

Z0SearchStep: increment for Z0 searching, default value being 50.

Z0SearchStepNum: steps for Z0 searching, default value being 2. Used to

determine whether the correct Z0 is searched in right way.

DSNR: signal to noise ratio of lock signal, using default value.

SNRToLockPower: lock power for the set signal to noise ratio of lock signal,

using default value. There is a relation between DSNR and SNRToLockPower as

shown in the following table.
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DSNR SNRToLockPower

>=5000 10

1300--5000 15

700--1300 20

50--700 25

< 50 Error message

WaitFidTime: waiting time for acquiring FID (ms), default value being 200.

PulseAngle: excitation pulse angle for deuterium, 40°～70° being recommended.

The default value is 60°.

LockDefaultGain: value for lock gain (dB), using 21 by default.

LockStableDiffThreshold: threshold of lock level fluctuation, using 3 by default.

The lock is defined as stable when fluctuation is smaller than this value.

LockStalbeAbsThreshold: absolute fluctuation threshold for stable lock, using 3

be default.

LockPowerMax: maximum lock power (dB), using 35 by default.

LockPowerMin: minimum lock power (dB), using 5 by default.

LockGainMax: maximum lock gain (dB), using 39 by default.

LockGainMin: minimum lock gain (dB), using 3 by default.

LockDistValueMin: Minimum value of final lock level, using 20 by default.

LockDistValueMax: Maximum value of final lock level, using 60 by default.

2.3.2.2 Auto Shim

1. AutoGain
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Figure 2.15 AutoGain configuration for SearchShim

step: increment of gain optimization for SearchShim, with a default value of 3.

fidThreshold: maximum FID intensity used for automatic gain calculation for

SearchShim. The maximum value for FID is 32768, but 20000 is recommend.

2. SearchShim

Figure 2.16 SearchShim configuration

angle: pulse angle for acquisition. Small angle is normally used, with 50° as

default.

lockDiff Threshold: threshold of lock level fluctuation, using 3 by default. When

the evaluation method for SearchShim is Locklevel, the fluctuation of lock level must

be smaller than this value before starting shimming.
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acqTimeRatio: ratio for automatic acquisition time, between 0.2~0.7, using 0.4

by default.

3. GradShim

Figure 2.17 GradShim parameter configuration

angleH1: pulse angle for acquisition when using proton GradShim. Small angle

is normally used, with 20° as default.

angleH2: pulse angle for acquisition when using deuterium GradShim. Small

angle is normally used, with 60° as default.

fidThreshold: maximum FID intensity used for automatic gain calculation for

GradShim. The maximum value for FID is 32768, but 24000 is recommended.

minDeltaHeightRatio: minimum height ratio of profile for deltatime optimization,

recommending 0.27.

minDeltaWidthRatio: minimum width ratio of profile for deltatime optimization,

recommending 0.85.

minDeltaTimeH1: minimum deltatime for proton GradShim.

minDeltaTimeH2: minimum deltatime for deuterium GradShim.
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profileWidthRatio: targeting width ratio of profile for gzlevel optimization,

recommending 0.45.

effectHeightRatio: the effective ratio of the range of points when calculating the

field map is recommended to use the default value of 0.28.

deltaTimeStepRatio: when optimizing the adjustment ratio of deltatime, it is

recommended to use the default value of 0.7, that is, multiply the value based on the

current value when optimizing deltatime.

iteration: the number of iterations, that is, the maximum number of iterations

when using the field map shimming, is recommended to use the default value of 4.

4. GradShim3D

Figure 2.18 GradShim3D parameter configuration

GammaH1: gyromagnetic ratio of proton (Hz/G).

GammaH2: gyromagnetic ratio of deuterium (Hz/G).

maxGradx: maximum gradient generated by x1 coil of room temperature shim

set, configured according to the type of shim set. The default value is 0.268.

maxGrady: maximum gradient generated by y1 coil of room temperature shim

set, configured according to the type of shim set. The default value is 0.268.
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minDeltaTimeH1: minimum deltatime for proton 3D GradShim.

minDeltaTimeH2: minimum deltatime for deuterium 3D GradShim.

2.3.2.3 STM

Figure 2.19 STM parameter configuration

tunepoint: default value is 200.

tunesw: bandwidth for tuning (MHz), recommended as 2.0.

doCalPhase: whether to do phase calculation. 0 for no (non-version E preamp), 1

for yes (version E preamp).

use OPCUA: whether to use OPCUA for tuning control. 0 for no, 1for yes.

thresholds: Automatic tuning threshold settings.

name: The tune nucleus name.

exact: The convergence value of the fine tuning, generally with the default value.

coarse: The convergence value of coarse tuning, generally with the default value.

complete: Convergence value in actual use, generally with the default value.

maxtimes: The maximum number of iterations to calculate, usually with the
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default value.

default: The tuning-related parameter value of the nucleus that is not in the list.

2.3.3 Others

This part mainly includes Data Service and experiment directory configuration.

2.3.3.1 Data Service

Data Service includes the management of regular experimental data and

automated experimental data, mainly to configure data format conversion and related

parameters for uploading data using FTP. To use the FTP file upload function, you

must first configure the corresponding user name and password on the FTP server,

and set the file access path for the user. Otherwise, the file upload function cannot be

used. Then configure the corresponding FTP server address and user name and

password in the software system configuration.

1. Global:

Figure 2.20 Global experimental data conversion and upload configuration

IP: IP address of FTP server.

Username: User name set by the FTP server (must be the same as the FTP server

user name).
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Password: The login password corresponding to the FTP server user name. (It

must be the same as the corresponding username and password in the FTP server,

otherwise the file cannot be uploaded).

UseFTP: Whether to use FTP server for file upload. True means use, after the

automated experiment is completed, the system will automatically upload the file

corresponding to the current experiment to the root directory corresponding to the

username of the FTP server; false means not to use, that is, the file is not

automatically uploaded using the FTP server.

Convert to data format 1: Convert to data format 1, which is converted to Varian

format data.

Convert to data format 2: Convert to data format 2, which is converted into

Bruker format data.

Upload SpinStudioJ Data: Upload data in SpinStudioJ format.

Upload data format 1: Upload data of format 1.

Upload data format 2: Upload data of format 2.

Data 1 path: Format 1 data storage path. It is recommended to use the default

path or click Browse to modify it.

Data 2 path: Format 2 data storage path, it is recommended to use the default

path, or click Browse to modify.

2. Automation:
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Figure 2.21 Automated experimental data conversion and upload related configuration

Same as Global file upload configuration.

2.3.3.2 Experiment Catalog

The directory structure of NMR Data Navigator is configured in Experiment

Catalog, with three options for College, Test Center and Pharmaceutical Factory.

User can select one of them according to your requirement, referring to Figure 1.51 at

1.6 NMR Data Navigator for details. The default option is College.

Figure 2.22 Data navigation directory structure configuration

User can also click to create new category, click to edit the

existing catalog structure, or click to remove unused catalog structure.
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Clicking button will open a window for creating new category (Figure

2.23) by entering the name for new category. Select guest, then click New to pop up a

dialog box (Figure 2.24). Enter a name to create a new directory under guest. You can

further create new directory under it.

Figure 2.23 New Directory Structure dialog

Figure 2.24 Edit the new directory name dialog under the guest

2.4 VT Control

Users are recommended to regulate the sample temperature before starting a

experiment, so that the experiment is done under a stable sample temperature,

referring to 1.10.5 Temperature Status for detailed operation.
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2.5 Inserting and Ejecting Sample

There are three methods for inserting and ejecting samples:

 Right-clicking the Sample Status icon , then select Inject or Eject

 In the menu bar, selectAcquire > Sample > Inject or Eject

 On the command line, enter inject or eject

When equipped with a sample changer, you can type aij(n) to insert sample or

aej to eject sample, or right-click the Sample Status icon to select Sample

Status, then right-click on the slot number to select Inject or Eject, referring to

1.10.3 Sample Status.

After inserting the sample, a dialog box will be popped up (Figure 2.25), where

you can enter the sample information which will be displayed when printing (optional)

and select a solvent, which will be used as the solvent in New Experiment.

Figure 2.25 Injection dialog

2.6 New Experiment

User can open a New Experiment dialog box by clicking icon in tool bars,

clicking File > New or Acquire > New Experiment > Create, or type newexp on

command line. This can also be done by right-clicking to select New Experiment

under User, Research Team, Research Project, Folder or Experiment in NMR

Data Navigator. Directory (Dir) and experiment name (Exp Name) will be different

if you create new experiment under different node of NMR Data Navigator, referring

to 1.6 NMR Data Navigator. The dialog box is shown in Figure 2.26, the default

Params Type will depend on if there were opened data in workspace.
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Figure 2.26 New experiment dialog

You can also select Acquire > New Experiment > New form Template to open

a Template dialog box (Figure 2.27). Clicking the specified template will also pop up

a dialog box shown in Figure 2.26, but with specified template information.

Figure 2.27 New experiment selection interface from template

Dir: directory where the data is saved. You can click to select. If there are

data in the specified directory.

Exp Name: user can give a name to your experiment. Chinese, English letters,

numbers and symbols are supported.

Params Type: type of parameter, which can be current workspace parameters
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or template. If there is any data open in workspace, the option is current workspace

parameters, i.e., using the parameters of the active workspace. If no data is opened,

the option is template, and the default template is PROTON16. You can also click

to open a dialog box (Figure 2.28). There there are two options for Dim, 1D and 2D,

and many options for Type, which includes Any, Basic 1D Proton, Basic 1D X,

Selective, Solvent Suppression, Instrument Test, Advanced, ATP, Basic 2D H-H,

Basic 2D H-X, and Basic 2D X-H. User can specify a type to display or enter a key

work in Include to find the template. Show Recommended is enabled by default.

Clicking Reset Filters to display all templates.

Figure 2.28 Template selection dialog

Solvent: deuterated solvent used for the sample. You click the down-arrow to

select one from the list, which should be the same as that in Sample dialog box

(Figure 2.25).

Title: optional information about the sample, e.g. sample name, solvent,

concentration, date.
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Advanced: advanced option where you can choose to get parameters from probe

file or copy them from specific experiments for each channel, or add a password for

the new experiment (Figure 2.29). If you want to copy parameters from some

experimental data, it must have been opened in workspace, then you can choose it

from the drop-down list of the Channel. The number of Channels displayed depends

on the type of experiment you chose.

Figure 2.29 Advanced expansion item

Only two parameters sw and frqo can be copied. You can click button to

open a dialog box (Figure 2.30), where you can edit to copy one or two parameters.

Figure 2.30 Edit parameter dialog

After all needed information are selected, click Finish to dismiss the window

(Figure 2.26), and the new experiment will be displayed in the corresponding position

of Data Navigator.

2.7 Locking

User can open Lock tab in Lock & Shim panel overlapped with the Data

Navigator by clicking button in tool bar, clicking Acquire > Lock > Manual

Lock in the menu bar, or double-clicking icon in Status panel (Figure 2.31).
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Select Show check box to open a window in the workspace to show lock sweep.

The red curve represents the lock level and the blue curve represents error level. The

lock level value is displayed in Lock & Shim panel.

Figure 2.31 Lock & Shim panel

Three parameters, Lock Power, Lock Gain and Lock Phase, are used to control

the lock signal. These parameters can be adjusted by left- and right-clicking mouse

buttons or rolling the mouse wheel up and down over the buttons corresponding to

different increments. These parameters may need an adjustment before and after

locking.

There are boxes and buttons under the lock parameters area used to save or load

lock or shim parameters during manual locking and shimming.

Value1 and Value2: temporarily saved lock and shim parameters, used in

combination with Apply and Save buttons.

Apply: apply temporarily saved Value1 or Value2 to the current lock. You have

to select one of these two values first.

Save: temporarily save current lock or shim parameters to Value1 or Value2.

You have to select one of these two values first.

Load: load a *.ini file and apply the parameters for lock and shim. A dialog box

will be opened to enable you select a file.

Save to File: save the current lock and shim parameters including z0 in a .ini file

in shimvalue directory under currently used solvent.
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2.7.1 Manual Locking

Adjust the value of z0 to maximize the red lock curve and make the blue curve as

close as possible to zero (Figure 2.32). You can adjust z0 by: moving the slider, left-

and right-clicking mouse buttons or rolling the mouse wheel up and down over the

buttons corresponding to different increments.

Figure 2.32 The lock horizontal line and the lock error line are separated

If the lock signal is too small that the two lines can not be separated, adjust Lock

Power and Lock Gain. If the red line is negative and the blue line not near zero, adjust

Lock Phase. When correct parameters are set, the red line is maximized and stable

(Figure 2.33). You may have to alternatively adjust z0 and lock phase to maximize the

lock level. If Lock Level is too large and saturated (>100), slightly lower Lock Power

and Lock Gain. When Lock Level is above 50, select Lock On check box to finish

locking.

Figure 2.33 Adjusted lock line

2.7.2 Auto Locking

Click Auto Lock in the Lock tab or type alock in command line, the software
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will automatically find z0, optimize Lock power, Lock Gain and Lock Phase to

complete locking. You can also click Auto z0 to find correct z0 only, then manually

optimize Lock power, Lock Gain and Lock Phase.

In the process of locking, if you want to stop, you need to enter the command

stopalock or the command aaa.

2.8 Tuning and Matching

Click Acquire > Tune, or click button in tool bar to open the tuning

interface. A parameter window is opened in left side and a window opened in

workspace showing a wobble curve with a dip (Figure 2.34).

Figure 2.34 Automatic tuning interface

There are two options for Nucleus and Freq under Nucleus.

Nucleus: Tuning nucleus. Users can choose according to the needs of the

experiment.

Freq: The frequency corresponding to the tuning nucleus. It will be updated

automatically when you switch Nucleus. The red vertical line in the right window is

the location of the frequency, located in the center of the window.

There are Tuning and Matching tool icon buttons under Tuning and Matching.

When manually tuning, you can click on these icons to adjust the Tune and Match of

the probe.

There are two options in Auto Tune and Manual Tune in Tune Mode, you can

choose auto tuning or manual tuning as needed.

Initialize the actuators: Set the probe's corresponding nucleus to the initial
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position before tuning. This option must be checked when switching the tuning

nucleus, otherwise the tuning will fail.

Message: Displays the tuning related status.

Start and Stop: Start and stop tuning.

Exit: Exit the tuning mode.

Settings: Open the Settings dialog box to set the tuning scan frequency range

TuneSpecWidth and the tuning scan point TunePoint (Figure 2.35).

TuneSpecWidth: sweep width in MHz for tuning, 2 is recommended. If no

signal is found, larger value can be used.

TunePoint: sweep points for tuning. If TunePoint is larger than 1, frequency

sweep is used, with a recommended value of 200; if TunePoint equals to 1, point

tuning method is used, and the tuning value will be shown on the LED screen of

preamplifier.

Figure 2.35 Settings dialog

Two display modes, ABS and Complex, for tuning curve can be selected by

right-clicking in the window. ABS (absolute value) mode is commonly used (Figure

2.36), while Complex mode can also be used (Figure 2.37). During the tuning process,

you can click and drag the mouse to zoom the display range, right-click and select

ShowFull to resume to full display.
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Figure 2.36 Absolute value mode tuning window

Figure 2.37 Complex mode tuning window

1. Automatic Tuning and Matching

Select the nucleus to be tuned in the Nucleus column and Freq will automatically

switch to the corresponding frequency. Select "Auto Tune" in Tune Mode and it is

recommended to check the "Initialize the actuators" option. Click the Start button

and the software will automatically perform the tuning operation. After the tuning is

completed, it stops automatically.

If there are multiple nuclei that require tuning, repeat the above. It is

recommended to tune the order of the nuclear resonance frequencies from low to high.

You can also enter the auto-tuning command stm. The software will read the

nuclei that need to be called according to the selected workspace, and automatically

perform the tuning operation in the order of the nuclear resonance frequency from low

to high. If no data opened, stm command will open the tuning and matching windows ,
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select 1H nucleus by default but without further operation.

2. Manual Tuning and Matching

After opening the tuning window, select the nucleus to be tuned in the Nucleus

column. Select "Manual Tune" in Tune Mode and unselect the "Initializing the

implements" option. Click the Start button to start tuning. The icon under the Tuning

and Matching column is activated and the tuning curve display area shows the tuning

curve. Adjust the Tune and Match of the probe by clicking the arrow buttons

corresponding to the Tuning and Matching icons. After the adjustment is completed,

click the Stop button to finish tuning.

If more than one nucleus should be tuned, start from that with the lowest

resonant frequency.

Note: When switching nucleus for tuning, it is recommended to use Auto

Tune, otherwise it’s easy to fail. After the Auto Tune is finished, you may need to use

Manual Tune for further fine tuning.

2.9 Shimming

Shimming is the process of small compensation (positive or negative) to the

main magnetic field to improve its homogeneity for better spectral resolution. Every

time when changing probe or sample, it is necessary to shim the magnet.d

SpinStudioJ provides four methods for shimming: Manual Shimming, Smart

Shimming, Search Shimming and 3D Smart Shimming. The last three methods belong

to auto shim. User can select proper method according to your situation.

2.9.1 Manual Shim

User can manually adjust the current values for room temperature shim coils.

Currently, the room temperature shim set for 400MHz spectrometer consists of 23

coils including z0, which can be further divided into five groups based on their effects

on magnetic field (Table 2.1).

Table 2.1 Room temperature shim coils
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Axial Z1 Z2 Z3 Z4 Z5 Z6

Low Order X1 Y1 ZX ZY C2 S2

3rd Order Z2X Z2Y ZC2 ZS2 C3 S3

4th Order Z3X Z3Y Z2C2 Z2S2

For manual shim, the criteria for field homogeneity is lock level. Higher lock

level normally indicates higher field homogeneity.

Note Lock level is not only criteria for field homogeneity. The area of FID and

line shape can also indicators of field homogeneity.

The process for Manual Shim is as follows:

1. Click Acquire > Shim > Manual Shimming, or click the down arrow of

button on tool bar then select Manual Shimming to open Lock & Shim

panel, with Manual Shim tab being active ( Figure 2.38).

Figure 2.38 Manual shimming interface

2. Click Load button to retrieve the shim values from a .ini shim file.

3. Adjust z1 value by using one of the following methods to increase the lock

level, until it maximized or even begins to fall.

(1) Right- or left-click the buttons showing different increments (-1+, -4+,

-16+ and -64+).
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(2) Turn the mouse wheel up or down while the cursor is over these buttons.

(3) Enter a number in the box corresponding to each coil. The range of the

number for shim coil is between -32768 ~ +32767.

(4) In the command line, assign a value to the shim coil in the form of , e.g.

z1=2000.

4. Repeat step 3 for z2.

5. The z1 may need to be adjusted again, then z2 again until the lock level no

longer increases.

6. Click LowOrder tab to display the low order radial shim coils. Adjust x1 to

maximize lock level, then adjust y1 in the same way.

7. Click Axial, slightly adjust z1 and z2 again to maximize the lock level.

You can click Save to temporarily save the shim values during manual shimming,

then click Apply to retrieve it. After finishing the manual shimming, click Save to

File to save all the shim values to a file that ends in the .ini extension, which can be

retrieved later by clicking Load.

The administrator can type ssh command to save all the shim values to the

currently used shim file, which can be retrieved by typing lsh in the command line.

Note If common user try to use manual shim, it is recommended to adjust

z1-z2 (Axial) and x1-y1 (Low Order) only.

Note The shim coils in 3Order and 4Order tabs can only be adjusted by

engineer and administrator.

2.9.2 Search Shimming

Search Shimming can automatically search and optimize the compensation value

for each shim coil, with consideration of coupling effects between coils. It can result

in good field homogeneity if used in combination with Smart Shimming.

There are two kinds of methods, Tuning and Simplex, for Search Shimming

based on currently used solvent. ①Tuning is a simple shim method for low order
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shim coils, shimming on one coil each time, without considering the coupling

between coils. Less coils and thus less time are used for shimming. ②Simplex is a

complex shim method considering the coupling between coils, used for spectrometer

calibration or after probe changing. More coils and thus much time are used for

shimming.

Two kinds of criteria, FIDArea and LockLevel, are used for judging shim results.

You can get best shim result by comparing the area of resulting FID (FIDArea) or by

comparing the lock level (LockLevel).

This will result in four combination of shimming modes (Figure 2.39), which can

be flexibly used according to the situation of current field homogeneity. Tow of then

will be introduced here, and the others are similar.

Figure 2.39 Search shimming mode

1. Shimming using Simplex with FIDArea as Criterion

(1) Click Acquire > Shim > Search Shimming, or click the down arrow of

button on tool bar then select Search Shimming to open SearchShim

window (Figure 2.40).

Figure 2.40 Search shimming interface
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(2) In the drop-down menu next to Solvent, select correct one.

(3) Click the drop-down menu next to Evaluate and select FIDArea.

(4) Select a combination of shim coils in the drop-down menu next to Simplex,

click Add to put into the searching list in Groups to immediately start search

shim. You can click Open button to display the real time result in the

searchshim window in workspace (Figure 2.41).

Figure 2.41 Search shimming window

(5) You can continue to add shim coils combinations to the search list during the

shimming process, and change the order by clicking Remove, Up and Down

buttons. The shimming process can be interrupted any time by clicking Stop

button (Figure 2.42).
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Figure 2.42 Simplex shimming with reference to FIDArea

2. Shimming using Tuning with Lock Level as Criterion

(1) Open the SearchShim window as described above (Figure 2.42).

(2) In the drop-down menu next to Solvent, select correct one.

(3) Click the drop-down menu next to Evaluate and select LockLevel.

(4) In the Lock tab (see 2.7 Locking), make sure that the check boxes for Show

and Lock On are selected. Look at the lock level and check if it is stable

(fluctuation small than 0.1, e.g. between 24.4\24.5\24.6). If not, slightly

lower the lock power.

(5) Select a combination of shim coils in the drop-down menu next to Tuning,

click Add to put into the searching list in Groups to immediately start search

shim. You can open the Lock window to check the real time result by lock

level.

(6) You can continue to add shim coils combinations to the search list during the

shimming process, and change the order by clicking Remove, Up and Down

buttons. The shimming process can be interrupted any time by clicking Stop

button (Figure 2.43).
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Figure 2.43 Tuning shimming with reference to Locklevel

The default iteration times are 15 for each coil combination. You can add or edit

the coil combinations by clicking Options > Preferences > Instrument >

Shimming > Search Shimming (refer to 1.4.6 Options).

After finishing the search shim, please save the shim values to a file, and readjust

the Lock again.

Note Tuning and Simplex search shim methods are very effective for lower

order shim coils. Users are net recommended to use these methods for high order

shim coils if you are not familiar with shimming.

2.9.3 Smart Shimming

In NMR spectrometers equipped with pulse field gradient system, user can

utilize gradients for automatic shimming. Smart Shim is thus designed for the

automatic shimming on axial (z axis) shim coils.

Smart Shim is based on Shim Map, which ref the effects of each shim coil on the

magnetic field as a function of sample position. User can retrieve a saved map for

Smart Shim or create a new map for shimming, as revealed in Figure 2.44.
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Figure 2.44 Smart Shim interface

1. Click Acquire > Shim > Smart Shim, or click the down arrow of button on

tool bar then select Smart Shimming to open Smart Shim window (Figure

2.44).

2. In the drop-down menu next to Solvent, select the solvent used for the sample. If

a mixture of 90% H2O+10% D2O is used, select H2O+D2O.

3. Smart Shim based on existing Field Map

(1) Select Shim Map to use existing Field Map for shimming. Displayed in the

box is a map named default, i.e., the system’s default Field Map for current

solvent. It will be displayed under the Smart Shim window, as shown in the
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left of Figure 2.45. Click Browse to open a window for the selection of user

created Field Maps, as shown in the right of Figure 2.45. The maps coming

along with the system is in the directory of default under current solvent, for

example, if the solvent is D2O, the path is

D:\SpinStudioJ-1.4.9alpha-20190624\system\data\solvents\D2O\gradshim1d

\default). The user created maps are saved in the directory of gradshim1d

under current solvent, with a name in the format of yyyymmdd(n), where n is

the sequential number, starting from 0, for these maps created in the same

day. For example, 201900622(2) is the 3rd map created at June 22, 2019.

Figure 2.45 Select the user-created shim map

(2) Click Setting button to open the dialog box for Shimming Parameters. User

can select Get parameters from field map file, or select Custom parameters to

give new values for delta and iteration (Figure 2.46).
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Figure 2.46 Shimming Parameters dialog

(3) User can click Show Map button to open a window showing the map in the

workspace area (Figure 2.47). Clicking Start button here or in the Smart

Shim panel will initiate the gradient shimming using current field map. This

process can be seized by clicking Stop button. If the currently used map was

made by user, you can click As Default to save it as the system default one

for current solvent. Click Close to close the map window.

Figure 2.47 Show Map dialog

(4) Clicking Show Workspace, will open the gradshim1d window in workspace

(Figure 2.48), showing the whole process of gradient shimming.
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Figure 2.48 Process of gradient shimming

(5) Typing smartshim in command line can also start Smart Shim.

Note If the result using saved field maps is not satisfactory, it might be that

the map is not suitable, you can make new map for shimming.

4. Smart Shim based on new Field Map

(1) If Make Map is selected, a new field map will be made first. The default

way is to make field map using automatically optimized parameters. User can

click Setting button to open a dialog box, then select “Set parameters

manually” to set up proper values for each parameter, as shown in Figure

2.49.

Figure 2.49 Parameter setting dialog

z num: number of axial shim coils used for making field map, 6 as default. User
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can change it according to the situation.

iteration: number of times for for gradient shim iteration. If data still dose not

converge after this number of iteration, it will be stopped automatically.

gain: receiver gain for data acquisition during making map. The optimum value

is the maximum one without overflow.

delta: waiting time before gradient pulse.

p1: pulse width used in the pulse sequence for field map.

plvl1: corresponding power for p1.

ns: number of scan for acquisition, 4 by default, or 8 for solvents with few

deuterium atoms. This value can be changed according to different solvents.

gzwin: the percentage of gradient image profile over the spectral width used in

gradient shimming. This should be adjusted when making new field map.

(2) Click Start button to make new field map. After the new map is made, the

program will automatically start gradient shimming using the map. Clicking

Show Workspace next to Make Map will open the gradshim1d window in

workspace (Figure 2.48), showing the whole process of gradient shimming.

(3) At the end of making field map, a window will be open shown the new map

(Figure 2.50). Right-clicking over it then select Show Field Map, or

double-clicking the map, will open a window showing the map in the

workspace area as in the case of using existing map (Figure 2.47).
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Figure 2.50 Shim map view box

(4) Typing smartmapshim in command line can also start Smart Shim with new

map.

5. Search Shim before and after Smart Shim

Whether using existing map or by making new map for Smart shim, combined

use of search shim Before and After Smart Shim will result in much better field

homogeneity. These options can be set in Smart Shim panel (see Figure 2.44)

(1) Click down-arrow next to Before and After to open the drop-down menu,

then select one of the coil combinations for search shim (Figure 2.51). You

can also click Options > Preferences > Instrument > Shim > Smart Shim,

to customize the combination, iteration and steps for yourself, referring to

1.4.6 Options. There are two options, FIDArea and LockLevel, for Evaluate,

as the same in Search Shim.

Figure 2.51 Tuning coil combinations of Before

(2) These setting can also be done by using commands:

gshim: smart shim using default map, without auto locking after shimming.

smartshimaa: smart shim using default map, plus search shim on z1-x1-y1-zx-zy,

with auto locking after shimming.

smartshimaxyz: smart shim using default map, plus search shim on z1-x1-y1,

with auto locking after shimming.

smartshimaz: smart shim using default map, plus search shim on z1, with auto

locking after shimming.
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smartshimba: search shim on z1-x1-y1-zx-zy, then smart shim using default map,

with auto locking after shimming.

smartshimbxyz: search shim on z1-x1-y1, then smart shim using default map,

with auto locking after shimming.

smartshimbz: search shim on z1, then smart shim using default map, with auto

locking after shimming.

gmapshim: smart shim using new map, without auto locking after shimming.

smartmapshimaa: smart shim using new map, plus search shim on

z1-x1-y1-zx-zy, with auto locking after shimming.

smartmapshimaxyz: smart shim using new map, plus search shim on z1-x1-y1,

with auto locking after shimming.

smartmapshimaz: smart shim using new map, plus search shim on z1, with auto

locking after shimming.

smartmapshimba: search shim on z1-x1-y1-zx-zy, then smart shim using new

map, with auto locking after shimming.

smartmapshimbxyz: search shim on z1-x1-y1, then smart shim using new map,

with auto locking after shimming.

smartmapshimbz: search shim on z1, then smart shim using new map, with auto

locking after shimming.

6. Selecting the check box of AutoLock will enable the field being auto locked on

after gradient shim, else the field will be unlocked. The default is on.

2.9.4 3D Smart Shimming

The principal of 3D Smart Shim is similar to Smart Shim, but with with XYZ

three directional gradient encoding, which results in longer time for shimming.

The interface for 3D Smart Shim is shown in Figure 2.52. User can retrieve a

saved map or create a new map for shimming.
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Figure 2.52 3D Smart Shim interface

As shown in above, the interface of 3D Smart Shim is similar to Smart Shim,

with several additional options.

Nucleus: the nucleus used for 3D shimming, set as deuterium by default. It can

be changed as H1 if your solvent is 90% H2O+10% D2O.

Phase Code: phase encoding matrix for 3D shimming, 4×4 by default. 8×8 or

16×16 can be used.

Channels: the shim coils used for 3D shimming, all being used by default. User

can click Edit button to edit your own combinations of shim coils.

The detailed 3D Smart Shim procedures are explained as follows:

1. Click Acquire > Shim > 3D Smart Shimming, or click the down arrow of

button on tool bar then select 3D Smart Shimming to open 3D Smart Shim

window (Figure 2.52).

2. Select Nucleus, the nucleus used for 3D shimming. The default nucleus is D

(deuterium), however, if the solvent has high content of H2O, such as 90%

H2O+10% D2O, it should be changed to H1.

3. Select Phase Code for phase encoding matrix, 4×4 by default. The 8×8 or 16×16

matrix can also be used.

4. 3D Smart Shim based on existing Field Map

(1) Select Field Map to use existing Field Map for shimming. Displayed in the
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box is a map named default, i.e., the system’s default Field Map for current

solvent as shown in the left of Figure 2.53. The default map will be displayed

under the 3D Smart Shim window.

(2) Click Browse to open a window for the selection of user created Field Maps,

as shown in the right of Figure 2.53. The maps coming along with the system

is in the directory of default under current solvent, for example, when the

solvent is D2O, the path is

D:\SpinStudioJ-1.4.9alpha-20190624\system\data\solvents\D2O\gradshim3d

\default. The user created maps are saved in the directory of gradshim3d

under current solvent, with a name in the format of yyyymmdd(n), where n is

the sequential number, starting from 0, for these maps created in the same

day. For example, 20190620(0) is the first map created at June 20, 2019.

Figure 2.53 Select the user-created 3D shim map

(3) Click Setting button to open the dialog box for shimming parameters. User

can select get parameters from field map file, or select custom

parameters to give new values for delta and iteration, and select the shim

coils to be used (Figure 2.54).
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Figure 2.54 Setting dialog when Shim Map is selected

(4) Select Channels, the shim coils coils used for 3D Smart Shim. The default is

composed of all coils for current spectrometer. User can click Edit to open a

edit window, then click Show button to check the default coils (Figure 2.55),

or click Add button to define your own coil combinations and give a name in

the Channel Name box (Figure 2.56).

Figure 2.55 Show button function in the Edit dialog

Figure 2.56 Add button function in the Edit dialog
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(5) User can click Show Map button to open a window showing the map in the

workspace area (Figure 2.57). You can check each coil by clicking Next or

Back. Clicking Start button here or in the 3D Smart Shim panel will initiate

the 3D gradient shimming using current field map. This process can be

seized by clicking Stop button. If the currently used map was made by user,

you can click As Default to save it as the system default one for current

solvent. Click Close to close the map window.

Figure 2.57 Show map dialog

(6) Clicking Show Workspace, will open the gradshim1d window in workspace

(Figure 2.58), showing the whole process of gradient shimming.

Figure 2.58 Process of gradient shimming
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(7) Typing smartshim3d in command line can also start 3D Smart Shim.

Note If the result using saved field maps is not satisfactory, it might be that the

map is not suitable, you can make new map for shimming.

5. 3D Smart Shim based on new Field Map

(1) If Make Map is selected, a new field map will be made first. The default

way is to make field map using automatically optimized parameters. User can

click Setting button to open a dialog box, then select Set parameters

manually to set up proper values for each parameter, as shown in Figure 2.59.

Figure 2.59 Setting dialog when Make Map is selected

p1: pulse width used in the pulse sequence for field map.

plvl1: corresponding power for p1.

gain: receiver gain for data acquisition during making map. The optimum

value is the maximum one without overflow.

delta: waiting time before gradient pulse.

ns: number of scan for acquisition, 2 by default, 4 is also ok.

gzwin: the percentage of gradient image profile over the spectral width used

in gradient shimming.

fov X: field of view in X direction.

fov Y: field of view in X direction.
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iteration: number of times for for gradient shim iteration.

(2) Select Channels, the shim coils coils used for 3D Smart Shim. The default is

composed of all coils for current spectrometer. User can edit for your own

coil combinations. Please refer to above section 3D Smart Shim based on

existing Field Map for details.

(3) Click Start button to make new field map. After the new map is made, the

program will automatically start gradient shimming using the map. Clicking

Show Workspace next to Make Map will open the gradshim3d window in

workspace (Figure 2.58), showing the whole process of gradient shim.

(4) Typing smartmapshim3d in command line can also start 3D Smart Shim.

6. Search Shim before and after Smart Shim

Whether using existing map or by making new map for Smart shim,

combined use of search shim Before and After Smart Shim will result in much

better field homogeneity. These options can be set in 3D Smart Shim panel

(Figure 2.52)

Click down-arrow next to Before and After to open the drop-down menu,

then select one of the coil combinations for search shim (Figure 2.60). You can

also click Options > Preferences > Instrument > Shim > Smart Shim, to

customize the combination, iteration and steps for yourself, referring to 1.4.6

Options. There are two options, FIDArea and LockLevel, for Evaluate, as the

same in Search Shim.

Figure 2.60 Tuning coil combinations of Before

7. Selecting the check box of AutoLock will enable the field being auto locked on

after gradient shim, else the field will be unlocked. The default is on.
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2.10 Experiment Setup

2.10.1 Parameter Setup

Acquisition related parameters can be setup in AcquParams tab of an NMR

experiment in workspace, such as observe nucleus (nuc) and corresponding basic

frequency (frqb) and offset (frqo), power (plvl1), spectral width (sw/swhz),

acquisition time (acqtime) , receiver gain (gain); decoupling nucleus (nuc1) and

corresponding basic frequency (frqb1) and offset (frqo), power (plvl2), as shown in

Figure 2.61. These parameters are listed under one of the following groups: Base,

Experiment, Constant, RF Channels, Duration and Pulse. The icon means that the

current display is active for parameter setup, you can enter or change values for

parameters with their value boxes in white. Clicking will switch it to ,

representing a status only for parameters display, in which no parameter can be

changed.

The parameters can be searched by entering any letters in Filter box.

Figure 2.61 Experimental parameter setting page

There are three ways for parameter setup: (1) directly entering a value for

parameter, such as ns, gain, sw, frqo; (2) clicking to open a drop-down list for
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selecting a value for the parameter, such as solvent, arraymode, nuc; (3) clicking to

activate the button, clicking which will open a dialog box displaying options

for selection, such as pulseseq (Figure 2.62). User can select pulse sequence from

System library or User library, with Filter to help you select quickly. Click OK to

close the window.

Figure 2.62 Pulse sequence selection dialog

The parameters can also be setup in command line. For example, you can type

ns=8 to set the number of scans to 8; type pulseseq='apt' to set the pulse sequence as

apt.

Different pulse sequence includes different parameters. When right-clicking over

the parameter line, a menu will appear with options where you can select one for

manipulation (Figure 2.63).

Figure 2.63 Right-clicking function of parameter line

User can select Add Parameter, or click the button in parameter panel to add

parameter for display. A dialog box will appear as shown in Figure 2.64. If you want
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to add some parameter for your currently used pulse sequence, simply select the check

box of the parameter, or click New button to open a dialog box for creating new

parameter (Figure 2.65). You must give a value to the field with asterisk.

Figure 2.64 Add parameter dialog

Figure 2.65 Create parameter dialog

Compared with 1D NMR experiment, 2D NMR experiment includes additional

parameters for indirect dimension, e.g. sw1, np1 for observation, si1, sb1, sbs1 for
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processing.

When np1 > 1, a 1D experiment becomes 2D experiment.

2.10.2 Displaying Pulse Sequence

Pulse sequence is displayed in Sequence window of the workspace. The pulse

sequence diagram and the source file are separately displayed in Diagram and Source

tabs. Some parameters are also displayed in the diagram, as shown in Figure 2.66. The

source file can be directly edited (Figure 2.67), and the revised version will be saved

in current experiment, without changing the system’s original pulse sequence.

Figure 2.66 Pulse sequence graphic display

Figure 2.67 Pulse sequence text display
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2.11 Data Acquisition and Storage

2.11.1 Starting and Stopping Acquisition

Firstly, type again in command line to get optimized gain value, then type go, or

click button in tool bar to start data acquisition (FID will be displayed when

acquisition is finished) , or type ga to execute data acquisition and processing (Fourier

transformation, automatic phase correction and spectrum display). If the acquisition

need to be stopped, type command aa to stop acquisition in current workspace or aaa

to stop acquisitions in all workspaces.

2.11.2 Repetitive Acquisition

Repetitive acquisition is designed for interactive parameter optimization. User

can look at the results after changing parameter in real time.

Open or activate the experiment with parameters to be optimized in workspace.

Type gs in command line to open the gs Editor window (Figure 2.68), and to start the

repetitive acquisition at the same time. User can optimize your parameter by changing

value directly in the box, by left-and right-clicking the button, or by rolling

mouse wheel forward and backward over the button to change the value based on the

increment shown left. The increment can be changed by clicking the down-arrow and

select other values. Click the button to apply the new value and start a new

acquisition. The resulting spectrum will show the effect of the revised parameter. To

exit this mode, you need to click button to stop first, then click

button to exit.



108

Figure 2.68 gs editor interface

If you exit the Gs Editor without stopping it first, you can type aa in command

line to stop it, or type gsedit to open the window again, then stop it.

2.11.3 Data Archiving

SpinStudioJ provide two methods for data archiving:

(1) After acquisition, the data will be automatically saved in the current

directory.

(2) Save data to other designated directory. Click File > Save As in menu bar, or

click the down-arrow of the button in tool bar and select SpinStudioJ

Data. A dialog box will appears as shown in Figure 2.69,where you can enter

the whole path in Save Directory box or click Browse button to select the

destination directory for data archiving. You can enter a name for your data

in Exp Name box, and even add a password to protect your data by clicking

Add Password button, then entering the password and confirming it (Figure

2.70).
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Figure 2.69 Dialog for saving experiment data

Figure 2.70 Add password dialog

2.11.4 Data Acquisition for 2D Experiments

The start of data acquisition for 2D experiments is the same as for 1D experiment.

After all preparation is done, type again in command line to get optimized gain value,

then type go, or click button in tool bar to start data acquisition.

2.12 Automation

Automation can simplify experiments and save much time for large number of

samples in routine work. User only need to assign the sample information, solvent and

pulse sequence for each sample, then the program will automatically complete other

things including sample inserting, auto locking, auto tuning, auto shimming, auto gain,

data acquisition and processing. Most routine 1D and 2D experiments can be done in

automation.
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2.12.1 Automation Login

Click Acquire >Automation on menu bar, or click button on tool bar. The

Automation login window appears, you can enter user name and password here to log

in (Figure 2.71). The administrator can use admin as username and password for first

time login. Other users and passwords are created by the administrator.

Figure 2.71 Automation login dialog

After login, the Automation interface will be shown in the workspace, which

includes tool bar, experiment queue list and history list, as shown in Figure 2.72.

Figure 2.72 Automation interface

2.12.2 Preference

After login, the administrator can click the button on the tool bar to

open the Preference setting window (Figure 2.73). Two parts, the general settings for

automation experiments (Automation) and user related settings (User Settings), are

included in Preference, which will be introduced in the following section.
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Figure 2.73 Automation configuration interface

1. Automation

(1) General Options

Figure 2.74 General Options configuration interface

Automation Data Root Directory: the root directory where the data of all

automation experiments are saved. When user create new automation experiments,

this directory is used as default value.

Data format 1 Root Directory: the root directory for saving data converted to

Varian format.
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Data format 2 Root Directory: the root directory for saving data converted to

Bruker format.

Web Server IP Address: IP address of the Web server for visiting automation

interface from web. This is set by engineer, not allowed to be changed by user.

Web Server Port: port number for the Web server. This is set by engineer, not

allowed to be changed by user.

Web Server timeout: The timeout period of the web server is generally 1800s

by default. After the interface is not operated, the interface information is no longer

updated, and the dialog box prompts the login timeout. When you click OK, it will

exit to the login interface.

(2) Auto Sample Changer

Figure 2.75 Configuration for auto sample changer

Eject When Queue Over: option to decide where to eject the sample after all

experiments in queue are finished.

2. User Settings

(1) User Manager

The administrator can use User Manager to add, edit or delete Automation

Experiment users (Figure 2.76).
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Figure 2.76 Configuration for User Manager

Click Add a User to open a dialog box (Figure 2.77). The administrator can set

the user name and password for a new user and assign its Role. The Role is guest for

all users created by administrator.

Figure 2.77 Add a new user

The administrator can select a user and click Edit the User to modify its

password (Figure 2.78), or click Delete the User to delete it.

Figure 2.78 User editing interface
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(2) User Preference

Figure 2.79 User Preference configuration interface

Information related to the automation experiments for each user is setup in User

Preference. User will use these information as default conditions to created new

automation experiments.

The first three items are basic. Username can be selected from the drop-down

list of user names, which are created in User Manager. There are many options for

Default Experiment template and Default Solvent.

The second part is Default Experiment Settings, which include all steps before

data acquisition as listed in the window. The functions of these items have been

introduced in previous sections.

The third part is the Default Data Process Settings. These selections decide

where to carry out Fourier Transformation, to do Auto Phase Correction and Auto

Baseline Correction after data acquisition.

The last part is User Directory List. The administrator can set several directories

for a user for data storage. The default root directory for a user is a subdirectory of
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user name under the root directory already set in General Options. Click Add a

Directory to open a dialog box (Figure 2.80). You can assign a name to the Custom

Directory for the user, which is under user root directory. If Date Directory or Slot

Directory is selected, a subdirectory with the format of [Date Time] or [Slot Index]

under Custom Directory will be created. If both of them are selected, then the

Custom Directory will be followed by /[Date Time]/ [Slot Index] subdirectory. Select

a directory in the box under User Directory List, then click Remove the Directory

to remove it, or click Set as Default to set it as default directory of the user.

Figure 2.80 Set user directory

2.12.3 Operations of Automation experiments

1. New

When you want to start a new automation experiment process, click

button in tool bar. A window will appear warning that all experiments will be cleared

(Figure 2.81). Click OK to proceed. There are two methods for creating automation

experiments, one by utilizing saved automation experiments list, another by adding

new experiments.

Figure 2.81 New automation experiment prompt box

2. Open

If user want to run the same automation experiments done before, or part of them
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will be repeated, you can click button in tool bar. A window the same as in

Figure 2.81 will be popped up to warn you. Click OK, and the file manager window

will be open. You can find the automation list file saved before, click Open to apply it

to the current experiments. The list can be further edited.

3. Add

Select a Slot line in the Automation list table window, the click button in

tool bar. A new experiment will be added under this slot. The experiment is the default

one as defined in “User Preference”, and can be modified further.

4. Checking and Modification of Parameters

After adding new experiments, user can check them and modify the parameters

through drop-down list or selecting or unselecting the option boxes, as shown in

Figure 2.82. You can also give a name to the experiment in the box under File.

Figure 2.82 Automation experiment parameter modification and editing

Click the Edit button under Param to open a dialog box, where you can edit

parameters for Acquisition (Acqu), Shim and Data Process as shown in the left of

Figure 2.83.
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Figure 2.83 Edit parameters for Acquisition

By default the Acqu tab is active, showing parameters according to the

experimental template. Clicking <<Advanced button will expand the menu to show

more parameters, as shown in the right of Figure 2.83.

The options in Shim and Data Process tabs are almost the same as in User

Preference, see Figure 2.84.

Figure 2.84 Options in Shim and Data Process

5. Copy

There are two methods to copy experiments to destination slot:
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(1) Copy single experiment to designated slot

Select the experiment line to be copied, then click button in tool bar, or

right-click and select Copy. A dialog box is open to let the user select destination slot.

After selecting the wanted slot, click button to close the box, as shown in

Figure 2.85.

(2) Copy all experiments in a slot to destination slot

Select the slot to be copied, then click button in tool bar, or right-click

and select Copy. A dialog box is open to let the user select destination slot. After

selecting the wanted slot, click button to close the box. It can also be

selected by the button Select All and the Select Invert and Choose buttons, as shown

in Figure 2.85.

Figure 2.85 Copy dialog

6. Delete

(1) Select the experiment you want to delete, click the toolbar button ,

or right click and select Delete. You can delete experiments with current user

experiment statuses of Queued, Submitted, Done, Error, and Editable.

(2) Select the Slot line, click the toolbar button , or right-click to select

Clear all experiments of this sample, you can delete all the experiments under the

Slot whose status is Done or Error. If there are experiments with other status under the

Slot, the operation will not be executed.

7. Start

After finishing setting and checking of experimental parameters, you can click
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button in the tool bar to start automation experiments. If you are logged in as

an admin user, this button submits all the experiments in the Editable state of the

experiment queue. If you log in as a normal user, this button is an experiment that

belongs to the current user in all Editable states in the submit experiment queue.

Or right click on the experiment queue area and select Submit All Experiments.

If you want to submit a single experiment, put the mouse arrow over the experiment

line and then right-click to select Submit This Experiment. This can only be done

for the experiment of the currently logged in user, and the administrator is no

exception.

8. Stop

(1) Stop current experiment to start subsequent one

Select the current experiment, then right-click to select Stop This Experiment.

This can only be done for the experiment of the currently logged in user, and the

administrator is no exception.

(2) Stop all experiments

You can click button in tool bar to stop the current running experiment

and all the submitted experiments. Any user clicking this button will stop all users’

experiments.

9. Take Priority

This operation gives priority to some experiment in the queue. Select the

experiment, then right-click to select Take Priority. For administrator, this operation

will put the selected experiment to the very beginning of the queue. The current user

can only put the selected experiment to the top of the queue of his own experiments.

10. Cycle Test

If you want to carry out repeated acquisition for some experiment, select an

experiment line, right-click to select Cycle Test. This experiment will be repeatedly

acquired after the queue is finished. This function is displayed only when logging in
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with admin, and is generally used when debugging the auto sampler changer.

11. OpenWorkspace

Select an experiment line, right-click to select Open Workspace. A window will

be opened in Workspace.

12. Save

Clicking button in tools bar will save the information of the current

queue list to a file, which can be retrieved later by clicking button.

13. History Log of Automation

The history log record the all the information about completed automation

experiments and the error messages. Double clicking the log item will open a window

corresponding to the experiment in the workspace.

2.12.4 Web Client

The automation user can log into the Automation interface through Web client,

using the same user name and passwords as for the SpinStudioJ Automation

Experiment. User can add new experiments, edit, delete, copy, submit and stop

experiments. These operations will be synchronized to the SpinStudioJ software.

The URL of Automation Experiment Web Client is: http://localhost:8081/. It is

recommended to use the 360 browser and use the speed mode (compatibility mode is

not available), localhost represents the workstation's IP address, which is the Web

Server IPAddress configured in the automated lab preferences.

The login page is shown in Figure 2.86.

http://localhost:8081/
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Figure 2.86 Login interface

The username and password are the username and password set for the

SpinStudioJ automation lab.

When the web interface exceeds the Web Server timeout set by the automation

experiment preferences, the interface information is no longer updated, and the dialog

box prompts the login timeout. After clicking the confirmation button, it will return to

the timeout login interface (Figure 2.87).
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Figure 2.87 Timeout login interface

The interface of Web client is shown in Figure 2.88.

Figure 2.88 The interface of Web client

New Experiment: click button in the tools bar or button at the end of

slot line under Operation column. A window will be opened as Figure 2.89.
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Figure 2.89 New experiment interface

The parameters in this window are the same as in the SpinStudioJ. After editing

the parameters, click Add button to add this experiment to the list.

Start: click button in the tools bar to start all the experiments in the list.

Clicking button at the end of experiment line under Operation column will start

the current experiment. All users can only submit their own experiments, with the

exception of administrators.

Stop: click button in the tools bar to stop all the experiments in the list.

Clicking button at the end of experiment line under Operation column will sop

the current experiment.

Delete: clicking button at the end of experiment line under Operation
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column will delete the current experiment.

Edit: for those experiment in editable Status, you can clicking button at the

end of experiment line under Operation column to edit it. This can only be done for

the experiment of the currently logged in user, and the administrator is no exception.

Copy: clicking button at the end of slot line under Operation column will

copy the experiment information of current slot to the next slot.

Reset: You can clear all experiments under the current Slot by clicking the

corresponding button under Operation in the Slot line. After the reset, other users

can use the Slot to add experiments again.

History log: the history of automation experiments will be displayed in the lower

part of the Web client, as shown in Figure 2.90.

Figure 2.90 History of automation experiments
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Chapter 3 Pulse Programming

The pulse sequence in SpinStudioJ is written in Extensible Markup Language

(XML). You can use text editor such as Notepad++ to create pulse sequence in XML,

then save it with ps as extension. The XML text of a pulse sequence is shown in

Figure 3.1, which corresponds to the pulse sequence diagram in Figure 3.2.

Figure 3.1 pulse sequence text

Figure 3.2 Pulse sequence diagram

3.1 Grammar of Pulse Sequence Editing

3.1.1 Modules of Pulse Sequence

A pulse sequence consists of the following parts (see Figure 3.1):

1. Basic information. The content of name is the name of the pulse sequence,

while the dimension represent the dimension of experiment, 1 for 1D and 2
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for 2D.

2. Description of the pulse sequence. This includes English and Chinese

descriptions.

3. Pulse sequence elements. The pulse sequence is based on the time slice

structure. All elements are embedded in time slices. <Slice> is the start symbol

of a time slice, and </Slice> is the end symbol. Each time slice may consists of

one or several elements. The pulse sequence shown in Figure 3.1 consists of

three time slices, each of which contains Delay, Pulse and Acquire element

respectively.

There are totally 11 elements defined in pulse sequence, some of which are

related with RF channels, while others are not. There are 6 values for channel

property in pulse sequence, i.e., observe channel f1, decoupling channel f2, f3 and f4,

gradient channel gz and shim channel shim.

Eight channel-related elements are: Pulse, Delay, Acquire, Gradient,

ShpaeGradient, ShapePulse, CompositePulse and Shim; three elements not related

to channel are: Loop, If and Stage.

In a time slice, there are three ways of alignment for elements: left, middle and

right.

4. Phase table. All phase cycle used in the pulse sequence should be listed here.

5. Parameters definition. All parameters used in the pulse sequence must be

defined here one by one. The first part is in English and the second part is in

Chinese. Each parameter consists of several properties:

id: name of the parameter.

description: text describing the meaning of the parameter.

value: parameter value.

allowarray: determine whether array is allowed. The value can be "true" or

"false".

type: type of parameter: real, integer, long, string.

digits: define the precision of the parameter, expressed in number of total
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digits.

unit: the unit of parameter: "M", "K", "m", "μ", " ". The last one means

standard international units.

min: the minimum value.

max: the maximum value.

force: whether to use the value given here as the parameter value.

probeparam: retrieve pulse width or pulse power when reading prove file.

Only used for pulse and power parameters.

3.1.2 Grammar for channel-related elements

1. Delay

The example of delay element is shown as

delay: element symbol

channel: "f1", "f2", "f3", "f4", "g"z or "shim"

align: "left", "middle", "right"

duration: time of delay. Reference values are d0~d20 in second.

2. Pulse

The example of pulse element is shown as

Pulse: element symbol

channel: "f1", "f2", "f3", "f4"

align: "left", "middle", "right"

duration: length of pulse. Reference values are p0~p20 in microsecond, s.

power: RF power of the pulse. Reference values are plvl0~plvl20 in dB.

phase: the phase of the pulse. Reference values are ph1~ph10.
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offset: the offset of RF transmitter. Reference values are fq~fq10 in Hz.

3. Acquire

The example of Acquire element is shown as

Acquire: element symbol

channel: "f1"

align: "left", "middle", "right"

duration: length of acquisition time. Reference values are acqtime~acqtime3 in

second.

phase: the phase of the pulse. Reference values are ph1~ph10.

points: acquisition points. Reference values are np~np3.

4. Gradient

The example of Gradient element is shown as

Gradient: element symbol

channel: "gz"

align: "left", "middle", "right"

duration: length of gradient pulse. Reference values are gtime~gtime9 in

microsecond.

amplitude: amplitude of gradient pulse. Reference values are gzlevel~gzlevel9,

in percentage value of the maximum gradient (G).

5. ShapeGradient

The example of ShapeGradient element is shown as
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ShapeGradient: element symbol

channel: "gz"

align: "left", "middle", "right"

duration: length of gradient pulse. Reference values are gtime~gtime9 in

microsecond.

amplitude: amplitude of gradient pulse. Reference values are gzlevel~gzlevel9,

in percentage value of the maximum gradient (G).

shape: shape of the gradient. Reference values are gshape~gshape9.

6. ShapePulse

The example of ShapePulse element is shown as

ShapePulse: element symbol

channel: "f1", "f2", "f3", "f4"

align: "left", "middle", "right"

duration: length of pulse. Reference values are sp~sp20 in microsecond, s.

power: RF power of the pulse. Reference values are plvl0~plvl20 in dB.

phase: the phase of the pulse. Reference values are ph1~ph10.

offset: the offset of RF transmitter. Reference values are fq~fq10 in Hz.

shape: shape of the pulse. Reference values are pulseshape~pulseshape9.

7. CompositPulse

The example of CompositPulse element is shown as

CompositPulse: element symbol

channel: "f1", "f2", "f3", "f4"
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align: "left", "middle", "right"

duration: length of pulse. Reference values are sp~sp20 in microsecond, s.

power: RF power of the pulse. Reference values are plvl0~plvl20 in dB.

phase: the phase of the pulse. Reference values are ph1~ph10.

offset: the offset of RF transmitter. Reference values are fq~fq10 in Hz.

shape: shape of the pulse. Reference values are pulseshape~pulseshape9. Refer

to the files in ~/system/data/shapelib directory.

8. Shim

The example of CompositPulse element is shown as

Shim: element symbol

channel: "shim"

align: "left", "middle", "right"

duration: lasting time for shimming

In the pulse sequence text, the phase used by the pulse sequence element must

give detailed information in the phase list, and the parameters used must also give

detailed information in the pulse sequence parameter list.

If the parameter used in an element is numeric type, it can be directly given a

numeric value. For example, a delay of 0.2s can be assigned directly, but double

quotes must be used.

The value of a property in an element can not only equal to a parameter name or

numeric value, but also to an expression. For example, a gradient element can be

expressed as (1-2*parseInt(ci/2))*0.8*gzlevel, Where parseInt(ci%2) indicates that

the remainder of ci divided by 2 is rounded, and gzlevel represents the gradient field

strength value of the Z direction set by the current experiment. Note that the
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parameters used in expression must have been defined in the parameter definition of

the pulse sequence.

Only hard gradients and shape gradients can exist in the gradient channel, and

other elements cannot exist in the gradient channel; hard gradients and shape

gradients cannot exist in the observation channel and the decoupling channel.

3.1.3 Grammar for elements not related to channels

Three elements are not related to channels: condition element If, loop element

Loop and decoupling element Stage. These elements are not within time slice, but

before or after time slices. They separate time slices.

1. If

The condition element consists of start and end parts. The start part contains

condition information, whereas the end part is just an end symbol.

(1) Start of the condition element

Example:

If: start symbol

condition: the content of condition

(2) End of the condition element is just an end symbol

2. Loop

The loop element consists of start and end parts. The start part contains loop

counting information, whereas the end element is just an end symbol.

(1) Start of Loop

Example:
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Loop: start symbol

count: number of loops, can be a parameter or an expression.

index: index of loop, starting from 0.

(2) End of the loop element is just an end symbol

3. Stage

When decoupling channel exists in pulse sequence，the decoupling information

can be included in the pulse sequence. This information is expressed by using Stage

to separate pulse sequence into several time periods. The decoupling status for each

period is controlled by the setting of the parameter decon, which consists of a string of

letters whose number equals to the total number of periods. The value for each letter

can only be "n" or "y", corresponding to decoupling off or on. If you want to separate

the pulse sequence in some place, simply insert a line with content of <Stage />. This

is represented as a triangle in pulse sequence diagram, at the bottom of the position

for separation, as shown in Figure 3.3. If decon = "nny", the decoupling will be

turned on during acquisition, and a light-blue square will be displayed at the

decoupling channel just under acquisition time in the diagram (Figure 3.3).

Figure 3.3 Pulse sequence with decoupling separator
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3.2 Display and Editing of Pulse Sequence

3.2.1 Pulse sequence display

For any experiment displayed in workspace, click the Sequence tab, then click

Diagram or Source tab to display the diagram or the source code of the pulse

sequence. Figure 3.4 is the diagram of a pulse sequence.

Figure 3.4 Pulse sequence graphic display

3.2.2 Change Pulse Sequence

Open the workspace, switch the tab of the workspace to the Parameters -

Acquparams page, click the button to the right of pulseseq, as shown in the red circle

in Figure 3.5, a pulse sequence selection dialog will pop up, as shown in Figure 3.6.

The pulse sequence displayed in the System group in this dialog box is in

~/system/data/pslib in the directory where the software is located. The pulse sequence

displayed in the User group is in ~/system/data/pslib/user in the directory where the

software is located. Select a pulse sequence and click the OK button. At this point,

switch the tab of the workspace to the Sequence page. The Sequence page will

display the selected pulse sequence.

Figure 3.5 Display file list
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Figure 3.6 Pulse sequence selection dialog

3.2.3 Editing Pulse Sequence

1. Create New Pulse Sequence

There are two ways to create a new pulse sequence:

(1) Create the text file of the new pulse sequence using an editor such as

Notepad++, then save it with an extension of .ps to the directory

~/system/data/ pslib.

(2) Using PS Editor to create the new pulse sequence. Refer to 3.4.1 Create

New Pulse Sequence for details.

2. Edit the pulse sequence text

Three ways can be used for pulse sequence editing.

(1) Modify the text directly. The pulse sequence text saved in the

~/system/data/pslib directory is opened in a text editing software such as

Notepad++, and can be saved after modification. This method will modify

the pulse sequence in the configuration file.

(2) Using PS Editor to edit the pulse sequence. Refer to 3.4.2 and 3.4.3 for

details. This method will modify the pulse sequence in the configuration file.

(3) Edit the pulse sequence in the workspace. To start the software and open a

workspace, switch the tab of the workspace to Sequence, which has two
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subpages: Diagram and Source. The Diagram page is shown in Figure 3.7.

This method only modifies the pulse sequence in the workspace.

Figure 3.7 Pulse Sequence Source Page

3.3 Synchronization of pulse sequence and experimental parameters

1. When opening a workspace, changing pulse sequence or after editing a pulse

sequence, the program will try to retrieve the property of each parameter. For a

parameter with the property of force="true", the value in the parameter list of pulse

sequence will be given to this parameter; if force="false", the value of the parameter

will not be changed.

2. The values displayed in the pulse diagram are the true values of parameters.

When the values are changed in command line or in Parameters tab, the diagram will

be refreshed in real time. There are two ways to modify the experimental parameters:

(1) edit in the parameter panel Parameters; (2) modify the parameters by command,

for example, enter d1=3 in the command line and press Enter to take effect.

3.4 PS Editor

3.4.1 Create New Pulse Sequence

Click the menu bar Tools > PS Editor > New PS to open the New Pulse

Sequence dialog box, as shown in Figure 3.8.
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Figure 3.8 New Pulse Sequence dialog box

In the left frame, select a sequence in the sequence library as the template, and

the right side is the description of the currently selected sequence. The Save Path

below is the newly edited sequence storage path. You can also click the button

Browse to select another path. File Name is the newly edited sequence name. Click

Finish when you are finished and the pulse sequence editor will open. The selected

template pulse sequence is loaded in the editor. The user can edit the sequence, that is,

change it to save. For the specific editing method, see 3.4.3 Edit Pulse Sequence.

3.4.2 Opening an existing pulse sequence

Click on the menu bar Tools > PS Editor > Open PS to open the pulse sequence

selection dialog box as shown in Figure 3.9. Select the pulse sequence file to be

modified and open it. The pulse sequence editor loads the selected pulse sequence.

The user can edit the sequence. For details, see 3.4.3 Edit Pulse Sequence.
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Figure 3.9 Pulse sequence selection dialog box

3.4.3 Edit Pulse Sequence

There are two subpages in the Pulse Sequence Editor: Diagram and Source. The

Diagram page is shown in Figure 3.10.

Figure 3.10 Diagram page

In the Diagram page, users can add elements to the sequence by dragging, and

can easily edit the element attributes, as follows.

Add new element: in the right area where all elements are listed, click the

element you want to add, then move the mouse cursor to the position in sequence

diagram where you want to put it, click again. The new element will be added at this
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position.

Move an element: in sequence diagram, click on the element you want to move,

then drag it to the new position and release the mouse button. The selected element

will be moved to the new position.

Edit an element: Double-click on any element, or right-click on the element to

display the menu shown in Figure 3.11. Select Properties to open the element property

editing area (see Figure 3.10). After editing the element properties in the property

editing area, it will be valid in real time and saved in real time.

Right click in the sequence display area will also pop up the right-click menu as

shown in Figure 3.11.

Figure 3.11 Pulse sequence editing related right-click menu

Undo, Redo, Cut, Copy, Paste: editing operations on elements

Show Duration, Show Power, Show Phase: display time, power or phase

Reset, Zoom In, Zoom Out, Shift Left, Shift Right: operation on the diagram

Properties: open element property tab

Validate PS text: check the grammar of the sequence text

The Source tab is shown in Figure 3.12. User can directly edit the source text of

the pulse sequence according to the grammar described in 3.1 Grammar of Pulse

Sequence Editing. Type Ctrl+s, or right-click the mouse button then select Save to

save the changes. You can also right-click and select Content Format to format the
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text, or select Validate PS text to check the grammar of the text.

Figure 3.12 Pulse Sequence Editor Source Page

Chapter 4 1D Data Processing

4.1 Workspace Introduction

Workspace has 4 label pages in total, they are respectively “FID/Spectrum”,

“Parameters”, “Sequence” and “Acqu”, as shown in Figure 4.1.

Figure 4.1 Workspace interface

The “FID/Spectrum” page displays the acquired FID data and the Fourier

transformed spectral data, which are switched by the right-click menu. There are 2
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sub-pages in the “Parameter” page: the acquiring parameter page displays the

parameters (including the pulse sequence parameters) that are called when acquiring,

and the processing parameter page displays the parameters that are called when

processing the data. The “Sequence” page displays the text and graphics of the pulse

sequence, which can be switched by clicking the Graphics and Source tabs at the

bottom left of the page. The “Acqu” page records real-time acquiring information.

Right-click on FID interface to pop up FID and display the menu as shown in

Figure 4.2. You can select to display real and imaginary part of the FID, or display

real and imaginary part of the spectrum. You can also open the FID property page.

Figure 4.2 FID page right-click menu function

The FID property page is divided into two sub-pages: Appearance and

Components. The appearance page is shown in Figure 4.3, and its properties are listed

as follows:

X Unit: Horizontal axis unit, optional values are s, ms, μs, pt

Foreground Color: Foreground color, ie FID curve color

Background Color

Show Grid

Grid Color

Show Border

Border Color

Border Line Width

Line Width: FID curve line width

Anti-aliasing
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Figure 4.3 FID property page Appearance

The component page is shown in Figure 4.4, and its properties are described as

follows:

Title: Whether to display the title. The title can be edited through the right-click

menu of the navigation bar and displayed in the upper left corner of the FID in the

workspace.

Show CursorInfo: Whether to display mouse information. The mouse

information shows the FID information of the current mouse point, which is displayed

in the upper left corner of the FID in the workspace.

Left Axis: Whether to display the left axis.

Right Axis: Whether to display the right axis.

TopAxis: Whether to display the top axis.

BottomAxis: Whether to display the bottom axis.

Figure 4.4 Components of the FID property page

The Appearance page option of the Spectrum property page is the same as the

FID Appearance page, except that the horizontal axis unit selectable values are ppm,

Hz, KHz, MHz, pt.

The component page of the spectrum is different from the FID, and there are
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three more items, as shown in Figure 4.5. The properties of these three components

are described below:

Integral Lines: Whether to display the integral lines.

Integral Label: Whether to display the integral label.

Peaks: Whether to display the peak information.

Figure 4.5 Components of the spectrum property page

4.2 Spectrum Operation

Here are some general spectral operations. The operation of the spectrum can be

done by selecting the corresponding icon on the toolbar. Both the FID and the

spectrum after the Fourier transform can perform the following spectrum operations.

4.2.1 Spectrum zoom

Zoom in or zoom out the spectrum vertically. Roll the mouse wheel up and down

on the spectrum and the spectrum will be zoomed in or zoom out in the vertical

direction. Or use the toolbar icon and , you can also zoom in the vertical

direction of the spectrum.

Zoom in or zoom out the spectrum horizontally. Drag the mouse over the

spectrum to achieve horizontal scaling. The specific operation is as follows: select the

left starting point on the spectrum, click the left mouse button to drag to the right to

release the left mouse button, and the spectrum within the dragging range will be

enlarged horizontally. Drag the mouse from right to left and the spectrum will return

to full spectrum in the horizontal direction. Or using the icon will restore the full

spectrum display both horizontally and vertically.
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4.2.2 Move the spectrum

Move the spectrum in the horizontal direction. The display region can not

display the entire spectrum after the spectrum is zoomed in, at this moment, you need

to move the spectrum horizontally to see the details of each part of the spectrum.

Place the mouse in the area of the horizontal coordinate. At this point, the mouse will

become a graphic with a small double arrow above the arrow. Hold down the left

mouse button and drag it left or right to move the spectrum horizontally. Or click on

the toolbar icon and to move the spectrum left and right, click to move a

small step; click the icon and move to the leftmost or rightmost end of the

spectrum at once.

Place the mouse in the ordinate area, and the mouse will change to the top of the

arrow with a small vertical double-headed arrow. Hold down the left mouse button

and drag it up and down to move the spectrum vertically. Click the toolbar icon

and you can also move the spectrum up and down in the vertical direction, click

to move a small step; click the icon to center the spectrum baseline, and click

to move the spectrum baseline to the bottom.

4.2.3 Illustration

Open the one-dimensional spectrum data, click the toolbar icon to enter the

illustration mode, and the left mouse button selects the area that needs to be enlarged.

Release the left mouse button, and the partial magnification spectrum is displayed in

the upper left corner of the spectrum, as shown in Figure 4.6. In this mode, if you

want to delete the illustration, right click on the illustration and select

.
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Figure 4.6 Show illustration

In the illustration mode or after exiting the illustration mode, you can place the

cursor outside the coordinate axis and move the spectrum up or down or left and right.

4.3 Window Function

Windowing can be done by the command window or dialog window.

4.3.1 Window function via command

Before using the window function, you need to set the window parameter:

“window function” and “window factor”. Users can set it in “Window function” of

“Procparams” interface, as shown in Figure 4.7. It can also be set in the command line.

For example, type wdw=‘exponential’ in the command line to set the window

function to exponential, type lb=3 to set line broadening factor to 3 Hz.

Figure 4.7 Window parameter
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When the value of wdw is set to sine, the values of sb and sbs are automatically

changed to 0.5 and 0, respectively; when the value of wdw is set to cos, the values of

sb and sbs are automatically changed to 1 and 0, respectively.

After setting the parameters, type in the command wft to do the Fourier

transform or type wfp to do the Fourier transform and phase correction.

4.3.2 Window via dialog

Click on the menu bar Process > Spectrum > Window Function to open the

window function dialog on the right side of the spectrum, as shown in Figure 4.8.

Figure 4.8 windowing dialog box

After opening the windowing dialog box, you can check the required windowing

functions, mainly in the following categories: Gaussian, Exponential, Sine, Squared

Sine, Cos, Squared Cos. Multiple window functions can be selected at the same time,

but Sine and Squared Sine cannot be selected at the same time. Cos and Squared Cos

cannot be selected at the same time. After selecting the window function, set the

corresponding parameters and click OK. This operation is equivalent to setting the

parameter and then typing the command wft. After adding the window, the spectrum

type (phase sensitive or absolute value or power) remains the same as before the
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windowing operation.

4.4 Linear Prediction

Linear prediction, as a sub-process in the Fourier transform process, can be

performed by a Fourier transform correlation command or Fourier transform dialog.

4.4.1 Linear prediction via command

The linear prediction related parameters need to be set before using the command

for linear prediction. The user can set it under the Linear prediction column on the

Procparams page of the parameter page, as shown in Figure 4.9. It can also be set on

the command line, such as typing lpmode="forward" at the command line and typing

coffnum=24 to set the number of prediction coefficients to 24.

Figure 4.9 Linear prediction parameters

lpmode indicates the prediction mode. If "no" is selected, no linear prediction is

performed. If "backward" is selected, backward prediction is performed (this function

is temporarily not supported). If "forward" is selected, forward prediction is

performed.

coeffnum indicates the number of prediction coefficients, and the number of

points participating in the prediction must be greater than 5 times of coeffnum,

otherwise the prediction will fail.

effstart and effend represent the starting point index and ending point index of

the participating predictions, and the value is a percentage of the total number of

points relative to the FID. For example, forward and backward predict the default

values of effstart and effend are usually 0 and 1.0 respectively.
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lpstart and lpend represent the starting point index and the ending point index of

the predicted data, and the value is a percentage of the total number of points relative

to the FID. For example, forward and backward predict the default values of lpstart

and lpend are usually 1.0 and 2.0 respectively.

After setting the parameters, type the Fourier transform related commands, such

as ft, wft, etc. During the Fourier transform, the parameter lpmode is identified to

determine whether to perform linear prediction.

4.4.2 Linear prediction via dialog

Click the menu bar Process > Spectrum > Fourier Transform to open the

Fourier Transform dialog box, as shown in Figure 4.10.

Figure 4.10 Fourier transform dialog box

Set the corresponding parameters and click OK. The operation performed at this

time is equivalent to setting the parameter and then typing the command ft. During the

Fourier transform, the parameter lpmode is identified to determine whether to perform

linear prediction.
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4.5 Fourier Transform

The Fourier transform can be performed through commands or the Fourier

transform dialog box.

4.5.1 Fourier transform via command

The parameters invoked by the command to perform the Fourier transform are

the Fourier related parameters in the Procparams parameter panel, including the si in

the Base column, and the other three parameters in the Ft column, as shown in Figure

4.11 . The parameters can be modified on the parameter panel or set on the command

line.

Figure 4.11 Fourier transform parameter

Si represents the number of spectral data points, that is, the number of points in

the Fourier transform. Unlike np, si must be a power of 2, such as 4096, 8192, 16384,

32768, and so on. If the value of np is between two powers of 2 at the time of

sampling, then si is preferably taken as a power higher, and the value of the partial

data point larger than np is filled with 0, which is commonly referred to as zero-filling.

sfidp represents the number of group delay shift points. If reverse selects true, the

inverse Fourier transform is performed; if false is selected, the positive Fourier

transform is performed. fcor is the weighted multiple of the first point in the FID.

The following are Fourier transform related commands:

ft: Fourier transform

fp: Fourier transform+Auto phase correction

wft: Window function+Fourier transform

wfp: Window function+Fourier transform+Auto phase correction

ftabs: Fourier transform+Display absolute spectrum
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ftpwr: Fourier transform+Display power spectrum

wftabs: Window function+Fourier transform+Display absolute spectrum

wftpwr: Window function+Fourier transform+Display power spectrum

4.5.2 Fourier transform via dialog

Click the menu bar Process > Fourier Transform to open the Fourier Transform

dialog box, as shown in Figure 4.12.

Figure 4.12 Fourier transform dialog box

The basic parameters of the Fourier transform and the linear prediction related

parameters can be edited in the Fourier transform dialog box. After setting the

parameters, click the OK button. The operation performed at this time is equivalent to

setting the parameter and then typing the command ft. During the Fourier transform,

the parameter lpmode is identified to determine whether to perform linear prediction.

After the Fourier transform, the workspace automatically switches to the spectrum

display page, as shown in Figure 4.13.
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Figure 4.13 Spectrum display page

4.6 Phase Correction

Phase correction is divided into automatic phase correction and manual phase

correction.

4.6.1 Automatic phase correction

Automatic phase correction can be done by typing the command aph on the

command line or by clicking on the menu bar Process > Phase Correction >

Automatic.

4.6.2 Manual phase correction

Click Phase Correction > Manual under the Process menu, or click the toolbar

icon to enter the manual phase correction mode. The phase correction toolbar

will appear at the top of the spectrum, as shown in Figure 4.14.

Figure 4.14 Manual phase correction toolbar

A vertical green line will appear on the spectrum interface (the default position is

the highest peak center of the spectrum), which is the baseline pivot, as shown in
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Figure 4.15. You can set the mouse location to the new pivot by selecting the

right-click menu Set Pivot Point.

Figure 4.15 Manual phase correction

Now move the mouse to the phase correction toolbar button , then slide the

mouse wheel to adjust the 0 order phase, as shown in Figure 4.16. Clicking the button

or will increase or decrease the zero-order phase by 90 degrees. Clicking the

button will increase the zero-order phase by 180 degrees.

Figure 4.16 Adjusting the 0 order phase

Then move the mouse to the phase correction toolbar button , slide the mouse

wheel to adjust the first-order phase, and the phase-aligned spectrum is shown in

Figure 4.17. If you are not satisfied with the calibration result, click the button to

return to the initial state and re-calibrate. Click the button to save the current
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phase correction spectrum and exit. Click the button to exit without saving the

phase correction result.

Figure 4.17 Spectrum after adjusting the phase

Below the phase correction toolbar, there is a status information bar as shown in

Figure 4.18. The value of pivot indicates the position of the red reference line; the

“phase increment” indicates the sensitivity of the phase adjustment, and the larger the

value, the greater the change of the phase of the mouse sliding in the 0 order and 1st

order phase adjustment. It can be adjusted by the button . Put the mouse on the

button and slide the mouse wheel up and down to increase or decrease the phase

increment. Ph0 represents the value of the current 0 order phase, and ph1 represents

the value of the current 1st order phase.

Figure 4.18 Phase correction information bar

4.7 Baseline Correction

4.7.1 Drift correction

Drift correction can be done by typing the command dc on the command line.

This function is equivalent to automatic calculation of parameters for zero-order

polynomial automatic baseline correction of the spectrum.
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4.7.2 Automatic baseline correction

Automatic baseline correction can be done by typing the command abs on the

command line. It can also be done by clicking Baseline Correction > Automatic

under the Process menu.

4.7.3 Semi-automatic baseline correction

Click the menu bar Process and select Baseline Correction > Semi to enter the

semi-automatic baseline correction mode. The semi-automatic baseline correction

dialog shown in Figure 4.19 is displayed on the right side of the spectrum.

The semi-automatic baseline correction uses an iterative algorithm. There are

two parameters affecting the iterative algorithm: Noise Factor and Cwt Factor, which

can be modified as needed.

Figure 4.19 Semi-automatic baseline correction dialog

When initially entering the semi-automatic baseline correction mode, the

program automatically simulates the baseline using an iterative algorithm based on

the spectrum and displays the automatically calculated “Noise Factor” and “Cwt

Factor” on the dialog. The area selected as the peak in the correction algorithm, the

baseline color is green; the area selected as the baseline, the baseline color is red.

If you are not satisfied with the simulated baseline effect, you can uncheck the

“Auto” option after the “Noise Factor” and “Cwt Factor” and manually adjust these
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two factors to make the simulated baseline and the spectral baseline as close as

possible.

If there is still a partial baseline simulation effect is not ideal, you can select the

peak or select the baseline manually. The dialog box has Select Peak and Select

Baseline for selection. After selecting an option, the user can drag the mouse to select

a region as a baseline or peak, and the program will simulate the baseline again

according to the user's settings.

If the user needs to zoom the spectrum to view the local baseline simulation,

click the right mouse button on the spectrum and select the right-click menu “Enter

zoom in/out” to enter the zoom mode. Then drag the mouse from left to right on the

spectrum to zoom in on the spectrum and drag the mouse from right to left to display

the full spectrum. Click the right mouse button on the spectrum again and select “Exit

zoom in/out” to exit the zoom mode.

Click the button to perform baseline correction on the spectrum based on the

current simulated baseline and save and exit. Click the button to exit directly.

4.7.4 Manual baseline correction

Click the menu bar Process to select the Baseline Correction > Manual option,

or click the button in the toolbar to enter the manual baseline correction mode.

The manual baseline correction dialog shown in Figure 4.20 is displayed on the right

side of the spectrum.

Figure 4.20 Manual baseline correction dialog
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When entering the manual baseline correction mode initially, the default

polynomial degree (Poly Degree) is 5, and the program automatically simulates the

baseline using a polynomial algorithm. You can also manually modify the polynomial

order, and the program will automatically simulate a new baseline based on the

current order and display it. The adjustable range of the polynomial order is 0~9.

The lower text box of Poly Degree shows the polynomial formula, and the

polynomial coefficients can be adjusted by buttons A0~A9. Place the mouse on any of

the coefficient buttons, and the corresponding coefficient value of the current button

will be automatically displayed on the interface, as shown in Figure 4.21. Slide the

mouse wheel and the corresponding factor will increase or decrease. If the order is 5,

only A0~A5 can be edited, and A0~A5 are adjusted in turn to make the red line and

the spectrum baseline overlap as much as possible.

“Increment” means sensitivity, the larger the value, the greater the change in the

coefficient of the mouse's sliding circle. You can increase or decrease the sensitivity

by clicking the button and .

Figure 4.21 Polynomial coefficient

If you need to zoom the spectrum to see the local baseline simulation, drag the

mouse from left to right on the spectrum to zoom in, and drag the mouse from right to

left to display the full spectrum.

Click the button to perform baseline correction on the spectrum based on the

current simulated baseline and save and exit. Click the button to exit directly.
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Chapter 5 2D Data Processing

5.1 2D Spectrum Operation

Here are some general 2D spectral operations.

5.1.1 Spectrum zoom

Drag the mouse over the spectrum to zoom in on the spectrum. The specific

operation is as follows: select the starting point on the spectrum, click the left mouse

button and drag to the end point to release the left mouse button, and the spectrum

within the dragged rectangle will be enlarged. Using the toolbar will restore the

full spectrum display.

5.1.2 Move the spectrum

The display area cannot display all the spectrum after the spectrum is enlarged.

Then you need to move the spectrum to see the details of each part of the spectrum.

Move the spectrum in the horizontal direction. The display region can not

display the entire spectrum after the spectrum is zoomed in, at this moment, you need

to move the spectrum horizontally to see the details of each part of the spectrum.

Click and drag the upper or lower axis to drag the spectrum horizontally. Use the

toolbar to move the spectrum in the horizontal direction. shows the

left shift, shows the right shift, shows moving to the top left end of spectrum,

shows moving to the top right end of spectrum.

Move the spectrum in the vertical direction. Use the toolbar to

move the spectrum in the vertical direction. shows the up shift, shows the

down shift, shows the spectrum base line is in the middle, shows the the

spectrum baseline is is set at the bottom.
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5.1.3 Spectrum display

Click the right mouse button and select the “Edit Contour Levels” option in the

spectrum display area. The dialog will open as shown in Figure 5.1.

Figure 5.1 Contour editing dialog

The user can modify the display sign. If the current spectrum is non-phase

sensitive, then Sign can only select positive signal. If the current spectrum is phase

sensitive, Sign can choose to display positive and negative signals simultaneously,

positive signals or Negative signal. The maximum value (Max Value) is automatically

calculated based on the spectrum and cannot be edited. The user can modify the

contour level (Base level), the contour growth factor (Increment), and the Number of

contour (Level Num). Wherein, the Base level is a percentage relative to the Max

Value; the Increment represents the growth ratio of the adjacent two contour lines; the

Level Num represents the total number of contour lines calculated, and currently

several of them can be selected for display.

Users can place the cursor on the spectrum and slide the mouse wheel to control

the number of displayed contour lines. You can also control the displayed contour line

number by clicking one of the contour lines with the left mouse button in the Contour
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dialog box. As shown in Figure 5.2, the white background contour is a calculated but

not displayed contour, and the blue background is the currently displayed contour.

Figure 5.2 Contour line diagram

Click the “Apply” button to apply the set value to the current spectrum, and click

“Exit” to exit directly.

5.1.4 Row and column display

First, open the 2D spectrum that needs to display the row and column data, click

the icon in the toolbar to enter the row and column display mode, and place the

cursor at any point in the spectrum, it will display the hydrogen spectrum data

corresponding to the current row and column, as shown in Figure 5.3. You can also

click on the icon or separately display the hydrogen spectrum corresponding

to the row or column at any position, and Figure 5.4 shows the hydrogen spectrum

corresponding to a row of the 2D spectrum..
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Figure 5.3 Row and column display for 2D spectrum

Figure 5.4 Row display for 2D spectrum

In this mode, the right mouse button can export the hydrogen spectrum of a row

or column (Figure 5.5). Click to select “Export F2 Dimension Data”, a dialog box will

pop up as shown in Figure 5.6, fill in the corresponding number of the data (the

number range is displayed in the right parenthesis), and the default number is the row

and column number corresponding to the red cross line intersection in Figure 5.5. By

default, the data is exported to the same directory of the current array data. You can

also click the Browse button to select the path and automatically name it as “current

data name _row/col_ filled in the row and column number”. The F2 dimension data is

exported by default “Row”.
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Figure 5.5 Row or column data export for 2D spectrum

Figure 5.6 Row or column data export dialog for 2D spectrum

5.1.5 Projection Display

On the side of the two-dimensional spectral display area, the corresponding

one-dimensional spectrum can be projected and displayed. Right-click on Properties

in the 2D spectrum display area and open the property page, as shown in Figure 5.7.

You can control the display/non-display of projections within Components.

Figure 5.7 Projection display property page

After the projection is displayed, right-clicking on the projection area will
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display the menu shown in Figure 5.8. The display of the internal projection or the

external projection can be switched by the right-click menu.

If it is currently displayed as an internal projection, the default is to display

“Positive”, and you can select “Positive”, “Negative”, or “Both” by right-click menu.

If the current display is an external projection, the default is to display the positive

and negative peaks (Both) and cannot be modified.

Figure 5.8 Right-click menu in projection state

Click on “External Projection”, if no external projection has been imported, the

dialog shown in Figure 5.9 will pop up. You can import an external projection by

selecting the external projection data directory.

Figure 5.9 Select external projection data directory

If an external projection has been imported, the data of the last imported external

projection will be saved in the .nmr file of the current path. When the user clicks on

External Projection, the dialog box shown in Figure 5.10 will pop up first, allowing

the user to select whether to display the “Projection in current file” or “Projection in

other file”. If the user selects “Projection in current file”, it will directly display the
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external projection of the last import. If “Projection in other file” is selected, the

dialog box shown in Figure 5.9 above will pop up to reselect the one-dimensional

projection data.

Figure 5.10 Import external projection dialog

5.2 2DWindow Function

2D windowing is similar to 1D, and can be done through command or dialog.

The parameter type of the 2D windowing is the same as that of the 1D, and only the

corresponding parameters in the F1 dimension are added. For example, the window

function on the F2 dimension is “wdw”, and the window function on the F1

dimension is “wdw1”.

5.2.1 Window via command

Before using the window, you need to set the window parameter: window

function, and window factor. Users can set it in Window function of “Procparams”

interface, as shown in Figure 5.11. It can also be set in the command line. For

example, type wdw1=‘exponential’ in the command line to set the window function

of F1 dimension to exponential, type lb1=3 to set line broadening factor of F1

dimension to 3 Hz.

Figure 5.11 Window parameter
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When the corresponding parameters sb and sbs of the sine window are 0.5 and 0,

respectively, when the parameters sb and sbs corresponding to the cos window are 1,

0, respectively, a better effect can be obtained. Therefore, when the value of wdw1 is

set to sine, the values of sb1 and sbs1 are automatically changed to 0.5 and 0,

respectively; when the value of wdw1 is set to cos, the values of sb1 and sbs1 are

automatically changed to 1 and 0, respectively.

After setting the parameters, type in the command wft to do the Fourier

transform or type in wfp to do the Fourier transform and phase correction.

5.2.2 Window via dialog

Click on Spectrum > Window Function under the Process menu to display the

window function dialog on the right side of the spectrum, as shown in Figure 5.12.

Figure 5.12 Windowing dialog box

After opening the windowing dialog box, you can check the required windowing

functions, mainly in the following categories: Gaussian, Exponential, Sine, Squared

Sine, Cos, Squared Cos. Multiple window functions can be selected at the same time,

but Sine and Squared Sine cannot be selected at the same time. Cos and Squared Cos

cannot be selected at the same time. After selecting the window function, set the

corresponding parameters and click “OK”. This operation is equivalent to setting the
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parameter and then typing the command wft. After adding the window, the spectrum

type (phase sensitive or absolute value or power) remains the same as before the

windowing operation.

5.3 2D Linear Prediction

Linear prediction is a sub-process in the Fourier transform process. 2D linear

prediction is the same as 1D, and can be performed by Fourier transform related

commands or Fourier transform dialog. The parameter type of 2D windowing is the

same as that of 1D, and only the corresponding parameters in the F1 dimension are

added. For example, the prediction mode on the F2 dimension is “lpmode”, and the

window function on the F1 dimension is “lpmode1”.

5.3.1 Linear prediction via command

The linear prediction related parameters need to be set before using the command

for linear prediction. The user can set it under the Linear prediction column on the

“Procparams” page of the parameter page, as shown in Figure 5.13. It can also be set

on the command line, such as typing lpmode="forward" at the command line and

typing coffnum=24 to set the number of prediction coefficients to 24.

Figure 5.13 Linear prediction parameters

“lpmode” indicates the prediction mode. If "no" is selected, no linear prediction

is performed. If "backward" is selected, backward prediction is performed (this

function is temporarily not supported). If "forward" is selected, forward prediction is

performed.

“coffnum” indicates the number of prediction coefficients, and the number of
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points participating in the prediction must be greater than 5 times of coffnum,

otherwise the prediction will fail.

“effstart” and “effend” represent the starting point index and ending point index

of the participating predictions, and the value is a percentage of the total number of

points relative to the FID.

“lpstart” and “lpend” represent the starting point index and the ending point

index of the predicted data, and the value is a percentage of the total number of points

relative to the FID.

After setting the parameters, type the Fourier transform related commands, such

as ft, wft, etc. During the Fourier transform, the parameter “lpmode” is identified to

determine whether to perform linear prediction.

5.3.2 Linear prediction via dialog

Click on Spectrum > Fourier Transform under the Process menu to open the

Fourier Transform dialog box, as shown in Figure 5.14.

Figure 5.14 2D Fourier transform dialog

Set the corresponding parameters and click OK. The operation performed at this

time is equivalent to setting the parameter and then typing the command ft. During the

Fourier transform, the parameter “lpmode” and “lpmode1” are identified to determine

whether to perform linear prediction for F2 dimension and F1 dimension.
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5.4 2D Fourier Transform

2D Fourier transform is similar to 1D, and can be done through command or

dialog. The parameter type of the 2D Fourier transform is the same as that of the 1D,

and only the corresponding parameters in the F1 dimension are added. For example,

the size of spectrum on the F2 dimension is “si”, and the size of spectrum on the F1

dimension is “si1”.

5.4.1 Fourier transform via command

The parameters invoked by the command to perform the Fourier transform are

the Fourier related parameters in the “Procparams” parameter panel, including the si

in the “Base” column, and the other five parameters in the “Ft” column, as shown in

Figure 5.15. The parameters can be modified on the parameter panel or set on the

command line.

Figure 5.15 2D Fourier transform parameter

“si” represents the number of spectral data points, “sfidp” represents the number

of group delay shift points. If reverse selects true, the inverse Fourier transform is

performed; if false is selected, the positive Fourier transform is performed. “fcor” is

the weighted multiple of the first point in the FID.

The following is the Fourier transform related command, which is exactly the

same as the one-dimensional Fourier transform command.

ft: Fourier transform

fp: Fourier transform+Auto phase correction

wft: Window function+Fourier transform
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wfp: Window function+Fourier transform+Auto phase correction

ftabs: Fourier transform+Display absolute spectrum

ftpwr: Fourier transform+Display power spectrum

wftabs: Window function+Fourier transform+Display absolute spectrum

wftpwr: Window function+Fourier transform+Display power spectrum

5.4.2 Fourier transform via dialog

Click on the Spectrum > Fourier Transform option under the menu Process to

open the Fourier Transform dialog box, as shown in Figure 5.16.

Figure 5.16 2D Fourier transform dialog box

The basic parameters of the Fourier transform and the linear prediction related

parameters can be edited in the Fourier transform dialog box. After setting the

parameters, click the OK button. The operation performed at this time is equivalent to

setting the parameter and then typing the command ft. During the Fourier transform,

the parameter lpmode and lpmode1 are identified to determine whether to perform

linear prediction.

After the Fourier transform, the workspace automatically switches to the

spectrum display page.
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5.5 2D Phase Correction

Phase correction is divided into automatic phase correction and manual phase

correction.

5.5.1 Automatic phase correction

The 2D spectrum does not support automatic phase correction currently.

5.5.2 Manual phase correction

Click the toolbar icon or click Phase Correction > Manual under the

Process menu. The spectrum will enter the manual phase correction mode. The phase

correction toolbar will appear at the top of the spectrum. The toolbar is shown in

Figure 5.17.

Figure 5.17 Manual phase correction toolbar for 2D spectrum

Move the mouse to the 2D spectrum in the workspace and right click to display

the context menu, as shown in Figure 5.18. Select “Add Peak”, the peak of the current

position of the mouse is marked with a small red circle and a crosshair to indicate that

the peak is selected. “Remove” indicates canceling the currently selected peak, and

“Remove All Peaks” means canceling all currently selected peaks. You can select 2~4

points as needed.

Figure 5.18 Schematic diagram of peak selection for 2D spectrum phase correction
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After selecting the peak, click to enter the row phase mode, and click to

enter the column phase mode. The row or column corresponding to the selected point

is extracted and arranged vertically for phase modulation, as shown in Figure 5.19.

The green line on the spectrum is the baseline pivot, and the red line position is the

highest point of the absolute value of the spectrum.

The phase adjustment method is the same as 1D, and the workspace reflects the

spectrum phase change in real time.

Figure 5.19 2D spectrum interactive phase adjustment

The spectrum effect of the two-dimensional spectral phase correction is shown in

Figure 5.20.

Figure 5.20 2D spectrum phase correction effect diagram

5.6 2D Baseline Correction

The 2D spectrum does not have a baseline correction function currently.
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5.7 J Spectrum Tilt

Click the Tilt option in the menu Process, open J spectrum tilt dialog as shown

in Figure 5.21.

Figure 5.21 J Spectrum Tilt dialog

Auto tilt along rows

Automatically tilt along the row. This can also be done by entering the command

tilt on the command line.

Tilt along rows

Tilt in row direction. When you select this option, you need to manually enter the

Tilt angle factor (F2, -2...2) on the dialog. The range of this parameter is between -2

and 2. Tilt angle θ=arctan(factor), when θ is a positive value, the point above the axis

in the horizontal level of the spectrum is tilted to the right, and the point below the

horizontal center axis is tilted to the left. When θ is a negative value, the tilt direction

is opposite.

Tilt along columns

Tilt in row direction. When you select this option, you need to manually enter the

Tilt angle factor (F1, -2...2) on the dialog. The range of this parameter is between -2

and 2. Tilt angle θ=arctan(factor), when θ is a positive value, the point on the left side

of the axis of the spectrum is tilted upward, and the point on the right side of the

center axis is tilted downward. When θ is a negative value, the tilt direction is

opposite.
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5.8 t1 Noise Elimination

Click the Eliminate t1 Noise option under Process to enter the eliminate t1 noise

mode, as shown in Figure 5.20.

Click the left mouse button to select the start and end lines, and select the vertical

region parallel to the F2 dimension with the t1 noise signal but no peak (see Figure

5.22). In the figure, 11 rows to 82 rows are selected, and then the right mouse button

is selected to select the menu “Eliminate T1 Noise”, and the t1 noise of the entire

spectrum is deducted, and the effect is shown in Figure 5.23.

Figure 5.22 Enter to t1 noise elimination mode

Figure 5.23 t1 noise elimination effect

5.9 Symmetry

5.9.1 COSY-like

COSY spectrum symmetry can be performed by clicking the Process menu,

selecting the Symmetry > COSY-like option, or entering the command sym directly.
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Note: When the COSY spectrum is symmetrized, the F2 dimension Fourier

transform points are the same as the F1 dimension Fourier transform points, that is, si

is equal to si1.

5.9.2 J-Resolved

J-spectrum symmetry can be performed by clicking on the menu bar Process,

selecting the Symmetry > J-Resolved option, or entering the command symj directly.

Before the symmetry of the homonuclear J-spectrum, it should be tilted first, see 5.7 J

Spectrum Tilt.
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Chapter 6 Data Analysis

6.1 Reference

6.1.1 Automatic calibration

Automatic calibration is based on the solvent selected when the field is locked.

Click the menu bar Analysis to select the Reference > Automatic option, or enter the

aref command in the command bar to perform the auto-calibration operation (the

calibration operation is performed by default when the sampling command is

executed).

Note: If the wrong solvent is selected during the injection or new experiment, the

automatic calibration will produce the wrong result. In this case, you can type rearef

on the command line, pop up the solvent selection box (Figure 6.1), select Lock

Solvent and Real Solvent, click the OK button, then the solvent information in the

base information column of the Acquparams will be automatically modified, and

perform the calibration operation again based on the current solvent.

Figure 6.1 Solvent selection box

6.1.2 Manual calibration

Click the Reference > Manual option under the menu bar Analysis, or click the

toolbar icon to enter the manual calibration mode. A green line will appear in the

spectrum, as shown in Figure 6.2.



174

Figure 6.2 Manual calibration interface

Old Shift: The horizontal position of the green vertical line in the spectrum.

New Shift: Reset the horizontal position of the green vertical line.

: Save and exit the calibration mode.

: Exit calibration mode without saving.

If you want to set the coordinates of the rightmost peak of the spectrum to 0 ppm,

just click the rightmost peak and set the value of “New Shift” to 0 on the right side of

the pop-up page. Click the Save button to complete the calibration. The result is

shown in Figure 6.3, and the rightmost peak coordinate has been set to 0 ppm.

Figure 6.3 Calibration effect spectrum

After entering the calibration mode, the spectrum cannot be scaled horizontally.

Click the right mouse button in the blank space to pop up the “Enter Zoom” option.

Click this option to enter the spectrum zoom mode. Click the right mouse button in

zoom mode to pop up the “Exit Zoom” option, click this option to exit the spectrum
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zoom mode.

6.2 Peak Picking

There are two types of peak picking modes: automatic and manual. After the

peak picking result is saved, the “Peak” item will be generated on the right side of

Acqu below the workspace. You can delete any line by right mouse button or export it

to .txt or .xls format file for post processing.

6.2.1 Automatic peak picking

Click the menu bar Analysis to select the Peak Picking > Automatic option, or

type pps in the command line to perform an automatic peak picking operation. The

peak picking results are shown in Figure 6.4. When pps is input, the threshold is

automatically calculated, that is, the spectrum is divided into 32 segments, the

difference between the maximum and minimum intensities of each segment is

calculated, and then the smallest difference in the 32 segments is multiplied by 4. You

can also manually set the threshold according to the ordinate value of the spectrum.

For example, you can type pps(1000000) or pps 1000000, which is equivalent.

Figure 6.4 Peak picking results

6.2.2 Manual peak picking

Click on the menu Analysis to select theManual option under Peak Picking, or

click the toolbar button to enter the manual peak picking mode. The toolbar
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shown in Figure 6.5 will appear at the top left of the spectrum.

Figure 6.5 Peak picking toolbar

: Peak picking by threshold. See 1 Threshold peak picking below for details.

: Peak picking manually. See 2 Peak picking manually below for details.

: Pick max peak in selected range. Hold down the left mouse button to select

the range, and when you release it, automatically pick the peak with the highest

intensity in the range. In this mode, the right mouse button function is exactly the

same as the “peak picking manually”. Refer to 2 Peak picking manually.

: Pick peaks in selected ranges. See 3 Range peak picking below for details.

: Delete the selected peak. First select the peak to be deleted, and then click

this icon to clear the currently selected peak information label.

: Remove all peaks. Clicking on this icon will clear all peak information labels

displayed on the spectrum. In the array spectrum, click the icon to clear the peak

information label for the currently selected spectrum.

: Save and exit peak picking mode. The peak information obtained by the

“peaks” is saved as a node to the system directory, the node name is “peaks”, and then

the peak picking mode is exited. The system log records the full path to the saved file.

: Exit peak picking mode without saving. The system does not save the peak

information and exits the peak-picking mode, but the peak-picking label is

temporarily retained on the workspace interface.

A detailed description of threshold peak picking and manual peak picking is as

follows.

1. Peak picking by threshold

When entering the manual peak picking mode, the default is “Peak picking by

threshold”. At this time, a green line is displayed in the spectrum, as shown in Figure

6.6.
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Figure 6.6 Interface for “Peak picking by threshold”

Click the right mouse button in the spectrum area to pop up the menu shown in

Figure 6.7.

Figure 6.7 Right-click menu in “Peak picking by threshold” mode

Pick Positive Peaks: Pick all positive peaks larger than this threshold, and the

results are shown in Figure 6.8;

Pick Negative Peaks: Pick all negative peaks whose absolute value is larger than

this threshold;

Pick Peaks: Pick all positive peaks and negative peaks whose absolute value

larger than this threshold;

Delete All Peaks: Clear all peak information in the spectrum (Figure 6.9);

Delete Selected Peaks: First select the peak to be deleted, and then click this

option to clear the currently selected peak information label (Figure 6.9);

Enter Zoom: Enter zoom mode. After entering the peak picking mode, the

spectrum cannot be scaled by dragging the mouse horizontally. You need to click this

option to zoom. Peak picking is not supported in zoom mode. After zooming to the
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desired area, click “Exit Zoom” to exit the spectrum zoom mode (Figure 6.9).

Figure 6.8 Spectrum with picking positive peaks

Figure 6.9 Right-click menu when there is peak information

2. Peak picking manually

Click the icon in the peak picking toolbar to enter the “Pick peaks in selected

ranges” mode. In this mode, the right click menu is shown in Figure 6.10. “Delete All

Peaks” means to delete all peaks. “Delete Selected Peaks” means to delete the

currently selected peaks. Click “Enter Zoom” to enter zoom mode to zoom the

spectrum, click “Exit Zoom” to exit zoom mode.

Figure 6.10 Peak picking manually
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3. Pick peaks in selected ranges

Click the manual peak picking icon to enter the “Pick peaks in selected

ranges” mode. Hold down the left mouse button and drag to form a square area

(Figure 6.11). Release the left mouse button and the information label of all the peaks

at the top of the peak will be displayed, as shown in Figure 6.12. In this mode, the

right mouse button function is exactly the same as “peak picking manually” and you

can refer to 2 Peak picking manually.

Figure 6.11 Select peak ranges in “Pick peaks in selected ranges” mode

Figure 6.12 Spectrum after “Pick peaks in selected ranges”

6.3 Integration

Click on the menu Analysis to select Integration >Manual, or click on the icon

in the toolbar to enter the manual integration mode. The integration toolbar will

appear at the top left of the spectrum, as shown in Figure 6.13.
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Figure 6.13 Integration toolbar

: Delete the selected integrals. First select the integrals you want to delete, then

click this icon to clear the currently selected integration information.

: Delete all integrals. Click this icon to clear all the integrals displayed on the

spectrum.

: Save and exit the integration mode. After saving the integration result, an

“Integration” item will be generated on the right side of Acqu below the workspace.

You can delete any line by right mouse button, or export it to .txt or .xls format file for

post processing.

: Exit the integration mode without saving the integration information.

A detailed description of other functions is as follows.

1. Add new integral manually

After entering the manual integration mode, place the mouse in the spectrum

display area, at which point the mouse will become the integral line graph and a

vertical red line will appear. Drag the red line to the appropriate position on the left

side of the peak that needs to be integrated, press the left button and drag to the

appropriate position on the right side of the peak, release the mouse button, and mark

the corresponding integral line and integral value on the spectrum. Repeat the same

operation to integrate the peaks that need to be integrated (Figure 6.14).

Figure 6.14 Schematic diagram of manual integration
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2. Add new integral via dialog

Clicking the Integral toolbar button will pop up the Add Integral dialog

shown in Figure 6.15. The value of the “Unit” drop-down box indicates the numerical

unit in the text boxes “From” and “To”. The default is ppm, and you can drop down to

select others. In the “From” text box, enter the abscissa of the starting point, and enter

the abscissa of the end of the point in the “To” text box. Click “OK” and the result

will be displayed in the spectrum. Click “Cancel” to cancel the operation of adding

new integral.

Figure 6.15 Add integral dialog

3. Expand by 1.15

Click the integration toolbar button to zoom in on the integral line level.

Place the mouse on the icon and click the left or right button once to zoom in or out

all the integration lines in the spectrum by 1.15 times, or use the scroll wheel to zoom.

4. Expand by X

Click the Integral toolbar button and the Zoom Integral dialog box will pop

up, as shown in Figure 6.16. Enter the scaling factor in the “Scaling Factor” text box.

After clicking “OK”, the system will scale the integration line according to the input

scale factor. Click “Cancel” to cancel the zoom.

Figure 6.16 Integral scaling dialog
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5. Delete integrals

Place the mouse on the information label position of the integral segment to be

deleted. At this time, the number will turn green. Click the left mouse button and the

color will turn dark green, indicating that the peak information to be deleted has been

selected. Click the icon and the system will delete the currently selected integral

segment. Right click and select “Delete selected integrals” from the right-click menu

to get the same result. If you want to delete all the integrals, click on the icon or

select “Delete all integrals” in the right-click menu (Figure 6.17).

Figure 6.17 “Delete integrals” in right-click menu

6. Edit current integral

Select the integral segment as described above, and then select “Edit current

integral” from the right-click menu, and a menu similar to Figure 6.15 will pop up.

You can re-select the values of “From” and “To” to precisely adjust the integral

segment.

7. Calibrate current integral

Select the integral segment to be used as the integral reference value as described

above, and select “Calibrate Current Integral” from the right-click menu to bring up

the dialog box (Figure 6.18). You can set the integral segment to the value of the

nucleus it represents as a reference.
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Figure 6.18 Dialog box for integral calibration

6.4 Multiple Spectrum Display

6.4.1 Multiple spectrum display

Open the spectrum data, click the Multiple Spectrum Display option under the

menu Analysis, or click the system toolbar button to enter the multiple spectrum

display mode. The spectrum of the current workspace is the reference spectrum, as

shown in Figure 6.19.

Figure 6.19 Multiple spectrum display interface

The multiple spectrum display toolbar at the top left is shown in Figure 6.20.

Figure 6.20 Multiple spectrum display toolbar

In “multiple spectrum display” mode, in the data navigation panel on the left,

double-click the data you want to use, and the spectrum of the data will be displayed

in the current workspace, together with the previous spectrum display. In the same

way, you can continue to add spectrum data. It should be noted that the data in the

multiple spectrum display area must be the same nucleus, but the acquisition

parameters such as the spectrum width may be different, and the actual displayed area

is based on the reference spectrum. Three spectra are displayed simultaneously in
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different colors as shown in Figure 6.21.

Figure 6.21 Schematic of multiple spectrum display

Note that the spectra are displayed in overlapping at this time. The upper right

corner area displays the data path information of each spectrum in different colors. If

the box on the right side is filled, it indicates that it is the current active spectrum, and

some operations can be performed on it. Click the icon to switch between

displaying/not displaying information.

If you choose the wrong one or no longer need one of the spectra, you can click

on the corresponding path information area box, select the spectrum, and then click

the icon to delete it. Note that the system cannot remove the base spectrum.

Click on the icon to change the spectrum from overlapping display to top

and bottom (Figure 6.22). Click this icon repeatedly to switch between the two

display modes.

Figure 6.22 Spectra display separately
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Click on the icon and respectively to zoom in or out twice the selected

spectrum. If you place the mouse directly in the spectra display area and scroll the

wheel, all selected spectra will be zoomed in or out vertically.

Place the mouse over the icon and scroll the wheel to move the selected

spectrum vertically.

6.4.2 Spectral addition and subtraction

In the “multiple spectrum display” mode, addition or subtraction of the spectrum

can also be performed. In the process of addition and subtraction, always use the

reference spectrum as one of them, then select another spectrum, click , the system

will add the reference spectrum to the selected spectrum, and display the added

spectrum at the top ( Figure 6.23).

Figure 6.23 Adding spectra

If a spectral subtraction is to be performed, the reference spectrum is also used as

the starting spectrum. Select another spectrum and click , the system will subtract

the selected spectrum from the reference spectrum and display the subtracted

spectrum at the top (Figure 6.24).
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Figure 6.24 Spectrum subtraction

After completing the spectral addition and subtraction operation, clicking

will pop up the dialog box shown in Figure 6.25 to save the result of the addition and

subtraction of the spectrum. The user can change the data storage address or

experiment name on the dialog box as needed.

Clicking does not save and exits the “multiple spectrum display” mode

directly.

Figure 6.25 Save spectrum addition and subtraction results

6.5 Array Data Display and Processing

Array data is a set of values that are set during the experiment. In the experiment,

one of these array values is taken to perform an experiment, and obtain a set of

experiment data.
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Before the experiment, some experiment parameters are set to a set of values

(such as setting the pulse width p1 to a series of values to find the 90-degree pulse

width). In the experiment, one of these parameter array values is taken to perform

experiments to obtain a set of experimental data, the array data is formed.

6.5.1 Array data display

The display of array data in the workspace is in the form of multiple spectra

arrangements. Multiple data can be arranged horizontally or vertically by clicking the

Horizontal or Vertical option under the menu bar View > Layout (Figure 6.26).

Figure 6.26 Horizontal (left) and vertical (right) display of array FID

Clicking on the Stacked option under the menu bar View > Layout will cause

the data to be stacked in a certain degree of inclination. A window pops up, allowing

the user to set the horizontal misalignment value for the stack display (Figure 6.27).

The data displayed after setting will be displayed in a stack according to the

horizontal misalignment between each data (Figure 6.28).

Figure 6.27 Horizontal misalignment value when stacked
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Figure 6.28 Stack display of array data

Clicking on the menu has the option to get more array data images. You can click

on the menu bar View to select Trace Manager, or click the toolbar icon . The

array data selection panel shown in Figure 6.29 will pop up on the right side of the

spectrum. Figure 6.30 shows the functions of the various buttons on the toolbar above

the array data selection panel.

Figure 6.29 Array data selection panel

Figure 6.30 Array manager toolbar

Any data in the array data can be displayed in the workspace by using the

function buttons of the array data selection panel. Users can selectively display certain

data by checking the way. Clicking on the icon will display the selection in turn,
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and clicking the icon will display all the data. You can also click on the icon

or to display odd or even digit data. Clicking on the icon will bring up a

window that lets you select the starting and ending range of the data you want to

display (Figure 6.31). Clicking on the icon or will cause the data to be

displayed horizontally or horizontally (as shown in Figure 6.26 above).

Figure 6.31 Select array spectrum display range

In the array spectrum display mode, use the left mouse button to click on any

spectrum. At this time, the number of the spectrum becomes green, and the user can

change the display range, height, peak picking, and integral operation of the spectrum.

Click the format brush icon to apply the results of the previous actions to all

spectra simultaneously.

Fourier transform of the array FID will result in an array spectrum, and the array

spectrum can also perform the operations described in this section.

6.5.2 Array data processing

To perform array data processing, you need to activate a current data (the

spectrum with the green number in the lower right corner is active). The data is

processed first, and other data requires the same operation to use the format brush

button . Figure 6.32 shows the results of the Fourier transform and phase

correction of the array FID in Figure 6.26.
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Figure 6.32 Array data activation display

If you need to do peak picking or integration, the format brush can't meet the

requirements of applying to other data. You need to enter the peak/integration mode.

After completing the peak/integration operation, click the icon on the

peak/integration toolbar to apply the result to all the spectra (Figure 6.33).

Figure 6.33 Array data peaking display

6.6 Fitting

Open the array spectrum data, and then click the Fitting option under the

Analysis menu to enter the fitting interface, as shown in Figure 6.34.
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Figure 6.34 Fitting interface

Zoom in/out: Spectral scaling. Select this option to scale the spectrum

horizontally. You can select the signal you want to fit to scale (scaling a signal or all

signals in a certain area).

Peak: Select this option to perform peak-picking operations.

Integration: Select this option to perform integration operations.

T1: Select this option to perform T1 relaxation fitting.

T2: Select this option to perform T2 relaxation fitting.

DOSY: Select this option to perform DOSY fitting.

6.6.1 T1 relaxation fitting

Open the T1 array spectra, first adjust the phase of the last spectrum to pure

absorption through the Trace Manager tool, and then apply the same phase to the

other sub-spectra. Click the Fitting option under the Analysis menu, the system will

enter the data fitting page, and various options will be displayed on the right side of

the workspace, as shown in Figure 6.35. Through the data fitting interface, the user

can complete the fitting of T1, T2 or DOSY data.

Use the Trace Manager tool to select the last spectrum and check Zoom in/out to

enlarge the spectrum to the appropriate range and height. Check Peak (or Integration,

the same operation) to enter peak picking mode. Hold down the left mouse button and

drag to select a region, the system will automatically mark the chemical shift value of
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the strongest signal peak in the region (only one chemical peak value of the signal

peak can be marked at a time), and then select the desired peak of the spectrum, as

shown in Figure 6.35. If you want to delete the selected peak, click the button

in the dialog box.

Figure 6.35 Amplification and peak picking in the fitting interface

Peaking results will work for all spectra. At this point you can operate the Trace

Manager to display all the spectra (Figure 6.36), or still only show one spectrum, and

the result is the same.

Figure 6.36 Show all spectra after peak picking

Select , click the button , the system will automatically

calculate and draw the T1 fit curve, as shown in Figure 6.37. Click the button , the

system will save the peak information obtained by the peak picking as a node to the

current data directory, the node name is “peaks”. Click the button , the system

can save the result of T1 relaxation fitting to text format and export (Figure 6.38),

which can be used for other software for processing and analysis. Finally, click the

button to exit the fitting mode.



193

Figure 6.37 T1 fitting curve

Figure 6.38 T1 fitting result output file

6.6.2 T2 relaxation fitting

The T2 relaxation fitting process is the same as the T1 relaxation fitting process,

but the first sub-spectrum is selected to perform peak picking/integration on the signal

to be fitted, then select and click to fit. The fitting process and

results are shown in Figure 6.39 and Figure 6.40 , respectively.
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Figure 6.39 T2 relaxation fitting interface

Figure 6.40 T2 fitting curve

6.6.3 DOSY fitting

The DOSY fitting process is the same as the T2 relaxation fitting. Select the first

sub-spectrum to pick peaks for the signal to be fitted, then select

and click the button to fit. The fitting process and

results are shown in Figure 6.41 and Figure 6.42, respectively.
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Figure 6.41 Peak picking for signals that need to fit

Figure 6.42 DOSY fitting curve

6.7 Signal/Noise Ratio

This function is to calculate the signal to noise ratio of the currently displayed

spectrum. Click the Signal/Noise Ratio option under the Analysis menu, or enter the

command dsn in the command bar to enter the SNR calculation mode (Figure 6.43) .

You can drag the mouse to select the calculated signal width and noise width

respectively (Figure 6.44) , then right click and select “Start calculate SNR” (Figure

6.45) , the calculation result will pop up (Figure 6.46).
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Figure 6.43 Signal/noise ratio calculation interface

Figure 6.44 Select signal width and noise width

Figure 6.45 Right-click menu in SNR calculation mode
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Figure 6.46 Signal to noise ratio calculation result

“Clear Regions” can also be selected through the right-click menu to clear the

currently selected signal and noise range. When “Edit Regions” is selected, the system

will pop up the dialog box shown in Figure 6.47, which can input the start and end

points of the signal and noise and the noise width respectively. When “Enter Zoom” is

selected, it will enter the zoom mode, and the horizontal zoom of the spectrum can be

performed. Right click on “Exit Zoom” to exit zoom mode.

Figure 6.47 Edit dialog for signal to noise ratio calculation range

The signal/noise ratio of the currently displayed spectrum can be calculated

using the command dsnmax or dsnmax(integer). Entering the command dsnmax will

pop up the calculation result directly, as shown in Figure 6.48. The command dsnmax

is equivalent to dsnmax(200), ie the signal-to-noise ratio of the noise interval is 200

Hz, while dsnmax (1400) calculates the signal-to-noise ratio of the noise interval in

the range of 1400 Hz.

Figure 6.48 Signal to noise ratio results obtained by dsnmax
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6.8 Line Width and Digital Resolution

Open the experiment data in the workspace, click the Resolution option under

the Analysis menu, or enter the command res in the command line to calculate the

peak width of 50%, 0.55%, 0.11% of the peak intensity of the current display range,

and the spectral digital resolution. The result will be displayed in the log line, as

shown in Figure 6.49.

Figure 6.49 Line width and digital resolution
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Chapter 7 1D NMR Experiments

7.1 1D 1H Experiment

Figure 7.1 Pulse sequence of 1D 1H experiment

1. Phase Cycle

● ph1: 0 90 180 270

● ph2: 0 90 180 270

2. Experiment Parameters

● sw: Spectral width is around 12 ppm

● gain: Receiver gain, set appropriate value to avoid overflow

● frqb: Basic frequency of observed channel (1H)

● frqohz: Frequency offset of observed channel (1H), the center of the spectrum

● d1: Relaxation delay 1 s (d1+acqtime=1~5 times T1)

● p1: 90 degree pulse width of observed channel (1H)

● plvl1: Power level of pulse in observed channel (1H)

● acqtime: Acquisition time is around 3.5 s (np in the 32k point range)

● ns: Number of the scans is 8, recommended in multiples of 4

3. Processing

Set si greater than np, generally 2 to the n which is similar to 2np, such as

np=16384, you can set si=32768, or set si=65536 for higher digital resolution, and

then perform Fourier transform. You can set si=32000 or si=64000, the program will
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automatically change it to 32768 or 65536. Phase correction is performed on the

transformed spectrum to make the spectrum a purely absorptive signal. Eliminate

baseline distortion by baseline correction. After scaling the peak, the peaks of interest

are integrated and finally the spectrum is output.

7.2 1D 13C Experiment

Figure 7.2 Pulse sequence of 1D 13C experiment

1. Phase Cycle

● ph1: 0 90 180 270

● ph2: 0 90 180 270

2. Experiment Parameters

● sw: Spectral width is around 250 ppm

● gain: Receiver gain, set appropriate value to avoid overflow

● frqb: Basic frequency of observed channel (13C)

● frqohz: Frequency offset of observed channel (13C), the center of the spectrum

● p1: 90 degree pulse width of observed channel (13C)

● plvl1: Power level of pulse in observed channel (13C)

● d1: Relaxation delay 1 s

● frqb1: Basic frequency of decoupling channel (1H)

● frqohz1: Frequency offset of decoupling channel (1H), the center of the

spectrum (1H)

● decon1: 1H decoupling section setting, usually "yyy", ie full decoupling, also
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"nny", ie sampling period decoupling

● decpw1: 90 degree pulse width of decoupling channel (1H) is about 100μs

● dectype1: Decoupling mode of decoupling channel (1H) is "www" (using

waltz16 decoupling sequences)

● decplvl1: Power level of decoupling channel (1H) is about 37 dB

● acqtime: Acquisition time is around 0.6 s

● ns: Number of the scans, depending on the sample concentration

● lb: Lorentzian broadening factor for exponential window multiplication, 2Hz is

recommended

3. Processing

Set si greater than np, generally 2 to the n which is similar to 2np, such as

np=16384, you can set si=32768, or set si=65536 for higher digital resolution, and

then perform Fourier transform. You can set si=32000 or si=64000, the program will

automatically change it to 32768 or 65536. Phase correction is performed on the

transformed spectrum to make the spectrum a purely absorptive signal. Eliminate

baseline distortion by baseline correction. The spectrum is output after peak picking.

7.3 1H T1 Relaxation

Figure 7.3 Pulse sequence of 1H T1 Relaxation measurements (inversion-recovery)

1. Phase Cycle

● ph1: 0

● ph2: 0 180 90 270
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● ph3: 0 180 90 270

2. Experiment Parameters

● sw: Spectral width is around 12 ppm

● gain: Receiver gain, set appropriate value to avoid overflow

● frqb: Basic frequency of observed channel (1H)

● frqohz: Frequency offset of observed channel (1H), the center of the spectrum

● p1: 90 degree pulse width of observed channel (1H)

● plvl1: Power level of pulse in observed channel (1H)

● d1: Relaxation delay is 20 s (＞5 times T1)

●irtime: Inversion-recovery time, set values as follows in array mode, [0.0625,

0.125, 0.25, 0.5, 1.0, 2.0, 4.0, 8.0, 16.0, 32.0]

● acqtime: Acquisition time is around 4 s

● ns: Number of the scans is in multiples of 4

3. Processing

Pretreatment can refer to hydrogen spectrum, post-treatment see 6.5.1T1

relaxation fitting.

7.4 1H T2 Relaxation

Figure 7.4 Pulse sequence of 1H T2 Relaxation measurements (CPMG) with solvent

presaturation

1. Phase Cycle

● ph1: 0 90 180 270
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● ph2: 0

● ph3: 90 180

● ph4: 0 90 180 270

2. Experiment Parameters

● sw: Spectral width is around 12 ppm

● gain: Receiver gain, set appropriate value to avoid overflow

● frqb: Basic frequency of observed channel (1H)

● frqohz: Frequency offset of observed channel (1H), the center of the spectrum

● p1: 90 degree pulse width of observed channel (1H)

● plvl1: Power level of pulse in observed channel (1H)

● d1: Relaxation delay is 20 s (＞5 times T1)

● d6: delay for power switching is 10μs

● echotime: Echo time, set values as follows in array mode, [0.025, 0.1, 0.4, 0.8,

1.6, 3.2, 6.4, 12.8, 25.6, 52.0]

● d3: Fixed echo time is about 0.00035 s, d3 should be << 1/J, but > (100 * p1)

● satdelay: Delay for presaturation is about 4 s (if presaturation is used)

● satplvl: Power level for presaturation is about 3 dB (if presaturation is used)

● satfreq: Presaturation pulse frequency offset, frequency difference between

presaturation peak and spectral center

● acqtime: Acquisition time is around 4 s

● ns: Number of the scans is in multiples of 4

3. Processing

Pretreatment can refer to hydrogen spectrum, post-treatment see 6.5.2 T2

relaxation fitting.
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7.5 APT (Attached Proton Test)

Figure 7.5 Pulse sequence of APT

1. Phase Cycle

● ph1: 0 0 180 180 90 90 270 270

● ph2: 90 90 270 270

● ph3: 90 270 90 270

2. Experiment Parameters

● sw: Spectral width is around 250 ppm

● gain: Receiver gain, set appropriate value to avoid overflow

● frqb: Basic frequency of observed channel (13C)

● frqohz: Frequency offset of observed channel (13C), the center of the spectrum

● frqb1: Basic frequency of decoupling channel (1H)

● frqohz1: Frequency offset of decoupling channel (1H), the center of the

spectrum (1H)

● d1: Relaxation delay is about 2 s

● jch: 145 Hz (CH one-bond scalar coupling constant)

● d3: Delay of the second echo is about 50 μs

● p1: 90 degree pulse width of observed channel (13C)

● plvl1: Power level of pulse in observed channel (13C)

● decon1: Stage of decoupling channel (1H) is "nny", resulting 1H decoupling in

the acquisition

● decpw1: 90 degree pulse width of decoupling channel (1H) is 100 μs
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● dectype1: Decoupling mode of decoupling channel (1H) is "www" (using

waltz16 decoupling sequences)

● decplvl1: Power level of decoupling channel (1H) is about 37 dB

● acqtime: Acquisition time is around 1 s

● ns: Number of the scans is in multiples of 8, depending on the sample

concentration

● lb: Lorentzian broadening factor for exponential window multiplication, 2Hz is

recommended

3. Processing

Set si greater than np, and then perform Fourier transform. The specific method

is the same as the 7.2 1D 13C Experiment.

7.6 DEPT (Distortionless Enhancement by Polarization Transfer)

Figure 7.6 Pulse sequence of DEPT

1. Phase Cycle

● ph1: 0

● ph2: 0 180 90 270

● ph3: (90)4 (270)4

● ph4: (0)8 (90)8 (180)8 (270)8

● ph5: (0 180)4 (90 270)4

● ph6: (90)2 (270)2 (180)2 (0)4 (180)2 (270)2 (90)4 (270)2 (0)2 (180)4 (0)2

2. Experiment Parameters
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● sw: Spectral width is around 250 ppm

● gain: Receiver gain, set appropriate value to avoid overflow

● frqb: Basic frequency of observed channel (13C)

● frqohz: Frequency offset of observed channel (13C), the center of the spectrum

● p1: 90 degree pulse width of observed channel (13C)

● plvl1: Power level of pulse in observed channel (13C)

● p2: 90 degree high power pulse width of decoupling channel (1H)

● plvl2: Power level of pulse in decoupling channel (1H)

● d1: Relaxation delay is about 2 s

● jch: 145 Hz (CH one-bond scalar coupling constant)

● mult: Multiple of p2, set values as [0.5,1.0,1.5] in array mode, where 0.5, 1.0,

1.5 represent DEPT45, DEPT90 and DEPT135

● frqb1: Basic frequency of decoupling channel (1H)

● frqohz1: Frequency offset of decoupling channel (1H), the center of the

spectrum (1H)

● decon1: Stage of decoupling channel (1H) is "nny", resulting 1H decoupling in

the acquisition

● decpw1: 90 degree pulse width of decoupling channel (1H) is 63μs

● dectype1: Decoupling mode of decoupling channel (1H) is "www" (using

waltz16 decoupling sequences)

● decplvl1: Power level of decoupling channel (1H) is about 37 dB

● acqtime: Acquisition time is around 1 s

● ns: Number of the scans is in multiples of 32, depending on the sample

concentration

● lb: Lorentzian broadening factor for exponential window multiplication, 2Hz is

recommended

3. Processing

(1) Perform Fourier transform to the array data (FID) then do phase correction to

the first spectrum .

(2) Type “deptproc”.
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(3) Obtain 4 spectra representing CH3, CH2, CH and all proton attached carbon

(CH3 and CH2 and CH).

7.7 BIRD (BIlinear Rotation Decoupling)

Figure 7.7 Pulse sequence of BIRD

1. Phase Cycle

● ph1: 0

● ph2: 180

2. Experiment Parameters

● sw: Spectral width is around 12 ppm

● gain: Receiver gain, set appropriate value to avoid overflow

● frqb: Basic frequency of observed channel (1H)

● frqohz: Frequency offset of observed channel (1H), the center of the spectrum

● d1: Relaxation delay is 20 s (＞5 times T1)

● birddelay: Bird delay, set values as follows in array mode, [0.1, 0.2, 0.3, 0.4,

0.5, 0.6, 0.7, 0.8, 0.9, 1, 1.1, 1.2, 1.3, 1.4]

● p1: 90 degree pulse width of observed channel (1H)

● plvl1: Power level of pulse in observed channel (1H)

● jch: 145 Hz (CH one-bond scalar coupling constant)

● acqtime: Acquisition time is around 4 s

● ns: Number of the scans is 1

3. Processing
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(1) Perform Fourier transform to the array data (FID).

(2) Type “ftabs”.

(3) Find the spectrum with the weakest signal (peak intensity) and the

corresponding birddelay is the optimum value.

7.8 1D DOSY (Diffusion Ordered SpectroscopY)

Figure 7.8 Pulse sequence of 1D DOSY

1. Phase Cycle

● ph1: 0

● ph2: 0 0 180 180

● ph3: 0 0 0 0 180 180 180 180 90 90 90 90 270 270 270 270

● ph4: 0 180 0 180 180 0 180 0 90 270 90 270 270 90 270 90

● ph5: 0 0 0 0 180 180 180 180 90 90 90 90 270 270 270 270

● ph6: 0 180 180 0 180 0 0 180 270 90 90 270 90 270 270 90

2. Experiment Parameters

● sw: Spectral width is around 12 ppm

● gain: Receiver gain, set appropriate value to avoid overflow

● frqb: Basic frequency of observed channel (1H)

● frqohz: Frequency offset of observed channel (1H), the center of the spectrum

● d1: Relaxation delay is about 5 s

● ecdelay: Eddy current delay is about 5 ms

● diffdelay: Diffusion time ( big delta) is 20~200 ms
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● p1: 90 degree pulse width of observed channel (1H)

● plvl1: Power level of pulse in observed channel (1H)

● gzlevel: Variable z-gradient, set values as follows in array mode, [10.6, 16.2,

21.8, 27.4, 33, 38.6, 44.2, 49.8, 55.4, 61, 66.6, 72.2, 77.8, 83.4, 89]

● gzlevel1: Amplitude of spoiled z-gradient is 100%

● gtime: Gradient time (0.5* little delta) is 1.0 ms

● gshape: Gradient pulse shape is hsine.grd

● gstab: Delay for gradient recovery is 0.2 ms

● acqtime: Acquisition time is around 1 s

● ns: Number of the scans is in multiples of 16, depending on the sample

concentration

3. Processing

See 6.5.3 DOSY fitting for the processing after the Fourier transform.

7.9 1D Solvent (Water) suppression Experiments

7.9.1 PRESAT (Presaturation)

Figure 7.9 Pulse sequence of PRESAT

1. Phase Cycle

● ph1: 0

● ph2: 0 180 180 0 90 270 270 90

● ph3: 0 180 180 0 90 270 270 90
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2. Experiment Parameters

● sw: Spectral width is around 12 ppm

● gain: Receiver gain, set appropriate value to avoid overflow

● frqb: Basic frequency of observed channel (1H)

● frqohz: Frequency offset of observed channel (1H), the center of the spectrum

● d1: Relaxation delay is 0~2s

● d6: delay for power switching is 10μs

● p1: 90 degree pulse width of observed channel (1H)

● plvl1: Power level of pulse in observed channel (1H)

● satdelay: Delay for presaturation is about 4 s

● satplvl: Power level for presaturation is about 3 dB

● satfreq: Presaturation pulse frequency offset, frequency difference between

presaturation peak and spectral center (this value can be set to 0 Hz and the center of

the spectrum is aligned to the saturated peak)

● acqtime: Acquisition time is around 2.5 s

● ns: Number of the scans is in multiples of 4, depending on the sample

concentration

3. Processing

Perform Fourier transform to obtain frequency domain data from time domain

data (FID) created by acquisition with si larger than td, followed by processing steps

like phase and baseline correction, resulting pure absorption signal in the spectrum.

After reference calibration, peak picking and other analysis steps, the spectrum can be

plotted.
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7.9.2 WATERGATE

Figure 7.10 Pulse sequence of WATERGATE (using W3 sequence)

1. Phase Cycle

● ph1: 0 90 90 180 180 270 270

● ph2: 180 180 270 270 0 0 90 90

● ph3: 0 0 90 90 180 180 270 270

2. Experiment Parameters

● sw: Spectral width is around 12 ppm

● gain: Receiver gain, set appropriate value to avoid overflow

● frqb: Basic frequency of observed channel (1H)

● frqohz: Frequency offset of observed channel (1H), the center of the spectrum

● d1: Relaxation delay is about 2 s

● wgdelay: Delay for binomial water suppression, is equal to 1/(2*d) where d is

the distance of next null (in Hz)

● p1: 90 degree pulse width of observed channel (1H)

● plvl1: Power level of pulse in observed channel (1H)

● gzlevel: Amplitude of z-gradient is about 15%

● gtime: Gradient time is 1.0 ~2.0ms

● gshape: Gradient pulse shape is hsine.grd

● gstab: Delay for gradient recovery is 0.1~0.2 ms

● acqtime: Acquisition time is around 3 s
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● ns: Number of the scans is in multiples of 8, depending on the sample

concentration

3. Processing

Perform Fourier transform to obtain frequency domain data from time domain

data (FID) created by acquisition with si larger than td, followed by processing steps

like phase and baseline correction, resulting pure absorption signal in the spectrum.

After reference calibration, peak picking and other analysis steps, the spectrum can be

plotted.

7.9.3 Solvent (Water) Suppression by 1D-NOESY

Figure 7.11 Pulse sequence of solvent water suppression by 1D NOESY

(noesy_gppr1d)

1. Phase Cycle

● ph1: 0 180

● ph2: 0 0 0 0 0 0 0 0 180 180 180 180 180 180 180 180

● ph3: 0 0 180 180 90 90 270 270

● ph4: 0

● ph5: 0 180 180 0 90 270 270 90 180 0 0 180 270 90 90 270

2. Experiment Parameters

● sw: Spectral width is around 12 ppm

● gain: Receiver gain, set appropriate value to avoid overflow

● frqb: Basic frequency of observed channel (1H)
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● frqohz: Frequency offset of observed channel (1H), the center of the spectrum

● d1: Relaxation delay is about 0~2s

● d6: delay for power switching is 10μs

● p1: 90 degree pulse width of observed channel (1H)

● p2: 90 degree pulse width of observed channel (1H)

● plvl1: Power level of pulse in observed channel (1H)

● gzlevel: Amplitude of z-gradient, set values as about 20%

● gtime: Gradient time is 1.0 ~2.0ms

● gshape: Gradient pulse shape is hsine.grd

● gstab: Delay for gradient recovery is 0.1~0.2 ms

● satdelay: Delay for presaturation is about 4 s

● satdelay1: Second delay for presaturation is 0.1 s

● satplvl: Power level for presaturation is about 3 dB

● satfreq: Presaturation pulse frequency offset, frequency difference between

presaturation peak and spectral center (this value can be set to 0 Hz and the center of

the spectrum is aligned to the saturated peak)

● acqtime: Acquisition time is around 2 s

● ns: Number of the scans is in multiples of 8, depending on the sample

concentration

3. Processing

Perform Fourier transform to obtain frequency domain data from time domain

data (FID) created by acquisition with si larger than td, followed by processing steps

like phase and baseline correction, resulting pure absorption signal in the spectrum.

After reference calibration, peak picking and other analysis steps, the spectrum can be

plotted.
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7.10 1D Selective Experiments

7.10.1 Selective 1D COSY Experiment

Figure 7.12 Pulse sequence of selective 1D COSY experiment (sel_cosy)

1. Phase Cycle

● ph1: 90 270 270 90 180 0 0 180

● ph2: 0 180 0 180 90 270 90 270

● ph3: 0 180 180 0 90 270 270 90

2. Experiment Parameters

● sw: Spectral width is around 12 ppm

● gain: Receiver gain, set appropriate value to avoid overflow

● frqb: Basic frequency of observed channel (1H)

● frqohz: Frequency offset of observed channel (1H), the center of the spectrum

● d1: Relaxation delay is about 2 s

● sp1: 90 degree shape pulse width of observed channel (1H)

● splvl1: Power level of shape pulse in observed channel (1H)

● p1: 90 degree pulse width of observed channel (1H)

● plvl1: Power level of pulse in observed channel (1H)

● acqtime: Acquisition time is around 2 s

● ns: Number of the scans is in multiples of 8, depending on the sample

concentration

3. Processing
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Perform Fourier transform to obtain frequency domain data from time domain

data (FID) created by acquisition with si larger than td, followed by processing steps

like phase and baseline correction, resulting pure absorption signal in the spectrum.

After reference calibration, peak picking and other analysis steps, the spectrum can be

plotted.

7.10.2 Phase-Cycled Selective 1D TOCSY Experiment

Figure 7.13 Pulse sequence of phase-cycled selective 1D TOCSY experiment

(sel_tocsy)

1. Phase Cycle

● ph1: 90 270 270 90 0 180 180 0

● ph2: 0 180 0 180 90 270 90 270

● ph3: 0 180 0 180 90 270 90 270

2. Experiment Parameters

● sw: Spectral width is around 12 ppm

● gain: Receiver gain, set appropriate value to avoid overflow

● frqb: Basic frequency of observed channel (1H)

● frqohz: Frequency offset of observed channel (1H), the center of the spectrum

● d1: Relaxation delay is about 2 s

● d6: delay for power switching is 10μs

● sp1: 90 degree shape pulse width of observed channel (1H)

● splvl1: Power level of shape pulse in observed channel (1H)
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● p1: Trim pulse of observed channel (1H) is 2.5 ms

● p9: Pulse for TOCSY-spinlock is about 40 μs

● slpltocsy: Power level of TOCSY-spinlock pulse in observed channel (1H)

● mult: Cycle number of composite pulse is 18 (must be even number, make

total TOCSY-spinlock time about 60~80 ms)

● acqtime: Acquisition time is around 2 s

● ns: Number of the scans is in multiples of 8, depending on the sample

concentration

3. Processing

Perform Fourier transform to obtain frequency domain data from time domain

data (FID) created by acquisition with si larger than td, followed by processing steps

like phase and baseline correction, resulting pure absorption signal in the spectrum.

After reference calibration, peak picking and other analysis steps, the spectrum can be

plotted.

7.10.3 Gradient-Based Selective 1D TOCSY Experiment

Figure 7.14 Pulse sequence of gradient-based selective 1D TOCSY experiment

(selgp_tocsy)

1. Phase Cycle

● ph1: 0 180

● ph2: 0 0 90 90 180 180 270 270

● ph3: 90
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● ph4: 0 180 180 0

2. Experiment Parameters

● sw: Spectral width is around 12 ppm

● gain: Receiver gain, set appropriate value to avoid overflow

● frqb: Basic frequency of observed channel (1H)

● frqohz: Frequency offset of observed channel (1H), the center of the spectrum

● d1: Relaxation delay is about 2 s

● d6: delay for power switching is 10μs

● p1: 90 degree pulse width of observed channel (1H)

● plvl1: Power level of pulse in observed channel (1H)

● sp1: 180 degree shape pulse width of observed channel (1H)

● splvl1: Power level of shape pulse in observed channel (1H)

● p2: Trim pulse of observed channel (1H) is 2.5 ms

● p9: Pulse for TOCSY-spinlock is about 40 μs

● slpltocsy: Power level of TOCSY-spinlock pulse in observed channel (1H)

● mult: Cycle number of composite pulse is 18 (must be even number, make

total TOCSY-spinlock time about 60~80 ms)

● gzlevel: Amplitude of z-gradient, set values as about 20%

● gtime: Gradient time is 1.0 ~2.0ms

● gshape: Gradient pulse shape is hsine.grd

● gstab: Delay for gradient recovery is 0.1~0.2 ms

● acqtime: Acquisition time is around 2 s

● ns: Number of the scans is in multiples of 8, depending on the sample

concentration

3. Processing

Perform Fourier transform to obtain frequency domain data from time domain

data (FID) created by acquisition with si larger than td, followed by processing steps

like phase and baseline correction, resulting pure absorption signal in the spectrum.

After reference calibration, peak picking and other analysis steps, the spectrum can be

plotted.
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7.10.4 Gradient-Based Selective 1D NOESY Experiment

Figure 7.15 Pulse sequence of gradient-based selective 1D NOESY experiment

(selgp_noesy)

1. Phase Cycle

● ph1: 0 180

● ph2: 0 0 90 90 180 180 270 270

● ph3: 0

● ph4: 0 180 180 0

2. Experiment Parameters

● sw: Spectral width is around 12 ppm

● gain: Receiver gain, set appropriate value to avoid overflow

● frqb: Basic frequency of observed channel (1H)

● frqohz: Frequency offset of observed channel (1H), the center of the spectrum

● d1: Relaxation delay is about 2 s

● p1: 90 degree pulse width of observed channel (1H)

● plvl1: Power level of pulse in observed channel (1H)

● sp1: 180 degree shape pulse width of observed channel (1H)

● splvl1: Power level of shape pulse in observed channel (1H)

● gzlevel: Amplitude of z-gradient is about 20%

● gtime: Gradient time is 1.0 ~2.0ms

● gshape: Gradient pulse shape is hsine.grd



219

● gstab: Delay for gradient recovery is 0.1~0.2 ms

● acqtime: Acquisition time is around 2 s

● ns: Number of the scans is in multiples of 8, depending on the sample

concentration

3. Processing

Perform Fourier transform to obtain frequency domain data from time domain

data (FID) created by acquisition with si larger than td, followed by processing steps

like phase and baseline correction, resulting pure absorption signal in the spectrum.

After reference calibration, peak picking and other analysis steps, the spectrum can be

plotted.
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Chapter 8 2D NMR Experiments

The two-dimensional sequence names provided by this software are as follows:

experimental type + underline + acquisition mode and others. The experimental type

includes cosy, tocsy and so on. The acquisition mode includes tppi, qf and so on.

Others include such as gradient, bird, etc. Acquisition mode and others are sorted

alphabetically.

The following is the meaning of the characters contained in the two-dimensional

sequence names provided for this software:

bi: With BIRD fragment

dqf: Double quantum filtering

pr: Presaturation

gp: Gradient

qf: Qf mode of acquisition

sh: States mode of acquisition

st: States-TPPI Mode of acquisition

tp: TPPI mode of acquisition

ea: Echo-antiecho mode of acquisition

For example, cosy_prqf represents the absolute cosy spectrum with presaturation

function. Users can choose different pulse sequences according to their needs.
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8.1 1H-1H COSY

8.1.1 cosy_prqf

Figure 8.1 Absolute value COSY pulse sequence with presaturation

1. Phase table

 ph1: 0 0 90 90 180 180 270 270

 ph2: 0 90 270 0 180 270 90 180

 ph3: 0 180 90 270 180 0 270 90

2. Acquisition parameters

 sw: Spectrum width in direct dimension is around 12 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is equal to sw

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 p1: 90° pulse width of 1H transmitter in observed channel

 p2: 90° (or 30° ~ 60°) pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel

 d1: Relaxation delay, 0s
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 d6: delay for power switching is 10μs

 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 4

 satdelay: Presaturation time, ~2s

 satplvl: Presaturation pulse power, ~3dB

 satfreq: Presaturation pulse frequency offset, frequency difference between

presaturation peak and spectral center

3. Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared sine or sine

 wdw1: Squared sine or sine

 sb: 0.5

 sb1: 0.5

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4. Processing

Type wft in command line to perform two-dimensional Fourier transform and

display the two-dimensional spectrum in absolute mode. The t1 noise can be further

eliminated if the t1 noise is strong.
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8.1.2 cosy_prtp

Figure 8.2 Phase sensitive COSY with presaturation

1.Phase table

 ph1: 0 180 180 0 90 270 270 90

 ph2: 0 180 0 180 90 270 90 270

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 12 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is equal to sw

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of

1H NMR spectrum

 p1: 90° pulse width of 1H transmitter in observed channel

 p2: 90° (or 30° ~ 60°) pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel

 d1: Relaxation delay, 0s

 d6: delay for power switching is 10μs

 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 4
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 satdelay: Presaturation time, ~2s

 satplvl: Presaturation pulse power, ~3dB

 satfreq: Presaturation pulse frequency offset, frequency difference between

presaturation peak and spectral center

3. Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared cos or cos

 wdw1: Squared cos or cos

 sb:1

 sb1:1

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4. Processing

Type wft or wfp in command line to perform two-dimensional Fourier transform

and display the two-dimensional spectrum in phase sensitive mode. The t1 noise can

be further eliminated if the t1 noise is strong.

8.1.3 cosy_gpqf

Figure 8.3 Gradient absolute value COSY pulse sequence
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1.Phase table

 ph1: 0 180 90 270

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 12 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is equal to sw

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 p1: 90° pulse width of 1H transmitter in observed channel

 p2: 90° (or 30° ~ 60°) pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel

 d1: Relaxation delay, 0.5-2 s

 gzlevel: Amplitude level of Z gradient, around 20（namely 20%）

 gradtime: Gradient time, 1~2ms

 gradshape1: hsine.grd

 gstab: Gradient stabilization time, 0.1~0.2ms

 ns: 4 (or multiple of 4) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 4

3. Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared sine or sine

 wdw1: Squared sine or sine

 sb: 0.5

 sb1: 0.5

 sbs: 0
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 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4. Processing

Type wft in command line to perform two-dimensional Fourier transform and

display the two-dimensional spectrum in absolute mode. The t1 noise can be further

eliminated if the t1 noise is strong.

8.1.4 cosy_gpprqf

Figure 8.4 Absolute value COSY pulse sequence with gradient and presaturation

1.Phase table

 ph1: 0 180 90 270

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 12 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is equal to sw

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum
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 p1: 90° pulse width of 1H transmitter in observed channel

 p2: 90° (or 30°~ 60°) pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel

 d1: Relaxation delay, 0s

 d6: delay for power switching is 10μs

 gzlevel: Amplitude level of Z gradient, around 20（namely 20%）

 gradtime: Gradient time, 1~2ms

 gradshape1: hsine.grd

 gstab: Gradient stabilization time, 0.1~0.2ms

 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 4

 satdelay: Presaturation time, ~2s

 satplvl: Presaturation pulse power, ~3dB

 satfreq: Presaturation pulse frequency offset, frequency difference between

presaturation peak and spectral center

3. Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared sine or sine

 wdw1: Squared sine or sine

 sb: 0.5

 sb1: 0.5

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4. Processing

Type wft in command line to perform two-dimensional Fourier transform and

display the two-dimensional spectrum in absolute mode. The t1 noise can be further

eliminated if the t1 noise is strong.
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8.1.5 cosy_eagp

Figure 8.5 Phase sensitive COSY pulse sequence with gradient

1.Phase table

 ph1: 0 180 180 0 90 270 270 90

 ph2: 0 180 0 180 90 270 90 270

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 12 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is equal to sw

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 p1: 90°pulse width of 1H transmitter in observed channel

 p2: 90° (or 30° ~ 60°) pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel

 d1: Relaxation delay, 0.5-2 s

 gzlevel: Amplitude level of Z gradient, around 20（namely 20%）

 gradtime: Gradient time, 1~2ms

 gradshape1: hsine.grd

 gstab: Gradient stabilization time, 0.1~0.2ms
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 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 4

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared cos or cos

 wdw1: Squared cos or cos

 sb: 1

 sb1: 1

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.Processing

Type wft or wfp in command line to perform two-dimensional Fourier transform

and display the 2D spectrum in phase sensitive mode. The phase must be corrected in

both two dimensions. The t1 noise can be further eliminated if the t1 noise is strong.

8.1.6 cosy_eagppr

Figure 8.6 Phase sensitive COSY pulse sequence with gradient and presaturation

1.Phase table

 ph1: 0 180 180 0 90 270 270 90
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 ph2: 0 180 0 180 90 270 90 270

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 12 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is equal to sw

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 p1: 90° pulse width of 1H transmitter in observed channel

 p2: 90° (or 30° ~ 60°) pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel

 d1: Relaxation delay, 0s

 d6: delay for power switching is 10μs

 gzlevel: Amplitude level of Z gradient, around 20（namely 20%）

 gradtime: Gradient time, 1~2ms

 gradshape1: hsine.grd

 gstab: Gradient stabilization time, 0.1~0.2ms

 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 4

 satdelay: Presaturation time, ~2s

 satplvl: Presaturation pulse power, ~3dB

 satfreq: Presaturation pulse frequency offset, frequency difference between

presaturation peak and spectral center

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared cos or cos
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 wdw1: Squared cos or cos

 sb: 1

 sb1: 1

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.Processing

Type wft or wfp in command line to perform two-dimensional Fourier transform

and display the 2D spectrum in phase sensitive mode. The phase must be corrected in

both two dimensions. The t1 noise can be further eliminated if the t1 noise is strong.

8.1.7 cosy_dqfgptp

Figure 8.7 Phase sensitive COSY pulse sequence with gradient and double quantum

filtering

1.Phase table

 ph1: 0 180 (Phase increases by TPPI)

 ph2: 0

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 12 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is equal to sw
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 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 p1: 90° pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel

 d1: Relaxation delay, 0.5-2 s

 gzlevel: Amplitude level of Z gradient, around 20（namely 20%）

 gradtime: Gradient time, 1~2ms

 gradshape1: hsine.grd

 gstab: Gradient stabilization time, 0.1~0.2ms

 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 4

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared cos or cos

 wdw1: Squared cos or cos

 sb:1

 sb1:1

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.Processing

Type wft or wfp in command line to perform two-dimensional Fourier transform

and display the 2D spectrum in phase sensitive mode. The phase must be corrected in

both two dimensions. The t1 noise can be further eliminated if the t1 noise is strong.
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8.2 1H-19F COSY

Figure 8.8 1H-19F COSY pulse sequence with gradient

1.Phase table

 ph1: 0 180

 ph2: 0 0 180 180

 ph3: 0

 ph4: 0 180 180 0

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 12 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension (Obtained from the basic single

pulse 19F NMR spectrum, optimized to the narrowest)

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 frqb1: Basic Frequency of 19F transmitter

 frqohz1: Frequency offset of 19F transmitter, the center of 19F NMR spectrum

 p1: 90° pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel
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 p2: 90° pulse width of 19F transmitter

 plvl2: The power of 19F transmitter

 d1: Relaxation delay, 0.5-2 s

 gzlevel: Amplitude level of Z gradient, around 20（namely 20%）

 gradtime: Gradient time, 1~2ms

 gradshape1: hsine.grd

 gstab: Gradient stabilization time, 0.1~0.2ms

 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 8

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared sine or sine

 wdw1: Squared sine or sine

 sb: 0.5

 sb1: 0.5

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.processing

Type wft in command line to perform two-dimensional Fourier transform and

display the two-dimensional spectrum in absolute mode. The t1 noise can be further

eliminated if the t1 noise is strong.
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8.3 TOCSY (TOtal Correlation SpectroscopY)

8.3.1 tocsy_st

Figure 8.9 TOCSY pulse sequence

1.Phase table

 ph1: 0 180 180 0 90 270 270 90 (Phase increases by TPPI)

 ph2: 0 180 0 180 90 270 90 270

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 12 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is equal to sw

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 p1: 90° pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel

 p2: Trim pulse width of 1H transmitter in Observed channel, 2.5 ms

 p9: 90° pulse width of Spin lock, 30 ~ 40 μs

 slpltocsy: The power of 1H transmitter in observed channel corresponding
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with p9

 mult: The number of cycles of the spin lock combination pulse: 18 (must be

even, so that the total width of the spin lock combination pulse is about 60 ~80 ms)

 d1: Relaxation delay, 0.5-2 s

 d6: delay for power switching is 10μs

 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 8

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared cos or cos

 wdw1: Squared cos or cos

 sb:1

 sb1:1

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.Processing

Type wft or wfp in command line to perform two-dimensional Fourier transform

and display the 2D spectrum in phase sensitive mode. The phase must be corrected in

both two dimensions. The t1 noise can be further eliminated if the t1 noise is strong.
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8.3.2 tocsy_eagp

Figure 8.10 TOCSY pulse sequence with gradient

1.Phase table

● ph1: 0 180

● ph2: 0

● ph3: 0 0 0 0 180 180 180 180

● ph4: 0 0 180 180

● acq: 0 180 180 0 180 0 0 180

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 12 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is equal to sw

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 p1: 90° pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel

 p9: 90° pulse width of Spin lock, 30 ~ 40 μs

 slpltocsy: The power of 1H transmitter in observed channel corresponding
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with p9

 mult: The number of cycles of the spin lock combination pulse: 18 (must be

even, so that the total width of the spin lock combination pulse is about 60-80 ms)

 d1: Relaxation delay, 0.5-2 s

 d6: delay for power switching is 10μs

 gzlevel: Amplitude level of Z gradient, around 20（namely 20%）

 gradtime: Gradient time, 1~2ms

 gradshape1: hsine.grd

 gstab: Gradient stabilization time, 0.1~0.2ms

 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 8

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared cos or cos

 wdw1: Squared cos or cos

 sb:1

 sb1:1

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.Processing

Type wft or wfp in command line to perform two-dimensional Fourier transform

and display the 2D spectrum in phase sensitive mode. The phase must be corrected in

both two dimensions. The t1 noise can be further eliminated if the t1 noise is strong.
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8.3.3 tocsy_eagppr

Figure 8.11 TOCSY pulse sequence with gradient and presaturation

1.Phase table

 ph1: 0 180

 ph2: 0

 ph3: 0 0 0 0 180 180 180 180

 ph4: 0 0 180 180

 ph5: 0 180 180 0 180 0 0 180

2.Processing parameters

 sw: Spectrum width in direct dimension is around 12 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is equal to sw

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 p1: 90° pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel

 p9: 90° pulse width of Spin lock, 30 ~ 40 μs

 slpltocsy: The power of 1H transmitter in observed channel corresponding
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with p9

 mult: The number of cycles of the spin lock combination pulse: 18 (must be

even, so that the total width of the spin lock combination pulse is about 60~80 ms)

 d1: Relaxation delay, 0s

 d6: delay for power switching is 10μs

 gzlevel: Amplitude level of Z gradient, around 20（namely 20%）

 gradtime: Gradient time, 1~2ms

 gradshape1: hsine.grd

 gstab: Gradient stabilization time, 0.1~0.2ms

 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 8

 satdelay: Presaturation time, ~2s

 satplvl: Presaturation pulse power, ~3dB

 satfreq: Presaturation pulse frequency offset, frequency difference between

presaturation peak and spectral center

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared cos or cos

 wdw1: Squared cos or cos

 sb:1

 sb1:1

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.Processing

Type wft or wfp in command line to perform two-dimensional Fourier transform

and display the 2D spectrum in phase sensitive mode. The phase must be corrected in

both two dimensions. The t1 noise can be further eliminated if the t1 noise is strong.
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8.4 NOESY (Nuclear Overhauser Effect SpectroscopY)

8.4.1 noesy_eagp

Figure 8.12 NOESY pulse sequence with gradient

1.Phase table

 ph1: 0 180

 ph2: 0

 ph3: 0 0 0 0 0 0 0 0 180 180 180 180 180 180 180 180

 ph4: 0 0 180 180 270 270 90 90

 ph5: 0 180 180 0 90 270 270 90 180 0 0 180 270 90 90 270

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 12 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is equal to sw

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 p1: 90° pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel
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 d1: Relaxation delay, 0.5-2 s

 mixingtime: Mixing time, about 1~2 s for small molecules and less than 1 s

for macromolecules, which amounts to the T1 relaxation time of samples.

 gzlevel: Amplitude level of Z gradient, around 20（namely 20%）

 gradtime: Gradient time, 1~2ms

 gradshape1: hsine.grd

 gstab: Gradient stabilization time, 0.1~0.2ms

 ns: 16 (or multiple of 16) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 16

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared cos or cos

 wdw1: Squared cos or cos

 sb:1

 sb1:1

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.Processing

Type wft or wfp in command line to perform two-dimensional Fourier transform

and display the 2D spectrum in phase sensitive mode. The phase must be corrected in

both two dimensions. The t1 noise can be further eliminated if the t1 noise is strong.
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8.4.2 noesy_gptp

Figure 8.13 NOESY pulse sequence with gradient

1.Phase table

● ph1: 0 180 (Phase increases by TPPI)

● ph2: 0 0 0 0 0 0 0 0 180 180 180 180 180 180 180 180

● ph3: 0 0 180 180 90 90 270 270

● ph4: 0

● ph5: 0 180 180 0 90 270 270 90 180 0 0 180 270 90 90 270

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 12 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is equal to sw

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 p1: 90° pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel

 d1: Relaxation delay, 0.5-2 s

 mixingtime: Mixing time, about 1~2 s for small molecules and less than 1 s
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for macromolecules, which amounts to the T1 relaxation time of samples.

 gzlevel: Amplitude level of Z gradient, around 20（namely 20%）

 gradtime: Gradient time, 1~2ms

 gradshape1: hsine.grd

 gstab: Gradient stabilization time, 0.1~0.2ms

 ns: 16 (or multiple of 16) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 16

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared cos or cos

 wdw1: Squared cos or cos

 sb:1

 sb1:1

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.Processing

Type wft or wfp in command line to perform two-dimensional Fourier transform

and display the 2D spectrum in phase sensitive mode. The phase must be corrected in

both two dimensions. The t1 noise can be further eliminated if the t1 noise is strong.
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8.4.3 noesy_gpprtp

Figure 8.14 NOESY pulse sequence with gradient and presaturation

1.Phase table

 ph1: 0 180 (Phase increases by TPPI)

 ph2: 0 0 0 0 0 0 0 0 180 180 180 180 180 180 180 180

 ph3: 0 0 180 180 90 90 270 270

 ph4: 0

 ph5: 0 180 180 0 90 270 270 90 180 0 0 180 270 90 90 270

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 12 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is equal to sw

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 p1: 90° pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel

 d1: Relaxation delay, 0s

 d6: delay for power switching is 10μs
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 mixingtime: Mixing time, about 1~2 s for small molecules and less than 1 s

for macromolecules, which amounts to the T1 relaxation time of samples.

 gzlevel: Amplitude level of Z gradient, around 20（namely 20%）

 gradtime: Gradient time, 1~2ms

 gradshape1: hsine.grd

 gstab: Gradient stabilization time, 0.1~0.2ms

 ns: 16 (or multiple of 16) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 16

 satdelay: Presaturation time, ~2s

 satplvl: Presaturation pulse power, ~3dB

 satfreq: Presaturation pulse frequency offset, frequency difference between

presaturation peak and spectral center

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared cos or cos

 wdw1: Squared cos or cos

 sb:1

 sb1:1

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.Processing

Type wft or wfp in command line to perform two-dimensional Fourier transform

and display the 2D spectrum in phase sensitive mode. The phase must be corrected in

both two dimensions. The t1 noise can be further eliminated if the t1 noise is strong.
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8.5 ROESY (Rotating Frame Nuclear Overhauser Effect

SpectroscopY)

8.5.1 roesy_prtp

Figure 8.15 ROESY pulse sequence with presaturation

1.Phase table

 ph1: 0 180180 0 90 270 270 90 (Phase increases by TPPI)

 ph2: 0 180 0 180 90 270 90 270

 ph3: 0

 ph4: 0 180180 0 90 270 270 90

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 12 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is equal to sw

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 p1: 90 degree pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel
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 p8: 90° pulse width of spin lock, around 130μs

 slplroesy: The power of 1H transmitter in observed channel corresponding

with p8

 mult: The number of cycles of the spin lock combination pulse: 600 (must be

even, so that the total width of the spin lock combination pulse is about 300ms)

 d1: Relaxation delay, 0s

 d6: delay for power switching is 10μs

 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 8

 satdelay: Presaturation time, ~2s

 satplvl: Presaturation pulse power, ~3dB

 satfreq: Presaturation pulse frequency offset, frequency difference between

presaturation peak and spectral center

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared cos or cos

 wdw1: Squared cos or cos

 sb:1

 sb1:1

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.Processing

Type wft or wfp in command line to perform two-dimensional Fourier transform

and display the 2D spectrum in phase sensitive mode. The phase must be corrected in

both two dimensions. The t1 noise can be further eliminated if the t1 noise is strong.
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8.5.2 roesy_eagp

Figure 8.16 ROESY pulse sequence with gradient

1.Phase table

 ph1: 0 180

 ph2: 0

 ph3: 0 0 180 180

 ph4: 180 180 0 0

 ph5: 90 90 270 270

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 12 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is equal to sw

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 p1: 90 degree pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel

 p8: 90° pulse width of spin lock, around 130μs

 slplroesy: The power of 1H transmitter in observed channel corresponding

with p8
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 mult: The number of cycles of the spin lock combination pulse: 600 (must be

even, so that the total width of the spin lock combination pulse is about 300ms)

 d1: Relaxation delay, 0.5-2 s

 gzlevel: Amplitude level of Z gradient, around 20（namely 20%）

 gradtime: Gradient time, 1~2ms

 gradshape1: hsine.grd

 gstab: Gradient stabilization time, 0.1~0.2ms

 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 8

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared cos or cos

 wdw1: Squared cos or cos

 sb:1

 sb1:1

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1:0.5

4.Processing

Type wft or wfp in command line to perform two-dimensional Fourier transform

and display the 2D spectrum in phase sensitive mode. The phase must be corrected in

both two dimensions. The t1 noise can be further eliminated if the t1 noise is strong.
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8.5.3 roesy_gptpw3

Figure 8.17 ROESY pulse sequence with gradient and water suppression

1.Phase table

 ph1: 0 180 180 0 90 270 270 90

 ph2: 0 180 0 180 90 270 90 270

 ph3: 0 180 0 180 90 270 90 270

 ph4: 180 0 180 0 270 90 270 90

 ph5: 0 180 180 0 90 270 270 90

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 12 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is equal to sw

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 p1: 90° pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel

 p2: 90° pulse width of 1H transmitter in observed channel

 plvl2: The power of 1H transmitter in observed channel
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 p8: 90° pulse width of spin lock, around 130μs

 slplroesy: The power of 1H transmitter in observed channel corresponding

with p8

 mult: The number of cycles of the spin lock combination pulse: 600 (must be

even, so that the total width of the spin lock combination pulse is about 300ms)

 d1: Relaxation delay, 0.5-2 s

 wgdelay: Binomial water suppression delay, around 0.3 ms

 gzlevel: Amplitude level of Z gradient, around 20（namely 20%）

 gradtime: Gradient time, 1~2ms

 gradshape1: hsine.grd

 gstab: Gradient stabilization time, 0.1~0.2ms

 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 8

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared cos or cos

 wdw1: Squared cos or cos

 sb:1

 sb1:1

 sbs:0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.Processing

Type wft or wfp in command line to perform two-dimensional Fourier transform

and display the 2D spectrum in phase sensitive mode. The phase must be corrected in

both two dimensions. The t1 noise can be further eliminated if the t1 noise is strong.
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8.6 Homo2dj (Homonuclear 2D J-resolved Spectroscopy)

8.6.1 homo2dj_qf

Figure 8.18 Homonuclear 2D J-resolved spectroscopy

1.Phase table

 ph1: 0 180 90 270

 ph2: 0 0 90 90 180 180 270 270

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 12 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 swhz1: Spectrum width in indirect dimension,100Hz (The maximum width

of multiple peaks of 1H-1H coupling)

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 frqb1: Basic Frequency of 1H transmitter in observed channel

 frqohz1: 0 Hz

 p1: 90 degree pulse width of 1H transmitter in observed channel
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 plvl1: The power of 1H transmitter in observed channel

 d1: Relaxation delay, 0.5-2 s

 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 8

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared sine or sine

 wdw1: Squared sine or sine

 sb: 0.5

 sb1: 0.5

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.processing

Type wft in command line to perform two-dimensional Fourier transform and

display the two-dimensional spectrum in absolute mode. The t1 noise can be further

eliminated if the t1 noise is strong.

8.6.2 homo2dj_prqf

Figure 8.19 Homonuclear 2D J-resolved spectroscopy with presaturation
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1.Phase table

 ph1: 0 180 90 270

 ph2: 0 0 90 90 180 180 270 270

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 12 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 swhz1: Spectrum width in indirect dimension,100Hz (The maximum width

of multiple peaks of 1H-1H coupling)

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 frqb1: Basic Frequency of 1H transmitter in observed channel

 frqohz1: 0 Hz

 p1: 90 degree pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel

 d1: Relaxation delay, 0 s

 d6: delay for power switching is 10μs

 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 8

 satdelay: Presaturation time, ~2s

 satplvl: Presaturation pulse power, ~3dB

 satfreq: Presaturation pulse frequency offset, frequency difference between

presaturation peak and spectral center

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512
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 wdw: Squared sine or sine

 wdw1: Squared sine or sine

 sb: 0.5

 sb1: 0.5

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.processing

Type wft in command line to perform two-dimensional Fourier transform and

display the two-dimensional spectrum in absolute mode. The t1 noise can be further

eliminated if the t1 noise is strong.

8.7 Heter2dj (Heteronuclear 2D J-resolved Spectroscopy)

Figure 8.20 Heteronuclear 2D J-resolved Spectroscopy

1.Phase table

● ph1: 0 0 0 0 90 90 90 90 180 180 180 180 270 270 270 270

● ph2: 0 180 90 270 90 270 180 0 90 270 180 0 180 0 270 90

● ph3: 0 0 180 180 90 90 270 270

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 200 ppm (Obtained from

the basic single pulse 13C NMR spectrum, optimized to the narrowest)



257

 swhz1: Spectrum width in indirect dimension,300Hz (The half of maximum

width of multiple peaks of 13C-1H coupling)

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 64

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 13C transmitter in observed channel

 frqohz: Frequency offset of 13C transmitter in observed channel, the center of
13C NMR spectrum

 frqb1: Basic Frequency of 1H transmitter in decoupling channel

 frqohz1: 0 Hz

 p1: 90 degree pulse width of 13C transmitter in observed channel

 plvl1: The power of 13C transmitter in observed channel

 p2: 90 degree pulse width of 1H transmitter in decoupling channel

 plvl2: The power of 1H transmitter in decoupling channel corresponding with

p2

 decon1: Decoupling switch ‘yny’

 decpw1: Pulse width of decoupling, 63μs

 dectype1: Decoupling modulation mode in decoupling channel, www

(waltz16 combined pulse decoupling)

 decplvl1: The decoupling power of 1H transmitter in decoupling channel,

around 37dB

 d1: Relaxation delay, 0.5-2 s

 ns: 16 (or multiple of 16) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 4

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared sine or sine

 wdw1: Squared sine or sine

 sb: 0.5
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 sb1: 0.5

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.processing

Type wft in command line to perform two-dimensional Fourier transform and

display the two-dimensional spectrum in absolute mode. The t1 noise can be further

eliminated if the t1 noise is strong.

8.8 HMQC (Heteronuclear Multiple Quantum Coherence)

8.8.1 hmqc_bitp

Figure 8.21 HMQC pulse sequence

1.Phase table

● ph1: 0

● ph2: 180

● ph3: 0 180 180 0

● ph4: 0 0 0 0 180 180 180 180

● ph5: 0 180（Phase increases by TPPI）

● ph6: 0 0 180 180

2.Acquisition parameters
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 sw: Spectrum width in direct dimension is around 10 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is around 165ppm (Obtained

from the basic DEPT135 spectrum, optimized to the narrowest)

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 frqb1: Basic Frequency of 13C transmitter in decoupling channel

 frqohz1: Frequency offset of 13C transmitter in decoupling channel, the center

of 13C NMR spectrum

 p1: 90 degree pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel corresponding with

p1

 p2: 90 degree pulse width of 13C transmitter in decoupling channel

 plvl2: The power of 13C transmitter in decoupling channel corresponding

with p2

 d1: Relaxation delay, 0.5-2 s

 birddelay: BIRD delay, which is about 0.6s to be optimized to minimize FID.

Observe the received FID in the set mode and adjust the birddelay to minimize the

intensity.

 mult: BIRD switch, 1:turn on, 0:turn off

 Jch: 145 Hz (Short range coupling constant of CH)

 decon1: Decoupling switch ‘nny’

 decpw1: Pulse width of decoupling, 63μs

 dectype1: Decoupling modulation mode in decoupling channel, wwg (garp

combined pulse decoupling)

 decplvl1: Decoupling power, around 37dB
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 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 8

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared cos or cos

 wdw1: Squared cos or cos

 sb:1

 sb1:1

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.Processing

Type wft or wfp in command line to perform two-dimensional Fourier transform

and display the 2D spectrum in phase sensitive mode. The phase must be corrected in

both two dimensions. The t1 noise can be further eliminated if the t1 noise is strong.

8.8.2 hmqc_eagp

Figure 8.22 HMQC pulse sequence with gradient

1.Phase table

 ph1: 0
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 ph2: 0 0 180 180

 ph3: 0 180

 ph4: 0 0 0 0 180 180 180 180

 ph5: 0 180 0 180 180 0 180 0

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 10 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is around 165ppm(Obtained from

the basic DEPT135 spectrum, optimized to the narrowest)

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 frqb1: Basic Frequency of 13C transmitter in decoupling channel

 frqohz1: Frequency offset of 13C transmitter in decoupling channel, the center

of 13C NMR spectrum

 p1: 90 degree pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel corresponding with

p1

 p2: 90 degree pulse width of 13C transmitter in decoupling channel

 plvl2: The power of 13C transmitter in decoupling channel corresponding

with p2

 d1: Relaxation delay, 0.5-2 s

 gzlevel: Amplitude level of Z gradient, around 20（namely 20%）

 gradtime: Gradient time, 1~2ms

 gradshape1: hsine.grd

 gstab: Gradient stabilization time, 0.1~0.2ms

 jch: 145 Hz (Short range coupling constant of CH)
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 decon1: Decoupling switch ‘nny’

 decpw1: Pulse width of decoupling, 63μs

 dectype1: Decoupling modulation mode in decoupling channel, wwg (garp

combined pulse decoupling)

 decplvl1: Decoupling power, around 37dB

 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 8

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared cos or cos

 wdw1: Squared cos or cos

 sb: 1

 sb1: 1

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.Processing

Type wft or wfp in command line to perform two-dimensional Fourier transform

and display the 2D spectrum in phase sensitive mode. The phase must be corrected in

both two dimensions. The t1 noise can be further eliminated if the t1 noise is strong.
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8.8.3 hmqc_eagppr

Figure 8.23 HMQC pulse sequence with gradient and presaturation

1.Phase table

 ph1: 0

 ph2: 0 0 180 180

 ph3: 0 180

 ph4: 0 0 0 0 180 180 180 180

 ph5: 0 180 0 180 180 0 180 0

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 10 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is around 165ppm(Obtained from

the basic DEPT135 spectrum, optimized to the narrowest)

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 frqb1: Basic Frequency of 13C transmitter in decoupling channel

 frqohz1: Frequency offset of 13C transmitter in decoupling channel, the center

of 13C NMR spectrum
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 p1: 90 degree pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel corresponding with

p1

 p2: 90 degree pulse width of 13C transmitter in decoupling channel

 plvl2: The power of 13C transmitter in decoupling channel corresponding

with p2

 d1: Relaxation delay, 0s

 d6: delay for power switching is 10μs

 gzlevel: Amplitude level of Z gradient, around 20（namely 20%）

 gradtime: Gradient time, 1~2ms

 gradshape1: hsine.grd

 gstab: Gradient stabilization time, 0.1~0.2ms

 jch: 145 Hz (Short range coupling constant of CH)

 decon1: Decoupling switch ‘nny’

 decpw1: Pulse width of decoupling, 63μs

 dectype1: Decoupling modulation mode in decoupling channel, wwg (garp

combined pulse decoupling)

 decplvl1: Decoupling power, around 37dB

 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 8

 satdelay: Presaturation time, ~2s

 satplvl: Presaturation pulse power, ~3dB

 satfreq: Presaturation pulse frequency offset, frequency difference between

presaturation peak and spectral center

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared cos or cos

 wdw1: Squared cos or cos

 sb: 1
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 sb1: 1

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.Processing

Type wft or wfp in command line to perform two-dimensional Fourier transform

and display the 2D spectrum in phase sensitive mode. The phase must be corrected in

both two dimensions. The t1 noise can be further eliminated if the t1 noise is strong.

8.9 HSQC (Heteronuclear Single Quantum Coherence)

8.9.1 hsqc_bitp

Figure 8.24 HSQC pulse sequence

1.Phase table

 ph1: 0

 ph2: 90

 ph3: 180

 ph4: 0 180 180 0

 ph5: 0 0 0 0 180 180 180 180

 ph6: 0 180

 ph7: 0 0 180 180
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2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 10 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is around 165ppm(Obtained from

the basic DEPT135 spectrum, optimized to the narrowest)

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 frqb1: Basic Frequency of 13C transmitter in decoupling channel

 frqohz1: Frequency offset of 13C transmitter in decoupling channel, the center

of 13C NMR spectrum

 p1: 90 degree pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel corresponding with

p1

 p2: 90 degree pulse width of 13C transmitter in decoupling channel

 plvl2: The power of 13C transmitter in decoupling channel corresponding

with p2

 d1: Relaxation delay, 0.5-2 s

 birddelay: BIRD delay, which is about 0.6s to be optimized to minimize FID.

Observe the received FID in the set mode and adjust the birddelay to minimize the

intensity.

 mult: BIRD switch, 1:turn on, 0:turn off

 Jch: 145 Hz (Short range coupling constant of CH)

 decon1: Decoupling switch ‘nny’

 decpw1: Pulse width of decoupling, 63μs

 dectype1: Decoupling modulation mode in decoupling channel, wwg (garp

combined pulse decoupling)
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 decplvl1:Decoupling power, around 37dB

 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 8

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared cos or cos

 wdw1: Squared cos or cos

 sb: 1

 sb1: 1

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.Processing

Type wft or wfp in command line to perform two-dimensional Fourier transform

and display the 2D spectrum in phase sensitive mode. The phase must be corrected in

both two dimensions. The t1 noise can be further eliminated if the t1 noise is strong.

8.9.2 hsqc_gptp

Figure 8.25 HSQC pulse sequence with gradient

1.Phase table
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 ph1: 0

 ph2: 90

 ph3: 0 0 180 180

 ph4: 90 90 90 90 270 270 270 270

 ph5: 270

 ph6: 0 180

 ph7: 0 180 0 180 180 0 180 0

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 10 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is around 165ppm(Obtained from

the basic DEPT135 spectrum, optimized to the narrowest)

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 frqb1: Basic Frequency of 13C transmitter in decoupling channel

 frqohz1: Frequency offset of 13C transmitter in decoupling channel, the center

of 13C NMR spectrum

 p1: 90 degree pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel corresponding with

p1

 p2: 90 degree pulse width of 13C transmitter in decoupling channel

 plvl2: The power of 13C transmitter in decoupling channel corresponding

with p2

 d1: Relaxation delay, 0.5-2 s

 gzlevel: Amplitude level of Z gradient, around 20（namely 20%）

 gradtime: Gradient time, 1~2ms
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 gradshape1: hsine.grd

 gstab: Gradient stabilization time, 0.1~0.2ms

 jch: 145 Hz (Short range coupling constant of CH)

 decon1: Decoupling switch ‘nny’

 decpw1: Pulse width of decoupling, 63μs

 dectype1: Decoupling modulation mode in decoupling channel, wwg (garp

combined pulse decoupling)

 decplvl1: Decoupling power, around 37dB

 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 8

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared cos or cos

 wdw1: Squared cos or cos

 sb: 1

 sb1: 1

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.Processing

Type wft or wfp in command line to perform two-dimensional Fourier transform

and display the 2D spectrum in phase sensitive mode. The phase must be corrected in

both two dimensions. The t1 noise can be further eliminated if the t1 noise is strong.
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8.9.3 hsqc_gpprtp

Figure 8.26 HSQC pulse sequence with gradient and presaturation

1.Phase table

 ph1: 0

 ph2: 90

 ph3: 0 0 180 180

 ph4: 90 90 90 90 270 270 270 270

 ph5: 270

 ph6: 0 180

 ph7: 0 180 0 180 180 0 180 0

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 10 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is around 165ppm(Obtained from

the basic DEPT135 spectrum, optimized to the narrowest)

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 frqb1: Basic Frequency of 13C transmitter in decoupling channel
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 frqohz1: Frequency offset of 13C transmitter in decoupling channel, the center

of 13C NMR spectrum

 p1: 90 degree pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel corresponding with

p1

 p2: 90 degree pulse width of 13C transmitter in decoupling channel

 plvl2: The power of 13C transmitter in decoupling channel corresponding

with p2

 d1: Relaxation delay, 0s

 d6: delay for power switching is 10μs

 gzlevel: Amplitude level of Z gradient, around 20（namely 20%）

 gradtime: Gradient time, 1~2ms

 gradshape1: hsine.grd

 gstab: Gradient stabilization time, 0.1~0.2ms

 jch: 145 Hz (Short range coupling constant of CH)

 decon1: Decoupling switch ‘nny’

 decpw1: Pulse width of decoupling, 63μs

 dectype1: Decoupling modulation mode in decoupling channel, wwg (garp

combined pulse decoupling)

 decplvl1: Decoupling power, around 37dB

 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 8

 satdelay: Presaturation time, ~2s

 satplvl: Presaturation pulse power, ~3dB

 satfreq: Presaturation pulse frequency offset, frequency difference between

presaturation peak and spectral center

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared cos or cos
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 wdw1: Squared cos or cos

 sb: 1

 sb1: 1

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.Processing

Type wft or wfp in command line to perform two-dimensional Fourier transform

and display the 2D spectrum in phase sensitive mode. The phase must be corrected in

both two dimensions. The t1 noise can be further eliminated if the t1 noise is strong.

8.9.4 hsqc_eagp

Figure 8.27 HSQC pulse sequence with gradient

1.Phase table

 ph1: 0

 ph2: 90

 ph3: 0 180

 ph4: 0 0 0 0 180 180 180 180

 ph5: 0 0 180 180

 ph6: 0 180 0 180 180 0 180 0

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 10 ppm (Obtained from the
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basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is around 165ppm(Obtained from

the basic DEPT135 spectrum, optimized to the narrowest)

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 frqb1: Basic Frequency of 13C transmitter in decoupling channel

 frqohz1: Frequency offset of 13C transmitter in decoupling channel, the center

of 13C NMR spectrum

 p1: 90 degree pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel corresponding with

p1

 p2: 90 degree pulse width of 13C transmitter in decoupling channel

 plvl2: The power of 13C transmitter in decoupling channel corresponding

with p2

 d1: Relaxation delay, 0.5-2 s

 gzlevel: Amplitude level of Z gradient, around 20（namely 20%）

 gradtime: Gradient time, 1~2ms

 gradshape1: hsine.grd

 gstab: Gradient stabilization time, 0.1~0.2ms

 jch: 145 Hz (Short range coupling constant of CH)

 decon1: Decoupling switch ‘nny’

 decpw1: Pulse width of decoupling, 63μs

 dectype1: Decoupling modulation mode in decoupling channel, wwg (garp

combined pulse decoupling)

 decplvl1: Decoupling power, around 37dB

 ns: 8 (or multiple of 8) scans, depending on sample concentration
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 dummyscan: Number of scans with no acquisition, 8

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared cos or cos

 wdw1: Squared cos or cos

 sb: 1

 sb1: 1

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.Processing

Type wft or wfp in command line to perform two-dimensional Fourier transform

and display the 2D spectrum in phase sensitive mode. The phase must be corrected in

both two dimensions. The t1 noise can be further eliminated if the t1 noise is strong.

8.9.5 hsqc_eagppr

Figure 8.28 HSQC pulse sequence with gradient and presaturation

1.Phase table

 ph1: 0

 ph2: 90
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 ph3: 0 180

 ph4: 0 0 0 0 180 180 180 180

 ph5: 0 0 180 180

 ph6: 0 180 0 180 180 0 180 0

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 10 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is around 165ppm(Obtained from

the basic DEPT135 spectrum, optimized to the narrowest)

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 frqb1: Basic Frequency of 13C transmitter in decoupling channel

 frqohz1: Frequency offset of 13C transmitter in decoupling channel, the center

of 13C NMR spectrum

 p1: 90 degree pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel corresponding with

p1

 p2: 90 degree pulse width of 13C transmitter in decoupling channel

 plvl2: The power of 13C transmitter in decoupling channel corresponding

with p2

 d1: Relaxation delay, 0s

 d6: delay for power switching is 10μs

 gzlevel: Amplitude level of Z gradient, around 20（namely 20%）

 gradtime: Gradient time, 1~2ms

 gradshape1: hsine.grd

 gstab: Gradient stabilization time, 0.1~0.2ms
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 jch: 145 Hz (Short range coupling constant of CH)

 decon1: Decoupling switch ‘nny’

 decpw1: Pulse width of decoupling, 63μs

 dectype1: Decoupling modulation mode in decoupling channel, wwg (garp

combined pulse decoupling)

 decplvl1: Decoupling power, around 37dB

 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 8

 satdelay: Presaturation time, ~2s

 satplvl: Presaturation pulse power, ~3dB

 satfreq: Presaturation pulse frequency offset, frequency difference between

presaturation peak and spectral center

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared cos or cos

 wdw1: Squared cos or cos

 sb: 1

 sb1: 1

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.Processing

Type wft or wfp in command line to perform two-dimensional Fourier transform

and display the 2D spectrum in phase sensitive mode. The phase must be corrected in

both two dimensions. The t1 noise can be further eliminated if the t1 noise is strong.
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8.9.6 hsqc_edeagp

Figure 8.29 Editable gradient HSQC pulse sequence

1.Phase table

 ph1: 0

 ph2: 90

 ph3: 0 180

 ph4: 0 0 0 0 180 180 180 180

 ph5: 0 0 180 180

 ph6: 180 0 180 0 0 180 0 180

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 10 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is around 165ppm(Obtained from

the basic DEPT135 spectrum, optimized to the narrowest)

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 frqb1: Basic Frequency of 13C transmitter in decoupling channel

 frqohz1: Frequency offset of 13C transmitter in decoupling channel, the center

of 13C NMR spectrum
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 p1: 90 degree pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel corresponding with

p1

 p2: 90 degree pulse width of 13C transmitter in decoupling channel

 plvl2: The power of 13C transmitter in decoupling channel corresponding

with p2

 p3: Trim pulse width of 1H transmitter in observed channel, 1ms

 d1: Relaxation delay, 0.5-2 s

 gzlevel: Amplitude level of Z gradient, around 20（namely 20%）

 gradtime: Gradient time, 1~2ms

 gradshape1: hsine.grd

 gstab: Gradient stabilization time, 0.1~0.2ms

 Jch: 145 Hz (Short range coupling constant of CH)

 decon1: Decoupling switch ‘nny’

 decpw1: Pulse width of decoupling, 63μs

 dectype1: Decoupling modulation mode in decoupling channel, wwg (garp

combined pulse decoupling)

 decplvl1: Decoupling power, around 37dB

 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 8

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared cos or cos

 wdw1: Squared cos or cos

 sb: 1

 sb1: 1

 sbs: 0

 sbs1: 0

 fcor: 0.5
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 fcor1: 0.5

4.Processing

Type wft or wfp in command line to perform two-dimensional Fourier transform

and display the 2D spectrum in phase sensitive mode. The phase must be corrected in

both two dimensions. The t1 noise can be further eliminated if the t1 noise is strong.

8.10 HMBC (Heteronuclear Multiple Bond Correlation)

8.10.1 hmbc_eagp

Figure 8.30 HMBC pulse sequence with gradient

1.Phase table

 ph1: 0

 ph2: 0 0 180 180

 ph3: 0 180

 ph4: 0 0 0 0 180 180 180 180

 ph5: 0 180 0 180 180 0 180 0

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 10 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is around 220ppm(Obtained from

the basic single pulse 13C NMR spectrum, optimized to the narrowest)

 np: Acquisition points in direct dimension, 1024
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 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 frqb1: Basic Frequency of 13C transmitter in decoupling channel

 frqohz1: Frequency offset of 13C transmitter in decoupling channel, the center

of 13C NMR spectrum

 p1: 90 degree pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel corresponding with

p1

 p2: 90 degree pulse width of 13C transmitter in decoupling channel

 plvl2: The power of 13C transmitter in decoupling channel corresponding

with p2

 d1: Relaxation delay, 0.5-2 s

 gzlevel: Amplitude level of Z gradient, around 20（namely 20%）

 gradtime: Gradient time, 1~2ms

 gradshape1: hsine.grd

 gstab: Gradient stabilization time, 0.1~0.2ms

 jchn: 6~10 Hz（Long range coupling constant of CH）

 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 8

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared cos or cos

 wdw1: Squared cos or cos

 sb: 1

 sb1: 1

 sbs: 0
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 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.Processing

Type wft or wfp in command line to perform two-dimensional Fourier transform

and display the 2D spectrum in phase sensitive mode. The phase must be corrected in

both two dimensions. The t1 noise can be further eliminated if the t1 noise is strong.

8.10.2 hmbc_eagppr

Figure 8.31 HMBC pulse sequence with gradient and presaturation

1.Phase table

 ph1: 0

 ph2: 0 0 180 180

 ph3: 0 180

 ph4: 0 0 0 0 180 180 180 180

 ph5: 0 180 0 180 180 0 180 0

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 10 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is around 220ppm(Obtained from

the basic single pulse 13C NMR spectrum, optimized to the narrowest)

 np: Acquisition points in direct dimension, 1024
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 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 frqb1: Basic Frequency of 13C transmitter in decoupling channel

 frqohz1: Frequency offset of 13C transmitter in decoupling channel, the center

of 13C NMR spectrum

 p1: 90 degree pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel corresponding with

p1

 p2: 90 degree pulse width of 13C transmitter in decoupling channel

 plvl2: The power of 13C transmitter in decoupling channel corresponding

with p2

 d1: Relaxation delay, 0s

 d6: delay for power switching is 10μs

 gzlevel: Amplitude level of Z gradient, around 20（namely 20%）

 gradtime: Gradient time, 1~2ms

 gradshape1: hsine.grd

 gstab: Gradient stabilization time, 0.1~0.2ms

 jchn: 6~10 Hz（Long range coupling constant of CH）

 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 8

 satdelay: Presaturation time, ~2s

 satplvl: Presaturation pulse power, ~3dB

 satfreq: Presaturation pulse frequency offset, frequency difference between

presaturation peak and spectral center

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512
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 wdw: Squared cos or cos

 wdw1: Squared cos or cos

 sb: 1

 sb1: 1

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.Processing

Type wft or wfp in command line to perform two-dimensional Fourier transform

and display the 2D spectrum in phase sensitive mode. The phase must be corrected in

both two dimensions. The t1 noise can be further eliminated if the t1 noise is strong.

8.10.3 hmbc_gpqf

Figure 8.32 HMBC pulse sequence with gradient

1.Phase table

 ph1: 0

 ph2: 0 180

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 10 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is around 220ppm(Obtained from
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the basic single pulse 13C NMR spectrum, optimized to the narrowest)

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 frqb1: Basic Frequency of 13C transmitter in decoupling channel

 frqohz1: Frequency offset of 13C transmitter in decoupling channel, the center

of 13C NMR spectrum

 p1: 90 degree pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel corresponding with

p1

 p2: 90 degree pulse width of 13C transmitter in decoupling channel

 plvl2: The power of 13C transmitter in decoupling channel corresponding

with p2

 d1: Relaxation delay, 0.5-2 s

 gzlevel: Amplitude level of Z gradient, around 20（namely 20%）

 gradtime: Gradient time, 1~2ms

 gradshape1: hsine.grd

 gstab: Gradient stabilization time, 0.1~0.2ms

 jch: 145 Hz (Short range coupling constant of CH)

 jchn: 6~10 Hz (Long range coupling constant of CH)

 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 8

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048

 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared sine or sine

 wdw1: Squared sine or sine
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 sb: 0.5

 sb1: 0.5

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.processing

Type wft in command line to perform two-dimensional Fourier transform and

display the two-dimensional spectrum in absolute mode. The t1 noise can be further

eliminated if the t1 noise is strong.

8.10.4 hmbc_gpprqf

Figure 8.33 HMBC pulse sequence with gradient and presaturation

1.Phase table

 ph1: 0

 ph2: 0 180

2.Acquisition parameters

 sw: Spectrum width in direct dimension is around 10 ppm (Obtained from the

basic single pulse 1H NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is around 220ppm(Obtained from

the basic single pulse 13C NMR spectrum, optimized to the narrowest)

 np: Acquisition points in direct dimension, 1024
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 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 1H transmitter in observed channel

 frqohz: Frequency offset of 1H transmitter in observed channel, the center of
1H NMR spectrum

 frqb1: Basic Frequency of 13C transmitter in decoupling channel

 frqohz1: Frequency offset of 13C transmitter in decoupling channel, the center

of 13C NMR spectrum

 p1: 90 degree pulse width of 1H transmitter in observed channel

 plvl1: The power of 1H transmitter in observed channel corresponding with

p1

 p2: 90 degree pulse width of 13C transmitter in decoupling channel

 plvl2: The power of 13C transmitter in decoupling channel corresponding

with p2

 d1: Relaxation delay, 0s

 d6: delay for power switching is 10μs

 gzlevel: Amplitude level of Z gradient, around 20（namely 20%）

 gradtime: Gradient time, 1~2ms

 gradshape1: hsine.grd

 gstab: Gradient stabilization time, 0.1~0.2ms

 jch: 145 Hz (Short range coupling constant of CH)

 jchn: 6~10 Hz (Long range coupling constant of CH)

 ns: 8 (or multiple of 8) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 8

 satdelay: Presaturation time, ~2s

 satplvl: Presaturation pulse power, ~3dB

 satfreq: Presaturation pulse frequency offset, frequency difference between

presaturation peak and spectral center

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048
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 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared sine or sine

 wdw1: Squared sine or sine

 sb: 0.5

 sb1: 0.5

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.processing

Type wft in command line to perform two-dimensional Fourier transform and

display the two-dimensional spectrum in absolute mode. The t1 noise can be further

eliminated if the t1 noise is strong.

8.11 HCCOR (Heteronuclear Chemical Shift CORrelation)

Figure 8.34 HCCOR pulse sequence

1.Phase table

 ph1: 0

 ph2: 0 180 90 270

 ph3: 0 0 0 0 180 180 180 180

 ph4: (0)8 (90)8 (180)8 (270)8

 ph5: (0 180 90 270)2 (90 270 180 0)2 (180 0 270 90)2 (270 90 0 180)2

2.Acquisition parameters
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 sw: Spectrum width in direct dimension is around 220ppm (Obtained from

the basic single pulse 13C NMR spectrum, optimized to the narrowest)

 sw1: Spectrum width in indirect dimension is around 10 ppm (Obtained from

the basic single pulse 1H NMR spectrum, optimized to the narrowest)

 np: Acquisition points in direct dimension, 1024

 np1: Incremental points in indirect dimension, 128

 gain: FID signal is not overflowed

 frqb: Basic Frequency of 13C transmitter in observed channel

 frqohz: Frequency offset of 13C transmitter in observed channel, the center of
13C NMR spectrum

 frqb1: Basic Frequency of 1H transmitter in decoupling channel

 frqohz1: Frequency offset of 1H transmitter in decoupling channel, the center

of 1H NMR spectrum

 p1: 90 degree pulse width of 13C transmitter in observed channel

 plvl1: The power of 13C transmitter in observed channel corresponding with

p1

 p2: 90 degree pulse width of 1H transmitter in decoupling channel

 plvl2: The power of 1H transmitter in decoupling channel corresponding with

p2

 d1: Relaxation delay, 0.5-2 s

 jch: 145 Hz (Short range coupling constant of CH)

 decon1: Decoupling switch ‘nny’

 decpw1: Pulse width of decoupling, 90μs

 dectype1: Decoupling modulation mode, www (waltz16 combined pulse

decoupling)

 decplvl1: Decoupling power, around 34dB

 ns: 32 (or multiple of 32) scans, depending on sample concentration

 dummyscan: Number of scans with no acquisition, 16

3.Processing parameters

 si: Fourier transform points in direct dimension, 2048
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 si1: Fourier transform points in indirect dimension, 512

 wdw: Squared sine or sine

 wdw1: Squared sine or sine

 sb: 0.5

 sb1: 0.5

 sbs: 0

 sbs1: 0

 fcor: 0.5

 fcor1: 0.5

4.processing

Type wft in command line to perform two-dimensional Fourier transform and

display the two-dimensional spectrum in absolute mode. The t1 noise can be further

eliminated if the t1 noise is strong.

Chapter 9 Spectrum Printing

9.1 Start to print

Click on the menu bar File to select Print, or directly click the toolbar print

button to open the print page shown in Figure 9.1.

Figure 9.1 Print page
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The top left corner of spectrum in the printed page shows the data path of the

spectrum. The bottom left corner is the descriptive information, which can be filled in

or deleted as needed.

On the printed page, click on the menu bar View and select “Actual

Size/Adaptive Size” to adjust the page display size. Actual Size is shown in Figure 9.2

and Adaptive Size is shown in Figure 9.3.

Figure 9.2 Actual size

Figure 9.3 Adapt to window size

Clicking on the menu bar View to select Page Setup will bring up the page setup

dialog shown in Figure 9.4.
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Figure 9.4 Page setup dialog

Size: Paper size, optional A3, A4 or A5.

Portrait: Vertical, as shown in Figure 9.5.

Landscape: Horizontal, as shown in Figure 9.6.

Margin (mm): Page margin, you can set up the left, right, top and bottom

margins.

Figure 9.5 Vertical display
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Figure 9.6 Horizontal display

9.2 Document Output

In the print interface, clicking on the menu bar File to select Export will bring

up the dialog box shown in Figure 9.7.

Figure 9.7 Document export dialog box
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The storage types of document exports include bmp, jpeg, png and pdf. Users

can choose the storage path, file name and type according to their needs, and click

“save”.

9.3 Printing

In the print interface, click on the menu bar File to select Print, or click on the

button in the toolbar to open the print dialog box as shown in Figure 9.8

Figure 9.8 Print dialog box

Users can choose printers according to their own needs, page range settings,

number of copies settings, etc. After setting up, click on “print”.


	Chapter 1 Overview
	1.1 Introduction
	1.1.1 Definitions and Conventions

	1.2 System Installation
	1.2.1 System Requirements
	1.2.2 SpinStudioJ Installation and Uninstallation
	1.2.3 Installation of plug-ins

	1.3 Start the System
	1.4 Menu bar
	1.4.1 File
	1.4.2 Acquire
	1.4.3 Process
	1.4.4 Analysis
	1.4.5 View
	1.4.6 Options
	1.4.7 Tools
	1.4.8 Help

	1.5 Toolbar
	1.6 NMR Data Navigator
	1.6.1 User Node
	1.6.2 Research Team node
	1.6.3 Research Project node
	1.6.4 Folder node
	1.6.5 Experiment node

	1.7 Workspace
	1.8 Log Panel
	1.9 Command Line
	1.10 Status bar
	1.10.1 Connection Status
	1.10.2 Lock Status
	1.10.3 Sample Status 
	1.10.4 Spinning Status
	1.10.5 Temperature Status
	1.10.6 Cryogen Level Status
	1.10.7 Queue Information
	1.10.8 Acquisition Related Information


	Chapter 2 Getting Started
	2.1 Sample Preparation and 
	2.2 Startup SpinStudioJ
	2.3 System Configuration
	2.3.1 Component
	2.3.1.1 Component
	2.3.1.2 Global Parameters
	2.3.1.3 Probe related parameters

	2.3.2 Automation
	2.3.2.1 Lock and Gain
	2.3.2.2 Auto Shim
	2.3.2.3 STM

	2.3.3 Others
	2.3.3.1 Data Service
	2.3.3.2 Experiment Catalog


	2.4 VT Control
	2.5 Inserting and Ejecting Sample
	2.6 New Experiment
	2.7 Locking
	2.7.1 Manual Locking
	2.7.2 Auto Locking

	2.8 Tuning and Matching
	2.9 Shimming
	2.9.1 Manual Shim
	2.9.2 Search Shimming
	2.9.3 Smart Shimming
	2.9.4 3D Smart Shimming

	2.10 Experiment Setup
	2.10.1 Parameter Setup
	2.10.2 Displaying Pulse Sequence

	2.11 Data Acquisition and Storage
	2.11.1 Starting and Stopping Acquisition
	2.11.2 Repetitive Acquisition
	2.11.3 Data Archiving
	2.11.4 Data Acquisition for 2D Experiments

	2.12 Automation
	2.12.1 Automation Login
	2.12.2 Preference
	2.12.3 Operations of Automation experiments
	2.12.4 Web Client 
	OLE_LINK8



	Chapter 3 Pulse Programming
	3.1 Grammar of Pulse Sequence Editing
	3.1.1 Modules of Pulse Sequence
	3.1.2 Grammar for channel-related elements
	OLE_LINK10

	3.1.3 Grammar for elements not related to channels
	OLE_LINK9


	3.2 Display and Editing of Pulse Sequence
	3.2.1 Pulse sequence display
	3.2.2 Change Pulse Sequence
	3.2.3 Editing Pulse Sequence

	3.3 Synchronization of pulse sequence and experimenta
	3.4 PS Editor
	3.4.1 Create New Pulse Sequence
	3.4.2 Opening an existing pulse sequence
	3.4.3 Edit Pulse Sequence
	OLE_LINK19



	Chapter 4 1D Data Processing
	4.1 Workspace Introduction
	OLE_LINK18
	OLE_LINK1
	OLE_LINK34
	OLE_LINK35
	OLE_LINK2

	4.2 Spectrum Operation
	4.2.1 Spectrum zoom
	OLE_LINK20
	OLE_LINK22

	4.2.2 Move the spectrum
	4.2.3 Illustration
	OLE_LINK21


	4.3 Window Function
	4.3.1 Window function via command 
	OLE_LINK24

	4.3.2 Window via dialog 

	4.4 Linear Prediction
	4.4.1 Linear prediction via command
	OLE_LINK26
	OLE_LINK27
	OLE_LINK28

	4.4.2 Linear prediction via dialog 
	OLE_LINK25


	4.5 Fourier Transform 
	4.5.1 Fourier transform via command 
	4.5.2 Fourier transform via dialog 
	OLE_LINK29
	OLE_LINK30


	4.6 Phase Correction
	4.6.1 Automatic phase correction
	4.6.2 Manual phase correction

	4.7 Baseline Correction
	4.7.1 Drift correction
	4.7.2 Automatic baseline correction
	4.7.3 Semi-automatic baseline correction
	OLE_LINK31
	OLE_LINK32

	4.7.4 Manual baseline correction
	OLE_LINK33
	OLE_LINK36



	Chapter 5 2D Data Processing
	5.1 2D Spectrum Operation
	5.1.1 Spectrum zoom
	5.1.2 Move the spectrum
	OLE_LINK37
	OLE_LINK5
	OLE_LINK39
	OLE_LINK40
	OLE_LINK38

	5.1.3 Spectrum display
	OLE_LINK6
	OLE_LINK41

	5.1.4 Row and column display
	OLE_LINK7

	5.1.5 Projection Display
	OLE_LINK43
	OLE_LINK45
	OLE_LINK44
	OLE_LINK46


	5.2 2D Window Function
	5.2.1 Window via command 
	5.2.2 Window via dialog 

	5.3 2D Linear Prediction
	5.3.1 Linear prediction via command
	5.3.2 Linear prediction via dialog
	OLE_LINK48


	5.4 2D Fourier Transform
	5.4.1 Fourier transform via command
	5.4.2 Fourier transform via dialog

	5.5 2D Phase Correction
	5.5.1 Automatic phase correction
	5.5.2 Manual phase correction
	OLE_LINK49
	OLE_LINK47


	5.6 2D Baseline Correction
	5.7 J Spectrum Tilt
	5.8 t1 Noise Elimination
	5.9 Symmetry
	5.9.1 COSY-like
	5.9.2 J-Resolved
	OLE_LINK50



	Chapter 6 Data Analysis
	6.1 Reference
	6.1.1 Automatic calibration
	6.1.2 Manual calibration

	6.2 Peak Picking
	6.2.1 Automatic peak picking
	6.2.2 Manual peak picking

	6.3 Integration
	OLE_LINK51
	OLE_LINK55
	OLE_LINK56
	OLE_LINK52
	OLE_LINK57

	6.4 Multiple Spectrum Display
	6.4.1 Multiple spectrum display
	6.4.2 Spectral addition and subtraction

	6.5 Array Data Display and Processing                
	6.5.1 Array data display
	6.5.2 Array data processing  

	6.6Fitting
	6.6.1 T1 relaxation fitting
	6.6.2 T2 relaxation fitting
	OLE_LINK4

	6.6.3 DOSY fitting

	6.7 Signal/Noise Ratio
	6.8 Line Width and Digital Resolution

	Chapter 7 1D NMR Experiments
	7.1 1D 1H Experiment
	7.2 1D 13C Experiment
	7.3 1H T1 Relaxation
	7.4 1H T2 Relaxation
	7.5 APT (Attached Proton Test)
	7.6 DEPT (Distortionless Enhancement by Polarization 
	7.7 BIRD (BIlinear Rotation Decoupling)
	7.8 1D DOSY (Diffusion Ordered SpectroscopY)
	7.9 1D Solvent (Water) suppression Experiments
	7.9.1 PRESAT (Presaturation)
	7.9.2 WATERGATE
	7.9.3 Solvent (Water) Suppression by 1D-NOESY 

	7.10 1D Selective Experiments
	7.10.1 Selective 1D COSY Experiment
	7.10.2 Phase-Cycled Selective 1D TOCSY Experiment
	7.10.3 Gradient-Based Selective 1D TOCSY Experiment
	7.10.4 Gradient-Based Selective 1D NOESY Experiment
	OLE_LINK3



	Chapter 8 2D NMR Experiments
	8.1 1H-1H COSY
	8.1.1 cosy_prqf
	8.1.2 cosy_prtp
	8.1.3 cosy_gpqf
	8.1.4 cosy_gpprqf
	8.1.5 cosy_eagp
	8.1.6 cosy_eagppr
	8.1.7 cosy_dqfgptp

	8.2 1H-19F COSY
	8.3 TOCSY (TOtal Correlation SpectroscopY)
	8.3.1 tocsy_st
	8.3.2 tocsy_eagp
	8.3.3 tocsy_eagppr

	8.4 NOESY (Nuclear Overhauser Effect SpectroscopY)
	8.4.1 noesy_eagp
	8.4.2 noesy_gptp
	8.4.3 noesy_gpprtp

	8.5 ROESY (Rotating Frame Nuclear Overhauser Effect S
	8.5.1 roesy_prtp
	8.5.2 roesy_eagp
	8.5.3 roesy_gptpw3

	8.6 Homo2dj (Homonuclear 2D J-resolved Spectroscopy)
	8.6.1 homo2dj_qf
	8.6.2 homo2dj_prqf

	8.7 Heter2dj (Heteronuclear 2D J-resolved Spectroscop
	8.8 HMQC (Heteronuclear Multiple Quantum Coherence)
	8.8.1 hmqc_bitp
	8.8.2 hmqc_eagp
	8.8.3 hmqc_eagppr

	8.9 HSQC (Heteronuclear Single Quantum Coherence)
	8.9.1 hsqc_bitp
	8.9.2 hsqc_gptp
	8.9.3 hsqc_gpprtp
	8.9.4 hsqc_eagp
	8.9.5 hsqc_eagppr
	8.9.6 hsqc_edeagp

	8.10 HMBC (Heteronuclear Multiple Bond Correlation)
	8.10.1 hmbc_eagp
	8.10.2 hmbc_eagppr
	8.10.3 hmbc_gpqf
	8.10.4 hmbc_gpprqf

	8.11 HCCOR (Heteronuclear Chemical Shift CORrelation)

	Chapter 9 Spectrum Printing
	9.1 Start to print
	9.2 Document Output
	9.3 Printing


